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Disclaimer

Harmonic reserves the right to alter the equipment specifications and descriptions in this publication without prior notice. No part of 
this publication shall be deemed to be part of any contract or warranty unless specifically incorporated by reference into such 
contract or warranty. The information contained herein is merely descriptive in nature, and does not constitute a binding offer for 
sale of the product described herein. Harmonic assumes no responsibility or liability arising from the use of the products described 
herein, except as expressly agreed to in writing by Harmonic. The use and purchase of this product do not convey a license under 
any patent rights, copyrights, trademark rights, or any intellectual property rights of Harmonic. Nothing hereunder constitutes a 
representation or warranty that using any products in the manner described herein will not infringe any patents of third parties.

Trademark Acknowledgments

Harmonic and all Harmonic product names are trademarks of Harmonic All other trademarks are the property of their respective 
owners.

The software described in this document is furnished under a license agreement or nondisclosure agreement. The software may be 
used or copied only in accordance with the terms of those agreements.
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Documentation Conventions
This manual uses some special symbols and fonts to call your attention to important information. The 
following symbols appear throughout this manual:

CAUTION:  The Caution symbol calls your attention to information that, if ignored, can adversely affect 
the performance of your Harmonic product, or that can make a procedure needlessly difficult. 

NOTE:  The Note symbol calls your attention to additional information that you will benefit from 
heeding. It may be used to call attention to an especially important piece of information you need, or it 
may provide additional information that applies in only some carefully delineated circumstances.

TIP:  The Tip symbol calls your attention to parenthetical information that is not necessary for performing 
a given procedure, but which, if followed, might make the procedure or its subsequent steps easier, 
smoother, or more efficient. 

In addition to these symbols, this manual uses the following text conventions:

NOTE:  You require Adobe Reader or Adobe Acrobat version 6.0 or later to open the PDF files. You can 
download Adobe Reader free of charge from www.adobe.com.

Convention Explanation

Typed Command Indicates the text that you type in at the keyboard 
prompt.

Buttons and Menus Indicates a button to choose, or a menu item to select. 

<Ctrl>, <Ctrl>+<Shift> A key or key sequence to press.

Links The italics in blue text to indicate Cross-references, and 
hyperlinked cross-references in online documents.

Bold Indicates a new term. For example:
SpanWindow - the transmission frequency along the 
1GHz spectrum allocated for each RF Port. It spans 
across 384MHz.

LCD Screen Output The text that is displayed on an LCD console output.

ScreenOutput The text that is displayed on a computer screen. 

Emphasis The italics text used for emphasis and document 
references.
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Chapter 1
Introduction

Thank you for purchasing Harmonic ProMedia™ Carbon (formerly Carbon Coder), Carbon 
Server, and Carbon Agent products. The boom in video consumption has resulted in an 
explosion in the number of formats that content creators and distributors must manage. 
Video may be captured in one format, edited in another, served live in a third, delivered on-
demand via the Web and mobile in half a dozen more and then finally archived in yet another. 
Harmonic’s products provide cost-effective and rapid transcoding across a wide range of 
applications from small studios to the largest enterprises.

NOTE:  Although the new ProMedia Carbon name appears on the splash screen, some shortcuts, and in 
the About dialog, you will still see its previous name, Carbon Coder, referenced throughout the user 
interface.

1.1 About this User Guide
The ProMedia Carbon User Guide describes ProMedia Carbon products and explains how to 
use them to manage and deliver appropriate file formats to your consumers.

1.2 Related Documentation
Table 1–1: Related Documentation

Document Description

Harmonic Carbon Coder API 
Guide

This document describes the API for the Harmonic Carbon 
range of products. When a ProMedia Carbon product is 
installed, it includes the installation of the Carbon Engine. 
Once the Carbon Engine is running, it can accept socket 
calls and COM commands through Nexus using the API 
described in this document, and can be controlled with the 
command-line interface. There is no additional fee for using 
the Harmonic SDK. No specific tools are required. A 
ProMedia Carbon installation installs everything necessary 
to use the API.

1.3 Components
ProMedia™ Carbon is a standalone application (engine) that handles transcoding between all 
major formats, as well as providing a host of additional functions like standards conversion, 
logo insertion, timecode burn-in, etc. It installs with Carbon Admin. 

Carbon Server is a management tool that allows a network of Carbon Agents to accelerate 
transcoding for high-volume applications. Both ProMedia Carbon and Carbon Server have 
easy-to-use interfaces, and both can alternatively be managed via an XML-based SDK for 
absolute programmatic control. The SDK is installed automatically with a Carbon installation. 

Carbon Agent is a “slave” transcoding process that runs under Carbon Server. Carbon Agent 
does not transcode independently of Carbon Server.
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This manual will cover the installation, as well as the basic and advanced functions of 
ProMedia Carbon, Carbon Admin, and Carbon Server. For updates on the latest features and 
documentation please visit www.harmonicinc.com or www.rhozet.com.

1.4 What is New in this Release 
Carbon 3.20 is a full Carbon release that extends Carbon 3.19 with new features described in 
this section.

1.4.1 Closed Captioning and Subtitling Support for Adaptive Streaming 
Formats

1.4.1.1 Smooth Streaming Exporter – H.264

Carbon 3.20 adds Closed Captioning and subtitling to the H.264 Smooth Streaming Exporter 

by including support for CEA-708 Captions and for Cavena1 Timed Text Markup Language 
(TTML) files. The 708 Captions are taken from the Carbon internal pipeline and converted to 
Caption streams in the form of ISMT files that are downloaded in fragments by the client. The 
process for TTML files is similar; they are also converted to ISMT files.

For Caption streams based on 708 Captions, a Service Number and a language tag, must be 
specified for each stream. The Service Number is the CEA-708 Service Number that 
identifies which service inside the 708 needs to be converted to ISMT. The language tag is 
used to let the user of the client choose the language they want to see displayed on the 
screen. This is additional functionality that needs to be implemented in the client. 

For 708, the language tags are entered manually and used as part of the ISMT file names. 
They can also be used in the name parameters of the text streams in the .ismc client manifest 
files. Clients can use this information to let the user select the language they want.

NOTE:  Use of 708 Captions is only allowed if the layers have a frame rate of 29.97 fps or 59.94 fps. Other 
frame rates are not supported.

For Caption streams based on TTML files. it is not necessary to indicate which language to 
convert the file. Each TTML file is only allowed to contain one language. Furthermore, 
specification of language tags is not required as those are included inside the files. ProMedia 
Carbon allows you to enter time offsets for each TTML file to counter a possible time offset.

Multiple languages can be supported with TTML files by creating multiple streams and 
selecting a different TTML file (representing a different language) for each stream.

NOTE:  Use of Caption streams based on TTML files does not allow for segmenting or stitching of source 
files.

1. Cavena Image Product AB, www.caven.se

http://www.harmonicinc.com/view_product.cfm?ID=215
http://www.harmonicinc.com/view_product.cfm?ID=215
http://www.harmonicinc.com/view_product.cfm?ID=215
http:\\www.rhozet.com
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1.4.1.2 HTTP Live Streaming Exporter

Carbon 3.20 also adds Closed Captioning to the HTTP Live Streaming Exporter by including 
support for CEA-608 Captions. This support is only available if every layer has a frame rate of 
59.94, 29.97, or 23.976 fps.

1.4.2 Splicer-compatible Content
ProMedia Carbon 3.20 can create content, such as advertising, that can be spliced into a 
network feed with the Harmonic ProSteam 2000 Ad Splicer. Both the content that is spliced, 
The network feeds into which they are spliced are Transport Streams containing H.264 video. 
The network feeds must be generated by a Harmonic Electra 5400, 7000, or 8000 Encoder.

This capability to create splicer-compatible content is controlled by a separate license, and it 
is enabled by a check box in the H.264 Exporter preset configuration. The check box is not 
displayed if the license is not present.

In addition to selecting the check box, you must configure the preset with specific values, 
depending on the network feed. ProMedia Carbon 3.20 includes a collection of factory 
presets for creating splicer-compatible content. It is recommended that you use one of these 
presets as a starting point, and then modify parameters as needed. To determine which 
parameters need to be modified, follow the instructions below that describe how to set up a 
new preset using the ProMedia Carbon GUI.
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Configuring the H.264 Exporter Preset for Splicer-compatible Content
1. Load the H.264 Exporter preset located in the System preset category.

2. Open the Advanced Setup view by clicking on the Target button.

3. Set the Multiplexer Type to MPEG-2 Transport Stream (default).

The Transport Stream Type can be Generic, ATSC, or DVB, depending on the primary 
network stream.

4. Set Multiple Video Pictures per PES packet to One AU per PES.

5. Select the check box labeled Uniform Packet Distribution.

6. Set the values for PCR PID, PMT PID, and Video PID to the same values used by the 
network feed.

7. Set the T-STD Delay for H.264 msl parameter to equal the maximum delay configured for 
the network feed encoder. For an Electra 8000 encoder, the value is typically 1000 ms.

8. Set the video parameters, Width, Height, Aspect Ratio, Frame Rate, and Interlacing, to the 
same values as used by the network feed. For PAL or SECAM systems, it will typically be 
720 x 576, 25 frames per second, with Upper (top) field first.

9. Set the Video Bitrate Mode to CBR. 

10. Set the Number of passes to 1 pass.

11. Set the Video Bitrate value in kilobits/s. It must be less than or equal to the video bitrate 
of the network feed. It must also be less than the Transport Stream Multiplexer Rate (see 
below).

12. Select the check box labeled Enforce Splicer Compatibility. It is located underneath the 
Maximum bitrate, which is greyed out. If you do not see it, then you are using an earlier 
version of ProMedia Carbon, do not have the appropriate license for creating splicer-
compatible content, or are not in Advanced Setup mode.
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13. Calculate and set the value for the parameter labeled VBV Buffer Size [bytes]. This 
parameter determines the maximum delay in the video elementary stream according to 
the H.264 standard HDR buffer model. Because this parameter is expressed in bytes 
rather than in seconds, you must use the following formula:

VBV Buffer Size [bytes] = {maximum delay (in sec)} * {Video 
Bitrate (in kilobits/s)}  * 1000 / 8
Here, maximum delay is the maximum delay configured on the network stream encoder, 
and Video Bitrate is same as value for the Video Bitrate box, above. 

For example, if maximum delay = 1 second and the Video Bitrate = 2000 kbits/s then the 
VBV Buffer Size = 1 * 2000 * 1000 / 8 = 250000 bytes.

14. Do NOT check the box labeled Use VBR Transport Stream Multiplexer Rate.

15. Select the check box labeled Use specific Transport Stream Multiplexer Rate.

16. Set the value of the Transport Stream Multiplexer Rate in kilobits/s. It must be set to a 
value less than or equal to the Transport Stream multiplex rate of the network feed. It 
must be greater than the sum of the bitrates of the H.264 video elementary stream and 
all audio streams combined, with some headroom added for Transport Stream 
multiplexing.

17. Set the Profile and Level parameters of the H.264 stream to the same values used by the 
network feed.

18. Leave all subsequent video stream encoder settings to their default values.

19. Configure the audio (Number Of Audio Programs, Audio Programs Type, Channel 
Configuration, Bitrate, etc,) to the same values as the network feed.

20. Save the preset by clicking the Save Preset button.

1.4.3 Improved Video Quality for H.264 Dual-Pass Encoding
The internal rate control algorithm for H.264 dual-pass encoding has been improved to 
provide better video quality. The video quality gains are especially significant in VBR encoding 
mode although there are also gains for CBR.

1.4.4 Dolby Parameters in the H.264 Exporter
Compared to earlier versions, ProMedia Carbon 3.20 provides an expanded set of 
configurable parameters in the H.264 Exporter for Dolby audio. With the exception of three, 
parameters, as noted below, the newly exposed parameters were all set to fixed values in 
earlier versions of ProMedia Carbon. 

The new set is now compatible with what is available for the MPEG-2 Exporter. To maintain 
backwards compatibility for existing projects that use the H.264 Exporter, the defaults for the 
H.264 Exporter differ from those for the MPEG-2 Exporter. 

The H.264 Exporter exposes three new parameters that were not used in earlier versions. 
These are:

 Line Mode Profile (Light Dynamic Compression)

 RF Mode Profile (Heavy Dynamic Compression)

 Preferred Stereo Downmix Mode
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You need to configure these parameters according to your preference.

1.4.5 Support for OP42 and OP47
ProMedia Carbon 3.20 introduces support for OP42 and OP47 standards that specify 
requirements for carrying Teletext data in VBI and ANC, respectively. The requirements are 
specific to the Australian market, although use of these standards in Europe is gaining 
popularity.

Pro Carbon 3.20 adds the following capabilities:

 Ability to insert Teletext from STL files and put it on the internal Teletext pipeline in an 
OP42-compliant format. To enable this feature, select the check the box labeled OP42 
Compatibility in the Teletext inject from STL filter.
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 A new and user-selectable filter that extracts OP42 Teletext data from VBI and puts it on 
the internal ANC (291M) pipeline, formatted according to OP47. The filter is called Teletext 
(OP42) to OP47 and should only be used for converting Teletext data that is OP42 
compliant.

 A new user-selectable filter that does the reverse of the filter described above. This filter 
extracts OP47-compliant Teletext data from the internal ANC pipeline and - converts it to 
OP42 Teletext for inclusion in the VBI. This filter is called Teletext from OP47 and has no 
user-configurable parameters.

1.4.6 Flat Output Folder Structure for H.264 Smooth Streaming Exporter and 
PCM Audio Exporter
The H.264 Smooth Streaming Exporter and the PCM Audio Exporter can now export to a 
single folder, rather than to separate subfolders for each individual source clip. For the PCM 
Audio Exporter, this functionality is implemented for the case where the Exporter is 

configured to create a wave file for each channel1.

1. In the case where the Exporter is configured to store all channels in a single file, the files were already written to 
a single folder.
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To export all target files to the same folder, do not select the Asset Directory Structure check 
box.

For the PCM Audio Exporter, in the case of one wave file per channel, the mechanism that 
detects existing target files with conflicting names is limited to the first audio file in a set. A 
new, optional replacement string for the destination file base name has been added to help 
avoid potential file naming conflicts. This replacement string, %g, adds a globally unique 
GUID to the name of the destination files. This replacement string can also be used in the 
H.264 Smooth Streaming Exporter.

1.4.7 New Factory Presets for Formats with H.264 Video
The factory presets for all formats that use H.264 video have been updated and new ones 
have been added as well. Any old presets that have been replaced by new ones are still 
available, but have moved to a new Legacy preset category. Existing projects and API calls 
that use these presets will continue to use them without any changes.

The categories for the H.264 presets are now as follows.

 Adaptive Bitrate H.264. This category includes presets for Apple HTTP Live Streaming 
and Microsoft H.264 Smooth Streaming, as well as presets for MP4 files that can be 
packaged with the Adobe VOD file packager for delivery with the Adobe Dynamic 
Streaming protocol.

 Broadcast. This category contains presets for H.264 Transport Streams for use in 
broadcast delivery environments.

 Handheld \ H.264. This sub-category includes generic H.264 MP4 presets for delivery to 
handheld devices.

 Splicer Compatible. This category includes presets for creating content that can be 
spliced with the Harmonic ProStream 2000 into network feeds generated with Harmonic 
Electra encoders.

 Web \ H.264. This category contains H.264 MP4 presets, but with a larger variety of 
resolutions and bit rates than the Handheld category.

1.4.8 Support for Omneon MPEG-2 LGOP Pre-charge Frames
An Omneon MPEG-2 LGOP clip recorded with the Spectrum/MediaDeck family of on-air 
servers may contain extra frames at the start of the recording. These frames, called pre-
charge frames, are added to assist with the recording process and are not part of the visible 
video when the clip is played back. Carbon 3.20 correctly ignores these frames, whereas 
earlier versions incorrectly treat them as if they are part of the visible video. A new Omneon 
Importer was implemented to support this functionality, that also allows Carbon to display 
more source properties for Omneon clips than it did previously.

1.4.9 RMP Proxy Preset – New Proxy Job Types and IPV Compliance

Carbon 3.20 adds new proxy job types and IPV1 compliance to the RMP Proxy preset in 
WorkFlow System (in the RMP Transcode tab in Preset Editor).

The new proxy job types allow the user more flexibility in what the preset creates. Carbon 
versions older than 3.20 always create proxy as well as thumbnail and storyboard, but the 
new proxy job types allow for different combinations such as thumbnail only or thumbnail and 
storyboard. The choices are:

 All, meaning proxy plus thumbnail plus storyboard

 Proxy only

1. IPV Limited, www.ipv.com
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 Thumbnail only

 Storyboard only

 Thumbnail and Storyboard

IPV compliance allows the proxy to be streamed with an IPV SpectreView server, for instance 
for browse or QC purposes. This functionality requires an IPV proxy player. The IPV streaming 
protocol provides operators with a responsive GUI experience, much more responsive than if 
a progressive download were used instead.
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1.5 Format Support
This section lists the different formats supported by ProMedia Carbon.

1.5.1 Supported Video Codecs
 AVC-Intra

 DNxHD

 DPS

 DPX

 DV25, DV50, DVCPro, DVCPro100

 Flash 8 (VP6)

 H.264/AVC/MPEG-4 Part 10

 HDV

 Image Sequences

 JPEG-2000

 MPEG-1 

 MPEG-2, D-10/IMX 

 MPEG-4 Part 2

 ProRes

 RealVideo

 VC-1

 Windows Media

1.5.2 Supported Audio Codecs
 AAC

 AC-3

 AMR-NB

 Dolby Digital

 Dolby E

 DTS

 MP3

 PCM

 RealAudio

 Windows Media Audio

1.5.3 Supported Containers
 3G2

 3GPP

 ASF, WMA, WMV

 AVI

 HTTP Live Streaming (Apple)

 LXF, GXF

 Microsoft Smooth Streaming

 MP4, F4V

 MPEG-2 PS, MPEG-2 TS
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 MXF (OP1a, OPAtom)

 QuickTime

 VOB

 WAV, Broadcast WAV

1.5.4 Supported Systems
 Adobe Premiere Pro

 Apple Final Cut Pro

 Avid Editing Systems 

 Grass Valley Edius

 Grass Valley Profile, K2

 Leitch VR, Nexio

 Omneon Spectrum, MediaGrid

 Panasonic P2

 Quantel sQ

 Sony XDCAM

1.6 Basic Features
This section lists the basic features of ProMedia Carbon.

1.6.1 Video Operations
 Aspect ratio conversion

 Black/white correction

 Blur

 Color correction

 Color space conversion

 Cropping

 Fade in/out

 Frame rate conversion

 Frame size conversion

 Gamma correction

 Interlace/De-interlace conversion

 Median

 NTSC-safe

 PAL/NTSC conversion

 Rotate

 SD/HD conversion

 Sharpen

 Telecine / inverse telecine

 Temporal noise reduction

 Video Processing

1.6.2 Audio Processing
 Dynamic range compressor
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 Fade In/Out

 Low-pass

 Normalize

 Volume

1.6.3 Additional Operations
 601/709 color space support

 Batch processing

 FTP delivery

 Line 21/CC preservation/conversion

 Logo insertion

 Metadata transport and conversion

 Multiple simultaneous target outputs

 Quality checking

 Remote job submission

 Segment extraction/insertion

 Subtitle/CC imprint

 Timecode imprint

 Unlimited number of encoding passes 

 XML controllable titler 
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Chapter 2
Installing Carbon Products

This chapter details system requirements and procedures for installing and upgrading 
ProMedia™ Carbon 3.20, Carbon Server, Carbon Admin, and Carbon Agent. This chapter also 
includes optimizations to increase ProMedia Carbon’s performance, and special requirements 
and rights for using third-party products included with the installation. 

NOTE:  Although the new ProMedia Carbon name appears on the splash screen, some shortcuts, and in 
the About dialog, you will still see its previous name, Carbon Coder, referenced throughout the user 
interface.

2.1 Software Versions

Carbon Coder 3.20.0.38542

Carbon Server

Carbon Agent

2.2 System Requirements
This section describes the recommended, minimum, and supported Microsoft® Windows® 
32- or 64-bit operating system requirements for installing Carbon products.

NOTE:  64-bit Windows operating system recommended for multi-layer video exporters. 

2.2.1 Recommended System Requirements
 Processor: Intel® Xeon 54xx; dual-processor configuration, 3.0 - 3.4 GHz processor clock

 Memory: 8- or 16-GB RAM 

 Microsoft Windows Server 2008, 32- or 64-bit (recommended), Service Pack 2 

 DirectX 9.0 or later

 USB 1.1 or 2.0 port for USB Hardware Key

 500 MB free hard disk space

2.2.2 Minimum System Requirements
 Processor: Intel® or AMD Athlon 2.0GHz CPU or faster

 Memory: 2-GB RAM (4GB RAM for HD encoding) 

 Microsoft Windows XP Service Pack 3 

 USB 1.1 or 2.0 port for USB Hardware Key

 500 MB free hard disk space

Application Build Number

3.20.0.38542

3.20.0.38542
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2.2.2.1 Additional supported operating systems:

 Workstation OS versions:

 Windows XP SP3

 Windows Vista SP2

 Windows 7

 Server OS versions:

 Windows Server 2003 R2 AP1 or R2 SP2

 Windows Server 2008 SP2

 Windows Server 2008 R2

2.2.3 Apple ProRes 422 Requirements
Apple ProRes 422 is a high-quality video format used in post-production. Carbon supports it 
as a target format for all 8-bit sources, and for 10-bit JPEG 2000 and 10-bit Avid AAF / 
DNxHD source materials. See B.5.1 QuickTime 7 Exporter for Apple ProRes 422 (3.1.8.1) on 
page 134 for more information on Apple ProRes 422. 

Installing Apple ProRes 422 requires special installation requirements, detailed in the 
following sections. 

2.2.3.1 Transcoding from 8-bit sources to ProRes 422

1. The system must be a multi-node transcode farm of at least two transcode nodes under 
control of Carbon Server or Workflow System (WFS). 

2. The transcode nodes that need to convert to ProRes 422 require a license to do so. 
Please contact your local Harmonic sales representative for information about this 
license.

3. The transcode nodes must run one of the following Windows Server Operating Systems:

 Windows Server 2003 R2 SP1 or R2 SP2 

 Windows Server 2008 SP2 

 Windows Server 2008 R2

2.2.3.2 Transcoding from10-bit JPEG 2000 and 10-bit AAF/DNxHD to ProRes 422

If the source format for transcoding to ProRes 422 is 10-bit AAF / DNxHD, then the following 
additional requirements must also be met:

1. The system must be a multi-node transcode farm of at least two transcode nodes under 
control of Workflow System (WFS). 

2. The transcode nodes that need to convert to ProRes 422 require a license to do so. 
Please contact your local Harmonic sales representative for information about this 
license.

3. The transcode nodes must run one of the following Windows Server Operating Systems:

 Windows Server 2003 R2 SP1 or R2 SP2 

 Windows Server 2008 SP2

 Windows Server 2008 R2

4. The DNxHD source files should be located on shared storage accessible by ProMedia 
Carbon and Workflow System. The feature has been qualified with network shares. 
Workflow System is required for transcoding from 10-bit JPEG 2000 or AAF / DNxHD to 
ProRes 422.

5. Frame rate, resolution and interlace mode of source and target files need to be the same. 
There is not yet support for setting In and Out points.



Chapter 2 Installing Carbon Products Installing and Upgrading Carbon Products

 © 2012 Harmonic Inc. 21 ProMedia™ Carbon Installation and User Guide v.3.20

6. The AAF / DNxHD clips exported by Avid Media Composer workstations must use a 
Windows Operating System.

2.2.4 Maximizing ProMedia Carbon’s Performance
ProMedia Carbon is a standalone product, and while upgrading the system is usually the best 
way to increase ProMedia Carbon’s performance, there are a few optimizations that can 
increase ProMedia Carbon’s speed without additional hardware or upgrades.

 Optimizing Drive Speed. Defragmenting the source and target hard drive(s) can 
significantly increase read and write speeds.

 Using Separate Source and Target Drives. Accessing source files and writing target files on 
separate physical disks will reduce seek data access times and improve ProMedia Carbon’s 
performance.

2.3 Installing and Upgrading Carbon Products
New installation and upgrade instructions (for existing installations) appear in different 
sections of this chapter; make sure you review the correct section before beginning 
installation or upgrade procedures. 

You will install the following Carbon products:

 ProMedia Carbon is a standalone application that runs on a single system, which can be 
used for production or for development purposes. ProMedia Carbon is installed with, and 
managed by, Carbon Admin; it cannot be controlled by Carbon Server. See 2.3.2 Installing 
ProMedia Carbon 3.20 on page 21.

 Carbon Server is a management application that allows you to control a farm of 
transcoders, each known as a Carbon Agent. See 2.3.3 Installing Carbon Server 3.20 - New 
Installation on page 25and 2.3.4 Upgrading Carbon Server on page 27.

 Carbon Agent is a “slave” transcoding process that runs under Carbon Server, with each 
agent managing a “farm” of transcoders. Carbon Agent does not transcode independently 
of Carbon Server. See 2.3.5 Installing Carbon Agent on page 28.

 Carbon Admin is used to configure and control Carbon Server and Carbon Agent. 

2.3.1 Thomson MP3 Exporter Installs with ProMedia Carbon
Supply of the Thomson MP3 Exporter product with ProMedia Carbon does not convey a 
license, nor imply any right to distribute content created with this product in revenue-
generating broadcast systems (terrestrial, satellite, cable and/or other distribution channels), 
streaming applications (pay-audio or audio-on-demand applications and the like) or on 
physical media (compact discs, digital versatile discs, semiconductor chips, hard drives, 
memory cards and the like). An independent license for such use is required. For details, 
please visit http://mp3licensing.com.

2.3.2 Installing ProMedia Carbon 3.20
This section provides ProMedia Carbon installation instructions. 

NOTE:  Prior to installing ProMedia Carbon, make sure that the USB hardware key that comes with your 
software is not plugged in. 

http://mp3licensing.com
http://mp3licensing.com
http://mp3licensing.com
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1. Make sure that QuickTime version 7.6.8 is installed on your system. It is available from the 
ProMedia Carbon CD-ROM.

2. Insert the ProMedia Carbon CD-ROM in your CD drive. The installer automatically 
launches if the Windows Autorun feature is enabled. If Autorun is not enabled, then go to 
My Computer, double-click the CD-ROM drive and run Setup.exe.

3. When the Welcome screen appears, click Next.

4. Select I do accept the term of the license agreement and click Next.

5. Enter your name and your company name on the Customer Information dialog box, then 
click Next.

6. When the Install the Nexus Service screen appears, select Using the “Local System“ 
account or Using a User Account for domain users. Click Next. 

7. Choose a destination location for ProMedia Carbon. The ProMedia Carbon Installer 
automatically suggests a default location. If you want to change this location, select 
Browse and choose a new destination folder. Click Next.

8. On the Ready to Install the Program screen, then click Next.

The Setup Status screen opens and provides status on the installation. After installing 
ProMedia Carbon, the Windows Media software will be installed. If you already have the 
latest versions of the software on your machine, the installer will skip to the next step.

9. Click Yes, I want to restart my computer now and click Finish to restart your computer.

10. After your computer has restarted, plug-in the USB Hardware Key that comes with your 
software. You can use the computer's on-board USB ports, a USB PCI card, or a USB hub 
connected to either of these ports.

11. Start ProMedia Carbon. (The USB Hardware Key must be connected before starting 
ProMedia Carbon.)

2.3.2.1 Installing to a Remote System (Command Line)

This section describes how to install ProMedia Carbon on a remote system from a network 
path. 

1. On one of the systems on which you would like to remotely install ProMedia Carbon, run 
the ProMedia Carbon setup locally from the command line using the /r parameter: 
P:\setup.exe /r.

This will create a setup.iss file in the windows directory.

2. Copy the Carbon Setup files to a directory on your network, in which all desired remote 
systems have both read and write access.

3. Copy the setup.iss file to the same location on the network as the Carbon Setup file. 

4. Copy the file included with this setup, InstallCarbonCoder.bat, to the same network 
location as the Carbon Setup files. 

5. Modify the InstallCarbonCoder.bat file by selecting it, and then Edit. 

6. Replace %CARBONCODER_SETUP_LOCATION% with the full network path to the 
location of the Carbon Setup files. 

7. Login to each remote system on which you would like to install ProMedia Carbon using 
an account with administrative privileges, usually using Remote Desktop. 

8. Execute the InstallCarbonCoder.bat file. InstallCarbonCoder.bat: 
@echo off 
call net use P: "\\%CARBONCODER_SETUP_LOCATION%" /PERSISTENT:NO 
P: 
cd \ 
call P:\Setup.exe /s /f1"P:\setup.iss" /f2"C:\%COMPUTERNAME%.txt" 
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call copy C:\%COMPUTERNAME%.txt "P:\Logfile\%COMPUTERNAME%.txt" 

InstallCarbonCoder.bat will execute the ProMedia Carbon installation stored on a 
remote system. It also creates an install log file on the network location with the setup 
files for reference. 

When you have completed installing ProMedia Carbon, see 3.2 Using the ProMedia Carbon 
Interface on page 30 or Chapter 4, Using Carbon Admin to learn how to load a source, select 
a target, and convert. See Chapter 3, Adding Source Files if you plan to process many files 
through Watch Folders. 

2.3.2.2 ProMedia Carbon Evaluation Versions

Included with the ProMedia Carbon evaluation package is a Harmonic USB Security Key that 
allows you to execute ProMedia Carbon for the duration of the evaluation period. Once the 
evaluation period expires, you can no longer run ProMedia Carbon. 

When your evaluation period ends there are two things that you must do to extend your 
license. First, you must contact Harmonic to arrange for your evaluation to be extended. 
Second, you must update your current hardware security key to match your newly extended 
evaluation period. 

Please be aware of the following conditions before updating your security key. 

 The license file information you receive from Harmonic (in the following  Update 
instructions, Step 6 on page 24) must be applied to the exact same key from which you will 
extract the status information (in Step 3 to Step 5). You cannot mix license files and apply 
them to keys other than the one they were generated for. 

 For security reasons, you must run the update application on the same physical computer 
the security key is attached to. In the event this is not possible, you can use Windows 
Remote Desktop to connect to the computer, but you must do so in Console Mode. To run 
Remote Desktop in Console Mode, open a command prompt window and enter the 
following command: mstsc /v:hostname /console.

 It is very important to generate a completely new key status file (in Step 3 to Step 5) every 
time your key expires. You cannot reuse old status key files. 

Update instructions
1. Download the USB Security Key update.zip from ftp://data.rhozet.com/

USBSecurityKeyUpdate.zip.

2. Using Windows Explorer, navigate to where you downloaded ‘USB Security Key 
update.zip’ and extract it. Once the files are extracted, run KeyUpdate.exe. 

3. Once the program has launched, make sure the Collect Key Status Information tab is 
selected (if not, select it). 

4. Select Collect information.

ftp://data.rhozet.com/USBSecurityKeyUpdate.zip


Chapter 2 Installing Carbon Products Installing and Upgrading Carbon Products

 © 2012 Harmonic Inc. 24 ProMedia™ Carbon Installation and User Guide v.3.20

5. A Save dialog box will open, select a file name to save the key status information in, and 
select Save. 

6. The USB Security Key will be read, information will be saved to the file you designated, 
and the screen will display a confirmation message like the following (the time and 
filename may be different): 19:41:49: Key status retrieved from HASP successfully. 
Information written to file c:\Temp\keystatus.c2v.

7. Contact Harmonic support and obtain an email address to send your key status file to 
(this is the file you just generated, in the example above it’s called “keystatus.c2v” and is 
located in the folder “c:\Temp”). 

8.  Email the file to Harmonic and we will use your key status information file to generate a 
new license with the expiration date extended to be applied to your USB Security Key. We 
will then email a new license update file to you. 

9.  Once you receive the license update file, save it to disk, for example, with the filename 
“c:\Temp\newlicense.v2c”. Make sure the “USB Security Key update.exe” program is still 
running, and make sure the Apply License Update tab is selected (if not, select it). 
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10. Select Continue (...) to the right of the Update file field. 

11. When the Open dialog box opens, navigate to the appropriate folder (in our example 
from above that would be “c:\Temp”), and select the file name to load the license 
information from (that was “newlicense.v2c” in our example), and select Open. 

12.  When the file name is shown in the Update file field, select Apply update. 

13. If the key is successfully updated, you should see a message like the following:
20:10:30: Applying update from file: c:\Temp\newlicense.v2c Update written 
successfully. 
If you see this kind of message, then your evaluation period has been successfully 
extended and you can now close the USB Security Key update.exe program and start 
evaluating ProMedia Carbon again.

14. Contact Harmonic support if you receive an error messages similar to this one: 19:57:48: 
Applying update from file: c:\Temp\newlicense.v2c Update failed: Key with 
requested id was not found. 

2.3.2.3 Using Canopus Edius 4 or Adobe Premiere CS2

ProMedia Carbon automatically installs a direct print-to-file plug-in for both Canopus EDIUS 
and Adobe Premiere video editing suites. This powerful plug-in will utilize ProMedia Carbon’s 
vast selection of codecs to save your file.  To use the ProMedia Carbon plug-in, follow the 
instructions below:

1. In either Adobe Premiere or Canopus EDIUS, select File, then select Print to File.

2. Choose Rhozet ProMedia Carbon from the list. 

3. ProMedia Carbon will start up automatically with the file from your editing program as the 
source.

4. Choose the target format(s) and then select the Convert tab to continue. 

2.3.3 Installing Carbon Server 3.20 - New Installation
If an earlier version of Carbon Server has previously been installed on this machine, please 
skip this section and go to 2.3.4 Upgrading Carbon Server instead.



Chapter 2 Installing Carbon Products Installing and Upgrading Carbon Products

 © 2012 Harmonic Inc. 26 ProMedia™ Carbon Installation and User Guide v.3.20

ATTENTION:  If you have any other Harmonic products, such as ProMedia Carbon (formerly known as 
Carbon Coder) or Carbon Agent installed on this machine, you must uninstall those products before 
installing a new installation of Carbon Server.

Installation instructions
1. Make sure that QuickTime version 7.6.8 (or later) is installed on your system. It is available 

from the ProMedia Carbon CD-ROM. 

NOTE:  You must install Carbon applications using an account that has administrative rights. We strongly 
recommend using the “Administrator” account.

2. Install the Carbon Server Farm Manager software from the \Carbon Server\setup.exe 
path on the Carbon Server CD. This will install the core components of Carbon Server, 
the drivers for the USB security key (HASP dongle), and Windows Media components. It 
also creates the following shortcuts on the desktop:

 ProMedia Carbon. The version of ProMedia Carbon that runs on the Carbon Server 
machine. You can use ProMedia Carbon to create jobs, manage presets, in the same 
way you can on a stand-alone ProMedia Carbon machine. Please see Chapter 3, 
Using ProMedia™ Carbon for more details.

 Carbon Admin. This tool lets you view and manage the transcoding jobs that are 
currently running on the server and agents. It also allows you to manage the server 
and agent parameters and modify advanced server options. You also use this to 
create, manage, and edit Watch Folders.

3. Reboot the machine. Do not install any other applications before the machine is 
restarted.

4. Insert the Carbon Server USB security key into a USB port on the Carbon Server 
machine.

NOTE:  In order for the Carbon Server to access Watch Folders, read source files, and write target files, it 
needs to be given the correct permissions. Permissions must be set correctly, or you may see errors such as 
"Can't read from source" when using Watch Folders or the API. 

Because the Nexus Service runs on the Carbon Server machine, as well as on all the Carbon Agent 
machines, you must set the permissions on each machine: once for the Carbon Server machine, and once 
per each Carbon Agent machine. If you have purchased any Carbon Agent licenses, it is recommended that 
you finish installing the Carbon Server machine, and all the Carbon Agent machines before creating 
domain or workgroup accounts and setting service credentials. 

5. Create the account that has permission to access the network resources. Options:

 If running in a Windows Workgroup environment, create identical users on all the 
machines using Windows user management. Choose a user name, like cs_service, 
and assign a password. Remember to use the exact same name and password on all 
the machines in the farm.

 If all machines are part of a Windows Domain, just create one domain user account, 
like cs_service.

6. Change the Nexus Service’s default credentials, “Local System,” to the user account you 
created earlier, like cs_service.

7. Go to Start > Control Panel > Administrative Tools > Services.

8. Double-click Nexus Server (Carbon Server Farm) service.

9. Select the Log On tab.

10. Click OK.

11. Stop and restart the Nexus Service.
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12. Close the Services console.

2.3.4 Upgrading Carbon Server
Follow the upgrade installation instructions in this section if you already have a version of 
Carbon Server, and are upgrading to Carbon Server 3.20. Make sure to follow the installation 
steps order exactly, otherwise valuable data may be lost.

NOTE:  The old Carbon Server Web Interface does not work on any Windows Server 2008 or Windows 7 
systems. The Web Interface is deprecated and is no longer being updated.

1. Exit any open Harmonic application.

2. Install Carbon Server 3.20 from the \Carbon Server\setup.exe path on the Carbon Server 
3.20 CD.

3. Reboot the system when prompted by the Carbon Server installer.

4. Using Carbon Server Admin, verify that you can see all your old presets, Watch Folders, 
and retrievals & notifications.

5. Make sure you follow the instructions in 2.3.5 Installing Carbon Agent on page 28 for 
information on how to install your Carbon Agent machine.

When you have completed installing or upgrading Carbon Server and Carbon Agent, see 
Chapter 4, Using Carbon Admin or Chapter 5, Configuring Carbon Server for setting up 
Carbon Server.

2.3.4.1 Performing a Clean Uninstall of Carbon Server

Under normal conditions, the standard uninstall process of Carbon Server should be used. If 
you are experiencing problems, Harmonic support may ask you to perform a complete or 
'Clean' uninstall. 

NOTE:  This clean uninstall will remove all your customizations from the Carbon Server machine, 
including Watch Folders and their configurations, jobs in progress, and any user-created presets. To avoid 
losing valuable information, follow the procedures below only as instructed by Harmonic support.

1. Exit any Harmonic application.

2. Uninstall Carbon Server using Start > Programs > Rhozet > Carbon Server Farm > 
Uninstall Carbon Server Farm. 

3. Delete the following folders:

 Program File folder: c:\Program Files\Rhozet\

 User presets & system presets folder: c:\Program Files\Common Files\Rhozet\

 Watch folder information and job folder (jobs, completed and in progress, and Watch 
Folder information are stored here): c:\Documents and Settings\All 
Users\Application Data\Rhozet\

4. Using the Registry Editor tool (select Start > Run… and enter regedit), delete the 
following registry keys (if present): HKCU\SOFTWARE\Rhozet and 
HKLM\SOFTWARE\Rhozet.

5. Restart the machine now.

6. If necessary, re-install Carbon Server normally, rebooting when prompted. 
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2.3.5 Installing Carbon Agent
This section provides step-by-step instructions for installing Carbon Agent. 

NOTE:  If you have any other Harmonic product (such as ProMedia Carbon or Carbon Server farm 
manager) installed on this machine, you must uninstall that product before installing Carbon Agent. Note 
that the USB security key provided with Carbon Agent allows you to install either Carbon Agent or 
ProMedia Carbon. You cannot have both products installed on the same machine simultaneously, because 
they each use a background Nexus Service and will conflict with each other.

1. Install QuickTime 7.6.8 from the \QuickTime folder on the Carbon Server CD. 

NOTE:  From time to time, newer versions of QuickTime are released, and once they are verified to work 
correctly with Carbon Server, Harmonic will include those newer versions on the distribution CD. You 
should not independently update components that have not been verified with Harmonic. Please contact 
Harmonic if you are unsure. See A.4 Contacting Harmonic Support.

2. If a previous version of Carbon Agent is installed, uninstall it by selecting Start > 
Programs > Rhozet > Carbon Agent > Uninstall Carbon Agent. Follow the on-screen 
instructions, and be sure to reboot after the un-installation completes.

3. Install the Carbon Agent software from the \Carbon Agent\setup.exe path on the CD. This 
will also install the drivers for the USB security key (HASP dongle), and Windows Media 
components. It also creates the Carbon Agent Admin shortcut, which enables you to view 
and manage the transcoding jobs that are running on the local agent.

4. Reboot the machine.

NOTE:  In order for the Carbon Server Nexus Agent to access Watch Folders, read source files, and write 
target files, it needs to be given the correct permissions. Permissions must be set correctly or you may see 
errors such as "Can't read from source" when using Watch Folders or the API. Permissions should already 
have been set in Step 5, 2.3.3 Installing Carbon Server 3.20 - New Installation on page 25.

5. Create the account that has permission to access the network resources (if you did not do 
so during Carbon Server installation). Options are:

 If running in a Windows Workgroup environment, create a user on this machine using 
Windows user management. Choose a user name like cs_service and assign a 
password. Remember that this must be the same user name and password as you 
used on all the other machines in the farm, both the Carbon Server machine and 
other Carbon Agent machines.

 If all the machines are part of a Windows Domain, create only one domain user 
account, like cs_service. You only need to do this once, so if you already created the 
domain user account during the installation of the Carbon Server machine or one of 
the other Carbon Agent machines you don’t need to do it again for this machine.

6. Make sure that the account you just created has permission to read files from and write 
files to all the network resources that Nexus needs to access. 

NOTE:  This includes the administrative shares (for example, “C$”, “D$”), specifically on the drive(s) on 
the Carbon Server machine where the System Presets and User Presets are located. It also includes folders 
that contain source files, folders where target files will be written, program files, folders that contain 
presets (see below for locations of these), etc.

7. Go to the Carbon Server machine and select Start > Run… The Carbon Server System 
and User Presets are stored in the registry in two keys.

8. Enter regedit to start the Registry Editor tool to locate these keys: 

 HKLM\Software\Wow6432Node\Rhozet\CarbonServer 
Farm\Common\PresetCacheValidator\SysPresetDir
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 HKLM\Software\ Wow6432Node\Rhozet\CarbonServer 
Farm\Common\PresetCacheValidator\UsrPresetDir

 HKLM\Software\ Wow6432Node\Rhozet\CarbonServer 
Farm\Common\PresetCacheValidator\WizPresetDir

9. Select Start > Control Panel > Administrative Tools > Services.

10. Double-click Nexus Server service.

11. Select the Log On tab.

12. Select This account and set the credentials for the service, user name and password 
(twice). 

 If running in a Windows Workgroup environment, enter the user name with a leading 
period character, but no domain name (for example, \cs_service). You can also use 
Browse.

 If running as part of a Windows Domain, enter the user name with the domain name 
(for example, domain\cs_service). You can also use Browse.

13. Select OK.

14. Close the Services console.

15. Insert the supplied Carbon Agent USB security key into a free USB port on the Carbon 
Agent machine.

16. Reboot the machine.

When you have completed installing ProMedia Carbon, see 3.2 Using the ProMedia Carbon 
Interface on page 30.
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Chapter 3
Using ProMedia™ Carbon

This chapter provides information about using ProMedia™ Carbon as a standalone application 
(on one computer, with Carbon Admin) to convert source files by assigning target formats and 
filters. The first section, 3.2 Using the ProMedia Carbon Interface, provides a quick file 
conversion overview. The second section, 3.3 ProMedia Carbon Interface Options and Details 
on page 37, provides many of the details and procedures for using ProMedia Carbon’s 
interface to fine-tune your file transcoding. 

3.1 Starting ProMedia Carbon
Double-click the ProMedia Carbon icon on your desktop.

3.2 Using the ProMedia Carbon Interface
Starting ProMedia Carbon opens the home screen, which shows three tabs on the left side of 
the screen: Source, Target, and Convert. These tabs control basic functions that allow you to 
add source files, set the target conversion format, modify input and output details, and begin 
the conversion processes. 

NOTE:  You can automate multiple file conversions using Carbon Admin and Watch Folders. See 
4.1 Using the Carbon Admin Interface on page 71.
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You will notice that the content in the center of the home screen changes depending on the 
tab you have selected, but generally this area displays the files you are working with. After 
selecting a particular file, you will see its properties on the right side of the screen. This is the 
Source Parameters dialog box, and it shows you the details of your original file and allows 
you to change certain aspects of that file. 

And finally, if you need assistance or more information for any feature, there is a help icon on 
the bottom left that provides general instructions on each area of the product. There is also a 
Help menu item that has detailed, searchable information.

The basic process for performing a transcode:

1. Select the Source tab to add the file(s) you wish to convert.

2. Select the Target tab to choose which format(s) you want to encode to.

3. Select the Convert tab to encode your file(s) and complete the process.

3.2.1 Adding Source Files
To begin, you will need to add a source file. A source file is the file you want to convert into 
another format type. You can add one source file for a single file conversion, or you can add 
multiple source files for easy batch conversions.

1. Select the Source tab.

2. Click Add to choose the file you want to convert. This will bring up the Open File dialog 
where you can select the file you want to convert. 

3. Select a single file, then click Open.

You will now see the selected file in the Source List.
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The Source Parameters window on the right displays the properties for the source. The 
Source Parameters window is designed to show you the details of your original file and allow 
you to change certain aspects of that file. For example, you might want to change the 
interpreted pixel aspect ratio of the source or choose a different audio source file rather than 
the one embedded with the source file. If you select any item, you will see a more detailed 
description in the lower right window pane. 

To the left of your source list, you will also see a button for advanced functions, as well as a 
Stitch check box. These functions provide controls that allow you to, for example, select only 
a segment of your video for transcoding or to “stitch” (combine) a number of input files into a 
single output file. These functions will be described in detail later in the manual.

You can add multiple source files for easy batch conversions or combine (stitch) multiple files 
together for one single output file. Stitching allows you to link multiple sources together to 
create a single seamless result, preventing you from having to combine the sources in an 
editor. Select the Stitch check box to link the multiple sources together to create a single 
seamless source file. Use the arrow keys to rearrange the order of each source. 

3.2.2 Assigning a Target Format
The next step is to assign a target format for your files to be converted. You can select a 
single- or multiple-target formats. Select the Target tab, and then click Add to bring up the 
Load Target Preset dialog box.
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The Load Target Preset dialog box has two columns. On the left side are categories of 
transcoding presets, and on the right are the actual presets. First select a category on the left 
and then select one of the available presets on the right. A category (like Web) can have 
several sub-categories (like QuickTime, Windows Media, etc.). ProMedia Carbon ships with 
over a hundred presets to help you get started. You can modify these presets and create your 
own. You can also create new categories for storing your own presets

1. In the Load Target Preset window, select a desired category on the left side.

2. Select (+) next to a category (if needed) to display its sub-categories. The right side 
displays all the available presets for that category. When you have selected a preset, you 
will see complete details of the format settings in the description pane located in the 
bottom of the Load Target Preset dialog box. You can use SHIFT + SELECT or CTRL + 
SELECT to select multiple presets within a single category.

3. Click OK to add this preset to your Target window. 

4. Repeat steps 1-3 to add multiple targets.

After you have added a target format to the Target List, you will see the specific encoding 
parameters on the right-hand side of the screen. You can modify every parameter, including 
output file naming, encoding parameters, audio processing, etc. After you have modified 
encoding parameters, you can save them to disk to be reused in the future by selecting Save 
Profile. Below the Save Profile button, there is also an Advanced button. This button allows 
you to access advanced codec encoding parameters, as well as add video and audio filtering 
to your video encoding.
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3.2.3 Target Parameters
The Target Parameters window displays the properties of the currently selected target in the 
Target tab. All of the resources necessary for managing and modifying your target 
parameters are available in this window.

The target’s basic parameters appear in the Target Parameters section. You can modify any 
of the parameters that aren’t grayed out. Simply enter values in the fields, or use the drop-
down menus to modify the default target parameters.

If you want to save the changes for a custom target, select Save Profile. Saved presets are 
visible in the Custom tab in the Add Target dialog box.
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3.2.4 Adding Filters
Video and Audio filters can be added to either individual source or target files, depending on 
your workflow. Video and Audio filters allow you to manipulate the video/audio during the 
transcode to perform tasks such as logo insertion, audio normalization, and color correction.

1. Select Advanced from the Source or Target screens to see the advanced controls and 
select the Video Filter tab.

2. Click Add to add one or more video filters to your target. 

3. Selected filters are applied from the list top-down, so the top-most filter in the list is 
applied first, and the bottom-most filter in the list is applied last.

4. To adjust the order of the filters in the list, select the filter in the list, then select Up or 
Down to move it up or down in the list. 

5. Once you have added a filter, you can select the filter in the list to view and adjust its 
properties just below the video preview. 

NOTE:  From this view, you can also save Preset Video Filters.

6. Click OK.



Chapter 3 Using ProMedia™ Carbon Using the ProMedia Carbon Interface

 © 2012 Harmonic Inc. 36 ProMedia™ Carbon Installation and User Guide v.3.20

3.2.5 Converting your Files
The last stage of the process is to convert (transcode) your files into their new formats. If you 
have chosen to convert one file into several output files, ProMedia Carbon will do each 
transcode simultaneously. You can view the output of the transcode during the transcoding 
process, and you can also play any transcoded file from the Output List on the right-hand side 
of the screen.

1. Select the Convert tab. The Convert tab will be greyed out until you have chosen a 
source file and a target format.

2. Click Convert to begin the encoding process.

3. Click Pause to temporarily halt the encoding process. 

4. Click Stop to cancel the encoding process. 

5. Select the Preview check box to turn on or off the video preview.

NOTE:  The encoding process is faster when the preview is turned off. As each file is finished, it can be 
played from within the program (even if other transcoding conversions are still in process). 

When the conversion is finished, the message “Conversion Finished” appears in the yellow 
description box at the bottom of the window.
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6. In the Output List, select the file you would like to view and then click Play File, located 
on the bottom right of the screen.

NOTE:  ProMedia Carbon automatically makes the necessary settings to be sure the source format 
transcodes properly to the target format.

3.3 ProMedia Carbon Interface Options and Details
ProMedia Carbon’s home screen tabs, Source, Target, and Convert, provide a host of 
additional preset, filter, job, capture, and conversion options detailed in the following sections.

3.3.1 Using the Source Tab
The Source Tab lets you add/remove source files, sort them, modify, enhance and repair 
source video settings prior to the conversion process

The Source List displays all of the source files you are planning to transcode. Use the buttons 
and options on the left to modify the list.

 Add. Click Add to add files to the list. You can also add files by dragging and dropping 
them onto the Source List.

 Remove. Click Remove to remove the currently selected file(s) from the list. You can also 
delete them using the delete key. 

 Remove All. Click Remove All to remove all of files from the list. 

 Advanced. Click Advanced to open the Advanced dialog box that will appear on top of the 
main ProMedia Carbon window. Double-clicking an item in the Source List also opens the 
Advanced dialog box. To close the Advanced dialog box, click Close.

 Stitch. Select this check box if you want ProMedia Carbon to connect all the items in the 
Source List into one logical source file. Stitching is useful if you want to connect multiple 
source segments. Use the arrow keys to reorder the Source List before the files are 
stitched together. By enabling the Stitching feature, you can encode multiple files into a 
single file.

3.3.1.1 Adding Source Files

1. Select the Source tab.

2. Click Add to choose the file you want to convert. 

3. When the Open File dialog box opens, select the file you want to convert. 

4. Select a single file and click Open.

You will now see the selected file in the Source List.

3.3.1.2 Choosing Source Parameters Settings

The Source Parameters window displays the properties of the currently selected source in 
the source tab. All of the resources necessary for managing and modifying your source 
parameters are available in this window.

When you add a file to the Source List, ProMedia Carbon automatically reads the file 
properties and analyzes its parameters. You can read more about each parameter by 
selecting it and referring to the Description section located in the bottom right-hand corners 
of the Source or Target tab windows.
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For example, if you add an interlaced source file to the Source List, the Parameters section 
tells you if the Bottom Field or the Top Field appears first in the Interlacing field. While 
ProMedia Carbon does its best to make the correct assessment, it may incorrectly identify the 
field order. If this happens, you can use the Interlacing drop-down menu to override ProMedia 
Carbon and choose the correct setting.

The parameters that appear differ depending on the type of file selected. The parameters that 
you can change also differ depending on the type of file selected. 

Select a parameter to view a description of its properties in the Description panel at the 
bottom of the screen.

3.3.1.3 Advanced Features Window

ProMedia Carbon’s Advanced window offers three tabs, Setup, Video Filter, and Audio 
Filter, to allow you to optimize the source file prior to the encoding process. You can trim the 
file, add a video filter to clean up the image, or apply an audio filter to enhance the audio 
quality.

To access the Advanced window from the basic view, do one of the following:

 Click the Advanced button (on the left, under the Remove All button).

 Double-click the Source entry.

 Right-click the Source entry and choose Advanced.

Setup

By selecting the Setup tab, you will be able to trim a segment of your video for transcoding.
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To trim a segment of your video, use the Video Scrubber, Play, or Time Controls to choose 
the desired In and Out points. The In button sets the In Point at the current displayed frame. 
The Out button sets the Out Point at the current displayed frame.

Trimming a Segment

1. If you are using the video scrubber, move the cursor to the desired In point and select In.

2. Move the cursor to the desired Out point and select Out. 

The selected video will appear on the video scrubber as a white bar. 

3. To play the selected area, select the Play (icon) button. 

4. Select Add Current Segment to add the new selection to the list of segments. Or you 
can select Enter Segment to directly enter an in/out point pair: 

 Scrubber/Play Controls. Use the scrubber or play controls to choose your In point 
and then select In. Then choose your Out point and select Out.

 Trimming section 

In. Sets the In Point at the currently displayed frame. The In Point’s Time and Frame 
number are listed in their respective boxes.

Out. Sets the Out Point at the currently displayed frame. The Out Point’s Time and 
Frame number are listed in their respective boxes.

 Clip section 
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Time. Displays the time for the frame at which the scrubber is stopped. You can also 
use the arrow buttons to find a specific time at which you want to set the In or Out 
point, or simply enter a time in the Time field.

Frames. Displays the frame number at which the scrubber is stopped. You can also 
use the arrow buttons to find a specific frame at which you want to set the In or Out 
points. You can also simply enter a frame number in the Frame box.

Total. Displays the source file’s total duration after the In and Out Points are set. This 
value is calculated automatically and cannot be modified by hand. It can only be 
modified by setting the In and Out points. Duration time is displayed in 
hours:minutes:seconds:frames.

3.3.1.4 Video Filter Tab

The Video Filter tab lets you apply filters to your video to help improve the image quality of 
your source files before they are converted. The filters can be previewed in this tab prior to 
the conversion process.

1. Select Advanced from the Source screen to see the advanced controls and then select 
the Video Filter tab.

2. Click Add to add one or more video filters to your source. A brief description of each filter 
is listed in the Description box when the filter is highlighted. You can browse the different 
filter categories on the left and choose filters from the right. Holding down SHIFT or CTRL 
and selecting the desired filters lets you add multiple filters to the Filter list. Remember 
that you can add filters to both sources and targets, so you should only add a filter at the 
target to improve it, for example, a brightness filter to correct a dark target. 
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3. The filter name(s) will appear in the Filter List. To the right you will see a preview of how 
the filter changes your source file in the Result window.

4. To adjust the filter parameters, use the sliders below the preview pane to your desired 
specifications.

5. Selected filters are applied from the list top-down, so the top-most filter in the list is 
applied first, and the bottom-most filter in the list is applied last. To adjust the order of the 
filters in the list, select the filter in the list then select Up or Down to move it up or down 
in the list.

Previewing Video Filters

The Original window displays what the original file looks like before filtering. The Result 
window displays the original file with the filters in the filter list applied.

The Plus button enlarges both preview images and the Minus button makes both preview 
images smaller. If the preview image is larger than the window, scroll bars appear allowing 
you to navigate through the entire image. You can also select and drag the image to navigate 
through the image.

The Fit to Window button resizes the preview images to fit inside the window’s current size. 
No matter what size the window, this preview mode preserves the aspect ratio assigned to 
the file. This button is useful if you enlarged or reduced the preview image and want to view 
the whole image in the window again.

The 1:1 button displays the video at 1-to-1 pixel size. (1 monitor pixel = 1 video pixel)

Use the Scrubber bar to find specific frames in the source video that you want to use so you 
can see the effect of the filter(s) on the specific frame. You can either select and drag the 
scrubber or use your keyboard’s arrow keys to step through the video’s individual frames.

Large Preview

Selecting the Large Preview button opens a floating window that allows you to modify the 
preview size. This helps scrutinize the finer details of your video. You can use the scrubber 
bar to find specific points in the video and resize the window as needed; it adjusts the size of 
the previews proportionally. It has the same controls as the Video Filter tab.

Video Filter Presets

This section describes the video filter presets that are supplied with ProMedia Carbon.

 601 Correction-Expand Color Space. This filter expands the RGB range of the from 16-
235 to 0-255. Use this filter to create output for a system that uses the full 0-255 range 
from input that uses 16-235.
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 601 Correction-Shrink Color Space. This video filter shrinks the RGB range of the video 
from 0-255 to 16-235. Use this filter when create output for a system that uses the 16-235 
range from input that uses the full 0-255 range.

 601 to 709 Color Correction-SD/HD Color Space. This video filter is used to convert 
video in the SD (601) colorspace to the HD (709) colorspace. Broadcast HD video uses 
YCbCr colors following Rec. ITU-R BT 709-5 whereas broadcast SD video follows ITU-R BT 
601. 

 709 to 601 Color Correction. The inverse of the above.

 Adaptive De-Interlace. Perform custom de-interlacing of interlaced content for 
progressive targets, either using Adaptive De-Interlace, Interpolate from Dominant Field, or 
Discard Dominant Field. Use this filter only when you want to change the default de-
interlacing behavior.

 Bitmap Keying. Superimpose a bitmap logo or graphic on the video. This is often used to 
watermark video so it can be personalized.

 Black/White Correction. This filter lets you adjust and control the levels of black and white 
pixels in your video. By adjusting the sliders, you can specify at which point a pixel will 
become black and/or white. The higher the setting, the more nearly black pixels will be 
converted to true black and vice versa. This works best if you are encoding video for the 
Web and need to adjust the black and/or white levels of broadcast video so that they are 
truly black or white. It’s also useful for making white titles on a black background more 
legible when viewing on a computer monitor.

 Blur. This filter blurs the video in a rectangular pattern.

 Broadcast Color Safe. Restricts the color range of the video to broadcast-safe values. 
Some colors that can be displayed on a computer cannot be displayed on television or 
video output. This filter restricts the colors in the source to only colors that are safe for 
television and video broadcast.

 Caption 608 to 708 Conversion. Converts CEA-608B caption payload in the Carbon 
pipeline to CEA-708D format. The 708 payload is then available to Exporters and Filters, to 
be inserted into output files. Note that when this filter is applied, 708 captions will always 
be overwritten by converted 608 captions, even if the 608 caption payload was empty.

 Caption Convert 708 to Ancillary. Converts CEA-708 captions from the transcoder 
pipeline "708 caption payload" into caption data inside the "Ancillary data payload" 
compliant with SMPTE-291m. Other filters or exporters can then manipulate or consume 
the ancillary data.

 Caption Convert Ancillary to 708. Converts CEA-708 captions from the transcoder 
pipeline "Ancillary Data" payload into caption data inside the "708 caption payload". Other 
filters or exporters can then manipulate or consume the ancillary data.

 Caption Inject from .SCC file Caption. Inserts caption data from an SCC closed caption 
file into target files. This filter should be added on the side (source versus target) that has 
the same frame rate as used inside the SCC file.

 Circular Blur. This filter blurs the video in a circular pattern. 

 Color Correction. This filter allows you to adjust the brightness, contrast, hue and 
saturation of your video image.

 Deblocking Filter. The deblocking Filter is used to smooth edges in the video, making the 
compression easier. 

 DVD Subtitle/608 CC1 Imprint. Imprints either DVD subpicture subtitles, or 608-style 
captions from the CC1 line of the VBI section of sources that allow and carry content in the 
VBI.
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 Fade In/Out. This filter applies a fade in and/or out to your video in order to aid the 
encoding process. You should use this filter if your source video has a lot of fast motion in 
the first few frames. The fade-in gives ProMedia Carbon a “running start” so it can encode 
your video more efficiently.

 Flexible-to-fixed Frame rate Conversion. Use this filter to correct jittery frame timestamps 
while decoding from flexible frame rate source video files.

 Gamma Correction. This filter adjusts your video’s gamma settings.

 Gaussian Blur. This filter applies a Gaussian blur to the video.

 Line 21 Extraction and Line 21 Modulator. Allows the extraction and insertion of 608-
style closed captions from- and into- Line 21 of the VBI for sources and targets that have a 
VBI section. The Line 21 extraction filter now auto scans the VBI lines and places the data 
correctly into Line 21. The following SD video formats are supported: 720 X 512 for NTSC 
and 720 X 608 for PAL. 

 Map Alpha to Target Y Channel. This filter takes the Alpha channel from the source and 
maps it into the Y channel of the target. All other source channels (R,G, & B) are discarded.

 Median. This filter is designed to improve picture quality by removing single-pixel defects 
without affecting the sharpness. This is similar to a despeckle filter.

 Motion Compensated Temporal Filter. Motion Compensated Temporal Filter (MCTF) has 
the ability to remove noise that may not be visible to the naked eye from input files with 
noisy video. Removing this noise makes the subsequent encode faster. It also allows the 
encoder to use a lower bit rate to generate the same quality, or to generate higher quality 
at the same bit rate.

 OP42 to OP47. Inserts OP42 compliant Teletext subtitles as OP47 packages into the 
SMPTE291m stream

 OP47 to Teletext. Copies OP47 packets from ANC space into the Teletext pipeline.

 Pulldown. This filter offers conversion without interpolation for progressive-to-interlaced 
(that is, film-to-video) file conversion. This preserves full spatial image quality and creates 
target fields that are selected from the nearest temporal source frame. Displaying the 
resulting file on a progressive display, such as a computer monitor, produces very 
noticeable interlacing artifacts. However, displaying this on an interlaced display, such as a 
television, produces very good image quality. This method is generally used when 
cinematographic footage is encoded to a DVD and played on a TV.

 Relative Crop. Allows for percentage-based cropping of sources. It is usually preferred to 
use the Video Source Properties filter to crop sources, since that crop filter can be applied 
to targets and can therefore also be used in Watch Folders. Relative Crop may be 
deprecated in future releases of Carbon.

 Rotate. This filter provides 90-degree rotation and axis-flipping for the video.

 Sharpen. This filter sharpens the video using the “Un-Sharp Mask” technique.

 STL Caption Burn-In. Imprints STL subtitles onto the video.

 Teletext Data Extraction. Extracts Teletext lines from VBI and makes them available for 
filter and target plugins. Used in combination with the Teletext Data Modulator filter.

 Teletext Data Modulator. Modulates Teletext data onto VBI lines. Used in combination 
with the Teletext Data Extraction filter.

 Teletext Inject from STL file. Imports an STL subtitle file, and converts the contents into a 
Teletext payload in the ProMedia Carbon pipeline. Several other filters and exporters are 
able to use or manipulate this Teletext payload or write it to output files.

 Teletext Subtitle Captioner. Imprints teletext subtitles onto the video frame.

 Temporal Noise Reducer. This filter removes noise by using temporal noise reduction. 
Temporal noise reduction is effective for removing analog noise.

 Timecode Display. Overlays the video with timecode.



Chapter 3 Using ProMedia™ Carbon ProMedia Carbon Interface Options and Details

 © 2012 Harmonic Inc. 44 ProMedia™ Carbon Installation and User Guide v.3.20

 Timecode Extraction-VITC. Extracts Vertical Interval Time Code (VITC) from NTSC and PAL 
input files with Vertical Blanking Interval (VBI) sections and makes the timecode available 
for other filters and targets.

 Timecode Insertion-VITC. Inserts Vertical Interval Time Code (VITC) into NTSC and PAL 
output files with Vertical Blanking Interval (VBI) sections.

 Timecode Processing. Processes and corrects sources with incorrect or undesirable 
timecode. Processed timecode is available to downstream Filters and Exporters.

 VBI Import from SMPTE 436M. Imports SMPTE 436M VBI from an MXF file and adds it to 
the video. This filter needs to be applied on the source side. 

 VBI Mapper. This filter maps incoming VBI lines to output lines chosen by the user.

 V-Chip. V-Chip Filter. For insertion of V-Chip rating information into MPEG-2 Video User 
Data.

 Video Inverse Telecine Filter. Use this filter to apply inverse telecine to sources that have 
had 2-3 telecine applied.

 Video Metadata Inject. The current version of the filter allows the setting of the start 
timecode of the target file and setting chapter markers. The syntax of the XML input file for 
this filter is as follows:

<cnpsXML StartTimeCode="00:00:05;00">
<Markers>

<Marker_1 MarkerTime_27MHz.QWD="270000000" 
MarkerName="Marker1"/>

<Marker_2 MarkerTime_27MHz.QWD="540000000" 
MarkerName="Marker2"/>

<MyMarker MarkerTime_27MHz.QWD="810000000" 
MarkerName="MyMarker"/>

</Markers>
</cnpsXML>

 Video Source Properties. This filter allows you to crop the source file before transcoding it 
to the target file(s). It can also be used to force the aspect ratio of the source file, and the 
force the detection and handling of progressive vs. interlaced content. This filter can also 
be used when creating Watch Folders, which otherwise don’t allow the manipulation of the 
properties of the source files. In the ProMedia Carbon application, it is possible to use this 
filter on a source as well as a target.

 Video Timecode Inject. Do not use this filter for new workflows. It will be deprecated in a 
future release. Use the Timecode Processor filter instead.

 XML Titler. This is an advanced, fully-featured filter that allows for a rich set of features 
when applying titles to target video files. The XML Titler video filter uses data from an XML 
file to add titles and images to a video stream. The syntax of the XML input file for this filter 
is discussed below.

The XML files to use with the XML Titler should look like this:

<?xml version="1.0"?> 
<TitlerData>
<Data StartTime='0.5' EndTime='4.0' Title='First title' 
CharSize='0.45' PosX='0.5' PosY='0.75'
ColorR='220' ColorG='220' ColorB='220' Transparency='0.0' 
ShadowSize='0.5' />
<Data StartTime='4.5' EndTime='13.5' Title='This is the second 
title' CharSize='0.25'/>
<Data StartTime='16.0' EndTime='21.0' Title='A third title' />
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  </TitlerData> 

See  XML Elements and Attributes for Text Titles,  XML Elements and Attributes for Image 
Titles, and  XML Titler (Additional Notes) for more information.

XML Elements and Attributes for Text Titles

If you selected the XML Titler video filter preset, the following XML elements and attributes 
for Text Titles apply:

 <?xml version="1.0"?>. This is the XML file header and must be present.

 <TitlerData>. This tag indicates the start of the titler data block.  The block must be closed 
with the </TitlerData> entry.  XML titler files must contain exactly one titler data block, in 
which there will be one data entry for each title to display.

 Data entries. Each data entry starts with the tag Data and describes one title to be 
displayed.  It may contain several parameters:

 Font. Specify the name of the font, for instance Arial.  Only one font may be selected 
per titler project.  If more than one font is present in the titler's XML data, only the first 
one will be used.  If the specified font is not installed or cannot be loaded, the XML 
titler will fail (that is, a different font will not be used as a fallback).

 FontCharSet. Specify the character set to use for the font. Allowed values are:

0: ANSI

1: BALTIC

2: CHINESEBIG5

3: DEFAULT

4: EASTEUROPE

5: GB2312

6: GREEK

7: HANGUL

8: MAC

9: OEM

10: RUSSIAN

11: SHIFTJIS

12: SYMBOL

13: TURKISH

14: VIETNAMESE

15: JOHAB

16: ARABIC

17: HEBREW

18: THAI

 StartTime. The time, in seconds, at which the display of this data entry's title will start.

 StartTimecode. An alternative to StartTime.  Instead of using a floating-point value 
like '5.5' for 5.5 seconds, you can use a time code value ('00:00:05:15').

 EndTime. The time, in seconds, at which the display of this data entry's title will end.
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 EndTimecode. An alternative to EndTime.  Instead of using a floating-point value like 
'5.5' for 5.5 seconds, you can use a time code value ('00:00:05:15').

 FadeInTime. Duration, in seconds, for which the title or image will fade in.

 FadeOutTime. Duration, in seconds, for which the title or image will fade out.

 Italics. The italic function is used much like <i> and </i> in HTML.  Within the Title 
string value, use ?ital;? to begin the italics section and ?/ital;? to end the italics. 

Sample:

<?xml version=”1.0”> 
<TitlerData>
<Data Title=’ital;This text will be italic /ital;’/> 
</TitlerData>

 Line Breaks. To insert a line break, within the Title string use the two bytes "0D 0A" 
to mark the end of line, or if editing XML data with Notepad, simply press the Enter 
key at the desired location of the line break.

 Title. The title text to display.

 CharSize. Value between 0.0 and 1.0 which controls the size of the characters.

 PosX. Value between 0.0 (left of the screen) and 1.0 (right of the screen) used to 
position the title horizontally.

 PosY. Value between 0.0 (top of the screen) and 1.0 (bottom of the screen) used to 
position the title vertically.

 ColorR, ColorG, ColorB. Values between 0.0 and 255.0, which respectively describe 
the amount of Red, Green and Blue to use for the title's color.

 Transparency. Value between 0.0 (fully opaque) and 1.0 (fully transparent), which 
determines the title's transparency.

 ShadowSize. Value between 0.0 (no glow) and 1.0 (strongest glow), which 
determines the glow, or shadow, around the title used to enhance its readability.

 HardShadow. Binary value of 0 or 1.  0: normal shadow 1: shadow with a hard 
border

 BkgEnable. Set value to 1 to enable use of black background behind text area, 
otherwise set to 0.

 BkgSemiTransparent. Set value to 1 to make text background semi-transparent, 
otherwise set to 0.  Only takes effect to BkgEnable to set to 1.

 BkgExtraWidth. Specifies how much wider than the text the background should be.  
This value is relative to the width of the image; so setting it to 0.05 would extend the 
background by 5% of the image's width.

 BkgExtraHeight. Specifies how much taller than the text the background should be.  
This value is relative to the height of the image; so setting it to 0.05 would extend the 
background by 5% of the image's height.

 RightToLeft. Set value to 1 for the text to be displayed in right-to-left order, otherwise 
set to 0.

 HAlign. Horizontal alignment of the title.

 0: Center

 1: Left

 2: Right
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 VAlign. Vertical alignment of the title.

 0: Centered around the first line.

 1: Centered

 2: Top

 3: Bottom

XML Elements and Attributes for Image Titles

If you selected the XML Titler video filter preset, the XML elements and attributes described 
in this section apply to Image Titles. When using image scripting, most of the XML tags 
previously defined for text (such as background, color, and position) do not apply to images.  
Supported image formats are tif, png, tga, and psd.  

 <?xml version="1.0"?>. This is the XML file header and must be present.

 <TitlerData>. This tag indicates the start of the titler data block.  The block must be closed 
with the </TitlerData> entry.  XML titler files must contain exactly one titler data block, in 
which there will be one data entry for each title to display.

 Data Entries

 StartTime. The time, in seconds, at which the display of this data entry's title will start.

 StartTimecode. An alternative to StartTime.  Instead of using a floating-point value 
like '5.5' for 5.5 seconds, you can use a time code value ('00:00:05:15').

 EndTime. The time, in seconds, at which the display of this data entry's title will end.

 EndTimecode. An alternative to EndTime.  Instead of using a floating-point value like 
'5.5' for 5.5 seconds, you can use a time code value ('00:00:05:15').

 Image. The local path and filename for the image file to be used in the title.

Sample: 

<?xml version=”1.0”>
?<TitlerData>
?<Data StartTime=’0’ EndTime=’6.1’ Image=’E:\alphatest.tif’/>
?<Data StartTime=’7’ EndTime=’26.1’ Image=’E:\betatest.png’/>?
</TitlerData>

 ImageOffsetX. Image horizontal offset, in pixels.  Please note that “0” denotes the far 
left and increasing values will offset the image to the right.

 ImageOffsetY. Image vertical offset, in pixels.  Please note that ?0? denotes the top 
of the image and increasing values will offset the image towards the bottom.

 ImageScaleX. Image horizontal scale factor.  Eg. 1.0 is actual size, 0.5 is half size, 
and 2.0 is double original size.

 ImageScaleY. Image vertical scale factor.  Eg. 1.0 is actual size, 0.5 is half size, and 
2.0 is double original size.

 Transparency. Value between 0.0 (fully opaque) and 1.0 (fully transparent), which 
determines the title's transparency.

XML Titler (Additional Notes)

 The first data entry should define all the different parameters.

 If a data entry does not set a parameter, the last value set for this parameter will be 
used for that data entry.  For instance, if you want a transparency value of 0.2, you 
may put Transparency='0.2' only in the first data entry and that value will be used for 
all other data entries.
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 The title's first line is always centered on the position described by PosX and PosY.

 The data entries must be sorted according to start time in the XML file.

 Unless specified, titles are displayed on a single line.  The XML titler will not add a 
line break if a line is too long.  It will be clipped from the left and right.  Line break 
characters must be inserted in the Title in order for a line break to occur. 

 Only one font may be used per XML titler filter instance.

 When using StartTime/EndTime for NTSC, in order to identify the start and end time 
of the titles, make sure to use drop-frame time code.  Non-drop-frame time code 
approximates the real frame rate and will drift away from the actual time by a few 
frames every minute.

 When using StartTimecode/EndTimecode, both drop-frame and non-drop-frame time 
codes are supported.  Drop-frame is in the format 'hh:mm:ss:ff', while non-drop-frame 
time code’s format is 'hh:mm:ss;ff'.  Notice that seconds and frames are separated by 
a semi-colon in non-drop-frame time code.

 When using StartTimecode/EndTimecode, the title display timing will not be accurate 
in the video filter's preview (Video Filter tab of Advanced > Filter). 

 You can use Internet Explorer, or a number of other tools, to verify if your XML file 
has correct XML syntax.  Simply open your file in Internet Explorer; if any errors 
related to the XML syntax exist, Internet explorer will display them.

 You can mix image data with regular data, but if a Data entry has an image, then its 
title will be ignored. 

 The images should be the same size as the video you are rendering onto, otherwise 
they will be copied starting at the top-left corner of the image, with 1:1 pixel 
mapping.

 XYZ to RGB Video Filter. Converts video using the XYZ color model to the RGB color 
model. The XYZ color space is an international standard developed by the CIE 
(Commission Internationale de l’Eclairage). 

Saving Custom Video Filter Presets

A custom preset saves the customized settings of the selected filter. Saving a custom preset 
is useful if you plan on reapplying the same filter settings in the future. Custom presets are 
stored with the default presets and can be categorized into folders and subfolders.

1. Select the filter you would like to modify from the Filter list.

2. Modify the filter’s properties according to your specifications. 

3. Select Save Preset. The Save Video Filter Preset window will appear. 

4. At the bottom of the Save Video Filter Preset dialog box, enter a name and a 
personalized description for the preset that will remind you of your custom settings. 

5. After you have saved a customized filter preset, select Add and load it the same way you 
would load a default preset.

6. To remove a customized filter preset, select Add to open the Load Video Filter Preset 
dialog box. Select the filter preset you want to remove and click Delete Preset. 

NOTE:  You cannot delete the default system presets. 

3.3.1.5 Audio Filter Tab

The Audio Filter tab lets you add audio filters to your source file to help improve the audio 
quality of your target files. These filters can be previewed in this tab and are applied to the 
source audio before any target audio filters are processed.
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1. Click Advanced from the Source dialog box. When you will see the advanced controls, 
select the Audio Filter tab to add a variety of filters.

2. Click Add to add one or more audio filters to your source. A brief description of each 
filter is listed in the Description box when the filter is highlighted. You can browse the 
different filter categories on the left and choose filters from the right. Holding down SHIFT 
or CTRL and selecting the desired filters lets you add multiple filters to the Filter list. 
Remember that you can add filters to both sources and targets, so you should only add a 
filter at the source to improve it, for example, a low pass filter to remove a whine or hiss. 

3. Once you have added a filter, you can select the filter in the list to view and adjust its 
properties. 

4. Selected filters are applied from the list top-down, so the top-most filter in the list is 
applied first, and the bottom-most filter in the list is applied last.

5. To adjust the order of the filters in the list, select the filter in the list then click Up or Down 
to move it up or down in the list.

Previewing Audio Filters

You can compare and preview the effect of audio filters by selecting Play Original followed by 
Play Result.

Use the Position scrubber bar to select the area of the file you want to preview. Use the 
Duration drop-down menu to select the length of the preview from 2 to 15 seconds.
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Audio Filters

The following audio filters are included:

 Channel Mixer. Use this filter to interchange and map audio channels.

 DVD to PC Converter. Adjusts volume and dynamic range of DVD audio for PC playback.

 Dynamic Range Compressor. Audio Dynamic Range Compression Filter. Use this filter for 
compressing the dynamic range of audio.

 Fade In/Out. The Audio Fade In/Out filter is used to add a fade in and/or fade out to the 
audio. Use this filter in conjunction with the Video Fade In/Out filter for an audio/video/fade 
in/out. 

 Lowpass. The Lowpass filter removes high-frequency signals, such as electrical noise and 
hiss, from the audio. 

 Normalize. The Normalize filter raises the audio to maximize volume without clipping. This 
is a dual-pass filter and will increase your source file’s overall conversion time. This filter is 
useful when performing a batch conversion or stitching various sources together so all the 
sources are at the same level.

 Normalize-TU 1770. This ITU 1770 Audio Normalization Filter provides very good 
performance compared to other peak sample meters so it has generally more accuracy 
then these meters that perform a similar function as the ITU 1170 Filter. It has also been 
determined that the ITU 1770 algorithm was more effective in determining appropriate 
levels for non-speech-based material, such as music and soundtrack material then other 
peak sample filters.

 Parametric 5.1 to Stereo Converter. This filter is used instead of the built-in converter, if 
access to the conversion parameters is needed.

 Track Offset. Adjusts the time offset between audio and video tracks.

 Volume. Lets you adjust the overall volume of the audio. 

Saving Custom Audio Filter Presets

A custom preset saves the customized settings of the selected filter. Saving a custom preset 
is useful if you plan on reapplying the same filter settings in the future. Custom presets are 
stored with the default presets and can be categorized into folders and subfolders.

1. Select the filter you would like modify from the Filter list.

2. Modify the filter’s properties according to your specifications. 

3. Click Save Preset. The Save Audio Filter Preset dialog box will appear. 
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4. At the bottom of the dialog box, enter the name of the preset and a personalized 
description that will remind you about your custom settings. 

5. After you have saved a customized filter preset, click Add and load it the same way you 
would load a default preset.

6. To remove a customized filter preset, click Add to open the Load Audio Filter Preset 
dialog box. Then select the filter preset you want to remove and click Delete Preset. You 
cannot delete the default system presets. 
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3.3.2 Using the Target Tab
The Target tab lets you assign a “target” format for your source file to be converted to. You 
can assign multiple targets to a single source file that lets you create different formats of the 
same source file in one process.

3.3.2.1 Modifying the Target List

The Target List displays all of the target files you are planning to transcode. Use the buttons 
and options on the left to modify the list.

 Add. Click Add to add target formats to the list. 

 Remove. Click Remove to remove the currently selected target format(s) from the list. You 
can also delete them using the delete key.

 Remove All. Click Remove All to remove all the targets from the list.

 Save Profile. Click Save Profile to save all target outputs in the target list, their customized 
settings, and their associated filter settings. A profile will typically be used to save a 
complex task that includes multiple targets and filters. The profile can then easily be re-
applied to different sources.

 Advanced. Click Advanced to open the Advanced dialog box. This window will appear on 
top of the main ProMedia Carbon window. Double-clicking an item in the Source List also 
opens the Advanced window. To close the Advanced dialog box, click Close.
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3.3.2.2 Assigning Targets

After clicking Add, you will need to assign a target format. 

1. In the Load Target Preset dialog box, select a desired category on the left side.

2. Select (+) next to a category (if needed) to display its sub-categories. The available 
presets for that category are displayed on the right.

3. When you have selected a preset, you will see complete details of the format settings in 
the description pane located in the bottom of the Load Target Preset dialog box.

4. You can use SHIFT+SELECT or CTRL+SELECT to grab multiple presets within a single 
category

5. Click OK to add this preset to your Target window.

3.3.2.3 Preset Target Types

 System. Contains base settings for all the formats ProMedia Carbon produces. These 
settings are a good starting point for creating a custom setting.

 Application Specific. Contains Editing Software, DVD production/ authoring, Hardware, 
and STB profiles.

 Audio. Contains PCM and MP3 settings for audio-only output formats. These settings are 
good for exporting audio for use in other applications and for conforming audio files.

 CD/DVD. Contains DivX, Computer, VCD, DVD and SVCD useful for video on CD and DVD 
media.

 Distribution Formats. Contains ATSC and CableLabs profiles.

 DV. Contains AVI, QuickTime and Raw DV profiles for different DV standards.

 Fast DVD VOB. High speed creation of DVD VOB files for preview purposes.

 H.264. Contains a collection of popular formats based on H.264, including Transport 
Streams. In ProMedia Carbon 3.20, users can override the default VUI color signaling 
(H.264 Encoder Settings – Advanced > Colour Description). Also, a new and 
recommended simpler AQM complexity mode is available that produces better results 
(H.264 Encoder Settings – Advanced > Use Simple Adaptive Quant Strength). Select the 
check box and set the new mode to a recommended value of 50 (a non-zero value in the 
range [1 .. 100]).
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 Handheld. Contains DivX, 3GPP and RealMedia 10 for video files that are compatible with 
handheld devices, such as PDAs and cell phones.

 HD. Contains DivX, MPEG and Windows Media HD settings.

 Image Sequence. Exports a series of still images.

 IPTV Services. H.264-based presets for acTVila.

 Mobile. Collection of presets for 3GPP compliant mobile devices.

 MXF. Contains presets for production formats based on MXF.

 Storage. Contains AVI, DivX, MPEG, or Windows Media targets for use as archival storage 
formats.

 Storyboard. Presets for storyboards, that is, sequences of poster frames (JPEG).

 Video Server. Contains profile categories with broadcast servers from Grass Valley, Leitch 
/ Harris, Omneon and Quantel.

 Web. Contains MPEG, QuickTime, RealMedia, and Windows Media profiles suitable for 
Web delivery.

3.3.2.4 Modifying Target Parameters

The Target Parameters window displays the properties of the currently selected target in the 
target tab. All of the resources necessary for managing and modifying your target parameters 
are available in this window.

The target’s basic parameters appear in the Target Parameters section. You can modify any 
of the parameters that aren’t grayed out. Simply enter values in the fields or use the drop-
down menus to modify the default target parameters.

If you want to save the changes for a custom target, click Save Profile. Saved presets are 
visible in the Custom tab in the Add Target dialog box.

Setup Tab

The Setup tab allows you to modify the parameters for each of the default encoding targets. 
By using the tree-based option list, you can navigate through the available settings. Select a 
parameter in the tree to display its parameters on the right of the screen in the Target 
Parameters section. Properties that have white backgrounds can be modified. Properties that 
have blue backgrounds are disabled for modification in order to maintain the format’s 
particular specifications. 
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A description of the parameter is displayed in the yellow box at the bottom of the screen.

Parameter Definitions Example

Depending on the circumstances of transcode, the parameters settings may not appear in 
certain targets, may be in different locations or may only appear under certain option 
choices. Some parameters settings may be disabled when using some target presets.

Destination

Base Name. Sets the name of the file excluding the extension. A few special substitution 
strings can be used in the Base Name and ProMedia Carbon will replace them with the values 
during its processing. Periods are not allowed in the base name.

 %s is replaced by the name of the source file (without extension) unless the Stitch function 
is used, in which case %s will be replaced by {Stitched Sources}.

 %n is replaced by the file-splitting segment number of the output file. If file-splitting is 
disabled, %n will be 0. 

 %% is replaced by a percent-sign (%).

 Path. Sets the output location for the target file(s). Select Continue (...) to set the output 
folder.

 File Name. Displays the output file name or an example, if one of the substitution strings is 
used.
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Target file splitting

Choose Splitting Method. Selects the automatic file-splitting method. Automatic file-splitting 
can divide output files into separate files for easier archiving or transport. File-splitting is not 
related to multiplexing. File-splitting cannot be used with multi-pass encoding. Not all formats 
support file splitting or all options available for file splitting.

Interval Time for Splitting (Minutes). Sets the time interval to split output files at (in minutes). 
For example, if the interval time is set to 10 minutes, a 35-minute source will be split into 4 
output files.

Select Source Segment. If Use Source Segment is selected, the Target only encodes a 
segment, specified by start and duration, from the source. This is designed for example for 
producing trailers.

Start Time [Seconds]. Specifies how many seconds in the Source Stream the Target shall 
discard before starting encoding.

Duration [Seconds]. Specifies how many seconds the Target shall encode from the Source 
stream.

Max. File Size for Splitting (MB). Sets the size to split output files at in megabytes. For 
example, if the max file size is set to 650 MB and the total output size is 1.5 GB, there will be 
3 output files.

Quality/Size. Select Continue Splitting. Do not automatically split output files. 

Split using Time Interval. Starts a new output file when the current output’s video length 
reaches the specified maximum time. 

Split using max. Size. Starts a new output file when the current output’s file size reaches the 
specified maximum size.

(...) to bring up the Quality/Size Configuration dialog box. The Quality/Size Configuration 
dialog box displays the media requirements for your conversion parameters and can set the 
bit rate to an appropriate value-based on the number of media you want to output.

For example, if your target media is a single CD-R (650MB) and your current setting will 
output 800 MB, the Number of media will be 2. You can then adjust the Quality slider until 
the Number of media reads 1. Alternatively, you can enable the Fill Media if possible option, 
then set the number of media to 1. ProMedia Carbon will automatically calculate an 
appropriate bit rate to fit within the media requirements, if possible.

This option is only available under the following circumstances:

 The target supports a user-specified bit rate for encoding 

 Split using max. Size is enabled 

 There is only a single source or the Stitch function is enabled. 

Video Basic

 Use Video. Choose how ProMedia Carbon will output video for the target.

 Use Always. A video track is always output. If the source has no video, a black video 
track is generated. 

 Use if Exist. If the source has video, that video will be output. If the source has no 
video, no video track is generated. 

 Don’t Use. A video track is not generated, even if the source contains video.

 Video Encoder. Select the video encoder (codec) to be used.

 Width. Sets the horizontal size of the video in pixels.

 Height. Sets the vertical size of the video in pixels.
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 Video Bitrate (kpbs). Displays the video data rate in kilobits per second for this Target.

 Frame rate. Specifies the frame rate of video. An image becomes smooth, although many 
bit rates are needed, if a high value is specified.

 Interlacing. Determines how video frames are stored in the stream. If the Interlacing mode 
is set improperly, the video may not play back smoothly.

 Non-interlaced (progressive) mode stores frames instead of fields.

 Lower/Bottom Field First mode stores frames instead of fields.

 Upper/Top Field First mode stores frames as separate fields, with the upper field 
first.

 Aspect Ratio. Specifies the width-to-height ratio of the video frame and its pixels in the file.

 Video Encoder Option. Displays the setting dialog of a video codec.

Video Advanced

 Color Format. Specifies the color format to be used.

 Use Default Quality. Uses the codec. default quality value.

 Use Default Keyframe Interval. Uses the default keyframe interval.

Audio Basic

 Use Audio. Selects whether the target will contain an audio track.

 Use Always. The target will always contain an audio track, even if the source does not 
contain audio. 

 Use if Exist. The target will contain an audio track if the source contains audio. If the 
source does not contain audio, the target will not have an audio track. 

 Don’t Use. The target will not have an audio track, even if the source contains audio. 

 Audio Encoder Type. Specifies DirectShow or Audio Compression Manager (ACM).

 Format. Specifies the frequency and sample size of PCM (non-compressed audio).

Multiplexer

 A/V interleaving period. Specifies the period of each audio/video chunk. The AVI 
multiplexer interleaves audio chunk with video chunk into one AVI program stream.

 Index Format. Determines whether the output file will be compatible or incompatible (AVI 
2.0) index format.

 Compatible format is for both Video for Windows and DirectShow applications.

 Non-compatible (AVI 2.0 only) format is compatible with DirectShow applications 
only.

3.3.3 Presets and Profiles
ProMedia Carbon includes over a hundred presets to simplify choosing transcoding settings 
for your job. There will be times, however, where you will be making changes to the supplied 
presets for a particular requirement. If you need to reapply the same settings in the future, 
you can save your own preset. ProMedia Carbon also includes the concept of a profile. Unlike 
a preset, a profile can include multiple target outputs. For example, you could save a profile 
called “Web Outputs” that creates five separate output files in different web formats. This 
profile could then be applied to any source file(s) in the future.
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 A preset saves the settings for a single codec or filter. Use it to reapply a particular set of 
parameters for future projects. As an example, you could have a preset called “Windows 
Media for Streaming” that saves the Windows Media parameters used for streaming output 
at your company. The Apply Preset and Save Preset buttons are available in the Advanced 
section for a particular codec or filter. 

 A profile saves the settings for all the targets and filters in a particular project. For example, 
you could save a profile called “Web Outputs” that creates 5 separate output files in 
different web formats. This profile could include the “Windows Media for Streaming” preset 
described above. The Save Profile button is on the main target tab.

NOTE:  A preset will not include the target file name and target folder. This is on purpose: a target preset 
is considered a group of encoding parameters, not file system locations. A profile will save the target file 
name and target folder.

3.3.4 Background Transcoding
In addition to its normal conversion processes, ProMedia Carbon also provides job queuing 
capabilities. Instead of waiting for the ProMedia Carbon application to finish a conversion, you 
can queue jobs to a background transcoding process that takes over and performs 
conversion of queued jobs, much like a print spooler handles printing jobs. In this manner, the 
ProMedia Carbon application serves as a job set-up tool and you can queue multiple jobs 
with different priorities and continue working with ProMedia Carbon.

The background transcoding process that is installed with Carbon is called ‘Nexus’ and is 
installed as a Windows operating system service. The various job queues that Nexus 
manages can be viewed by the management application called Carbon Admin. Carbon 
Admin is available whenever any version of ProMedia Carbon 3.x is installed (ProMedia 
Carbon or Carbon Server). Using Carbon Admin, you can see all jobs that have been queued 
for background transcoding when using ProMedia Carbon, as well as jobs that have been 
created by Watch Folders. Please see 4.1 Using the Carbon Admin Interface on page 71 for 
more information.

3.3.4.1 Queuing a Job

You have two ways to render a job: click Convert, and you’ll encode the files serially with 
ProMedia Carbon’s main interface. You can also click Queue to encode the files, which opens 
the job queuing window.

To queue a job, set up the conversion in the ProMedia Carbon application as you normally 
would, but instead of selecting the Convert tab and starting conversion, select Queue below 
the Convert tab.
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1. In the Job Name field, enter a name for the job. The name will be displayed when the job 
is viewed in one of the job queues. If logging of jobs is enabled the name will also appear 
in the log.

2. Enter a description of the job in the Job Description field. The description will be 
displayed when the job is viewed in one of the job queues. If logging is enabled the 
description will also appear in the log.

3. Choose a Job Priority from the drop-down box. The higher the job priority is, the sooner 
the Queue Manager will start the job. Higher-priority jobs are started before lower-priority 
jobs. The highest priority is 9, which means the job will be started as soon as any 
currently jobs are complete, unless there are more priority 9 jobs already waiting.

4. On a multicore system, click the One Job for Each Target check box in the middle of the 
window. This enables ProMedia Carbon to more efficiently assign processor cores to the 
encoding job. 

5. Virtual Source Name: Read-only parameter.

6. From the Target File Name drop-down menu, select the appropriate action to take if an 
output file already exists:

 Rename if exists. Rename the output file if a file of the same name already exists.

 Overwrite if exists. Overwrite the output file if a file of the same name already exists.

7. Select the Execution Machine, either Local or WFS.

8. If your version of ProMedia Carbon is part of a rendering farm, click the Render in 
Network Grid check box to send the files to the rendering farm.

9. Enter the WFS Controller IP Address.

10. Enter the WFS Controller Port.

11. If your network contains a Carbon Server machine in the same TCP/IP subnet as the 
machine ProMedia Carbon is operating on, you may queue this job to this farm for 
remote execution. You can then continue working on your local machine, for example, 
configuring your next job.

12. Click Queue to add the job to the queue. This sends the encoding jobs to the encoding 
engine.

13. Go to Options > Transcoding Settings to open the Transcoding Settings dialog box.

14. To watch your progress, open the Carbon Administrator application, the other program 
installed when you set up ProMedia Carbon.
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3.3.5 Application Options

3.3.5.1 Transcoding Settings

The Transcoding Settings window allows you to set target folders to save encoded files and 
specify processing options for the application. Setting these parameters is useful if you are 
going to be dealing with many source files from a single or similar sources. 

The Transcoding Settings window contains the following tabs:

 Processing Options

 Conversion Options

 Default Target Folder

 Capture Options

 Carbon Farm Options

3.3.5.2 Processing Options Tab

The Processing Options tab controls both Frame Rate Conversion, Scaling, and Letterboxing 
preferences.

Frame Rate Conversion

If your source and your target have different frame rates, there are many different ways to 
convert the source frame rate to the target frame rate. 
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 Always Pick Nearest Frame. This option creates a target frame by picking the nearest 
temporal frame from the source stream. This preserves full spatial source image quality. 
However, depending on the ratio between the source and target frame rates, movement in 
the video may appear jerky.

 Always Interpolate. This option creates a target frame interpolating between the two 
nearest temporal source frames. This guarantees smooth movement. However, since every 
target frame is an interpolation between source frame, the spatial quality is degraded and 
“ghost” images may appear.

 Automatic Selection. When the source or target frame rate is below approximately 23 fps, 
ProMedia Carbon will pick the nearest frame instead of interpolating in order to avoid 
ghosting. If ProMedia Carbon needs to interpolate frames for doing frame rate conversions, 
ghost images might appear. Use the Automatic selection option to avoid ghosting. If 
ghosting still occurs, then use the Always pick nearest frame option.

 Enable Source Playback Speed Adjustment. ProMedia Carbon normally does not alter 
the playback rate of sources in order to preserve the source’s original speed and visual 
intent. In other words, objects always move at the same speed through video regardless of 
the target frame rate and a 10-second source always converts to a 10-second target.

However, in some circumstances, it is advantageous to slightly alter the source playback 
rate by a very small amount in order to aid conversion. For example, a 29.97fps source can 
be sped up to 30fps playback for conversion to a 15 fps output, removing the possibility of 
interpolation artifacts and making the conversion faster.

It is also standard that 24fps film transfers to PAL DVD-Video are not put through frame 
rate conversions. Instead, the 24fps film content is encoded and authored as if it was 25fps 
content, resulting in a 4% speed-up. This eliminates any interpolation or pulldown but 
makes PAL DVDs of film transfers slightly shorter in length.

Check this box to allow ProMedia Carbon to alter the playback speed of sources up to the 
percentage in the Max. Adjustment (%) box.

Chapter Points

Chapter points are metadata information that can be embedded in the source or output file. 
These chapter points are generally used to allow jumping to different sections within a video.

 Set Chapter Point at Source Stitch Points. This option can be used when stitching 
together multiple files into single output file. Chapter points will be set at each joining point. 
An example use of this would be merging the multiple chapters of a movie into a single 
output file.

Time Code

This is used to represent the temporal location of a particular frame of video. The time code 
may be embedded in the source video or it may be imputed from the video itself. Time code 
may be discontinuous in a particular piece of video.

 Use NTSC Drop Frame Time Code. In the NTSC video world, time code can be 
represented in two modes, drop frame and non-drop frame. Drop frame time code 
compensates for the difference between wall clock time and the time code generated by 
the 29.97 frame rate of NTSC video. Choose this option to make all time code display in 
drop frame mode.
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Scaling and Letterboxing

If your source and your target have different frame sizes, there are two different ways to 
handle this scenario. For example, you may have a 16:9 source file that needs to be encoded 
to a target file with a 4:3 aspect ratio frame size. Because of the different frame sizes, you 
either have to scale and crop your Source file, or add black bars to the video to compensate 
for the difference.

 Add Letterbox/Scale & Crop Slider. Use the slider to adjust the desired percentages or 
cropping. Select 100% letterbox, by sliding the adjustment bar to all the way to the left will 
leave the source frame completely visible, with letterbox bars added if necessary. If the 
slider is at 0% letterbox (100% Scale and Crop), the image will fill the entire space without 
letterboxing, but the sides will be chopped off. Leaving the letterbox slider in the middle 
(50%) is a mixture of adding letterbox bars and scaling the file to fit the space. If you know 
you can afford to cut off a little of the video, then you should have the bar more toward the 
middle. Experiment with these settings to determine the correct settings for your source 
files.

 Allow anamorphic scaling. This setting allows scaling the pixel aspect ratio non-
proportionally (horizontal and vertical scaling are different). Next to this check box is a field 
called Max. Aspect Ratio Distortion (%) for entering the maximum aspect ratio distortion 
percentage allowed during the anamorphic scaling process.

 Crop/Adjust when converting between VBI containing formats (480/512, 576/608 
Lines). This option can be used for certain transcodes between broadcast formats where 
either the source or target contain Vertical Blanking Interval (VBI) information and the other 
format does not. With this option checked, ProMedia Carbon will either strip out the extra 
32 lines of VBI data when going from a VBI source to a non-VBI target or add 32 lines of 
blank VBI data when going from a non-VBI source to a VBI target.

 Crop when scaling D1 to DV (NTSC). Enable this option when converting a NTSC D1 
(720x486) source to NTSC DV (720x480). ProMedia Carbon will crop 4 lines from the top 
and 2 lines from the bottom of the source frame during conversion. This results in faster 
processing and higher quality since scaling is not performed.

 Enable MPEG-1compliant scaling. ProMedia Carbon normally converts full-D1 sources to 
MPEG-1 SIF using the Scaling and Letterboxing slider setting. However, the MPEG 
specification states that to convert a full-D1 (720x480) source to MPEG-1 SIF (352x240), 
crop 8 pixels from the left and right sides of the source to create a 704x480 frame then 
scale it to 50% for a 352x240 frame. Checking this box forces ProMedia Carbon to use the 
MPEG-1 specification method.

 Discard field when scaling height by ½. When using full-size interlaced source files, this 
option discards one of the fields if you are scaling the file to half-size. In some cases, this 
eliminates the need for applying deinterlacing filters to your source file since discarding a 
field effectively deinterlaces the video.

 Use NTSC safe colors for letterboxes. Safe colors refer to those that are inside the safe 
region for NTSC television video. Title colors that are outside of this range can display badly 
and “bleed” on NTSC televisions.

 Active line length 704 pixels. Select this option to avoid having black bars down each 
side when equating to the full 4x3 or 16x9 picture.

 Picture Scale Method. Different methods can be available for scaling video up and down. 
There is a trade off between processing speed and video quality, and in general the slower 
the processing the better the quality. The “Best Quality” setting produces the best quality 
but is generally not the fastest. The “Legacy” and “Linear Interpolation” settings are typically 
the fastest and the produced quality can be considered good. The “Legacy” setting uses 
the Harmonic proprietary scaling algorithm of ProMedia Carbon versions 3.16 and earlier.
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3.3.5.3 Conversion Options Tab

The Conversion Options tab controls various preview, loading and system preferences.

Preview Options

 Always Scale/Shrink To Aspect Ratio Correct Full Screen Display. Enable this option to 
have ProMedia Carbon always compensate for pixel aspect ratio differences and provide 
an accurate on-screen display. It is recommended to keep this option enabled.

Preview Devices

 Use Overlay on Desktop. Enable this option to use video overlay for preview. Video 
overlay is faster than standard video and therefore uses less system resources. You should 
disable this option for remote desktop or if your preview stays blank.

Source Loading Options

 Apply modified Source options to similar Sources. Enable this option to use modified 
source options on subsequent source files. With this option enabled, subsequent sources 
of similar types will be loaded with the same source parameters as the previous source of 
the same file type. This is useful for Watch folders because it allows source files to be 
adjusted automatically without the need for the user to interact with the software. For 
example, let’s say you have an AVI file that does not have square pixels and you set it so 
the pixel aspect ratio isn’t square (that is, DV NTSC). If Apply modified Source options to 
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similar Sources is enabled, the next AVI source file you load will retain the same settings 
used before, and will load the file with the pixel aspect ratio set to DV NTSC, instead of the 
default setting.

 Force Internal DirectShow MPEG Decoder. This forces ProMedia Carbon to use the built-
in decoder, even when using DirectShow graphs. 

 MPEG Timestamp Mode. Sets the default timing mode for MPEG Transport Streams, 
where the timing mode defines how in and out points and audio / video synchronization 
are handled. 

 Default Subtitle Language. Select what subtitle language should be pre-selected when 
loading a VOB. 

System

 Temp. Dir. Some conversions need to save temporary files. Select Browse to choose a 
location for your temporary directory.

 Cache Dir. ProMedia Carbon retains some information in order to speed certain types of 
conversions. Select Browse to select the location to use for ProMedia Carbon’s cache files.

3.3.5.4 Default Target Folder Tab

The Default Target Folder tab allows you to specify where you transcoded files should be 
stored. 
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Global Default Target Folder

 Global Default Target Folder. This option sets the output location for all formats and 
targets. Select Browse to select the folder you want to use.

 If you want the global settings to apply to all target folders, select Always use the Global 
Default Folder for all Targets. Checking this option disables and overrides any local 
settings you may specify in the next section.

Local Default Target Folder

 Local Default Target Folder. Sets the output location for specific target presets. The local 
defaults override the global defaults. This is helpful for separating files that go to different 
projects or can be used to separate different target formats from each other.

To set the Local Default Target folder:

1. Uncheck Always use the Global Default Folder for all Targets.

2. Select the desired target from the list by selecting it.

3. Select Use Local Default Folder for the selected target option.

4. Select Browse to choose the folder to use.

5. Select Apply or OK.

3.3.5.5 Capture Options Tab

The Capture Options tab allows you to specify video and audio capture settings. A 
DirectShow compliant hardware capture device must be installed in your computer.
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Capture Settings

 System. While capturing video, ProMedia Carbon attempts to transcode directly from the 
input video into the target formats. If the performance of the system is not fast enough to 
enable immediate encoding, ProMedia Carbon will generate an intermediate file on disk 
and then transcode asynchronously from this temporary file into the target formats. If your 
encode stops during capture or has dropped frames, select a lower system speed. This will 
force ProMedia Carbon to generate the temporary file.

 TC Offset. Time Code offset is used when there is a difference between the time code 
displayed by the tape deck and the display in ProMedia Carbon.

 Reduce preview refresh. Previewing video during capture uses CPU cycles that could be 
used for transcoding. Selecting this option will reduce the rate of frames displayed and will 
increase the processing power available for encoding. On faster machines this option is not 
necessary. 

 Stop Capturing on Frame Drop. If your machine is not fast enough to perform encoding 
during the capture, it may drop some video frames. Select this option to stop the capture 
process if there is a frame dropped.

 Use Source HD Buffer. Some encoding functions, such as frame rate conversions, are 
computationally intensive. ProMedia Carbon has the ability to perform partial transcodes 
and then write temporary data to the hard drive to ensure that there are no dropped frames 
during the transcode. Writing this temporary data will slow down the encoding process, but 
guarantees successful capture. You may select from one of three options: Never, 
Automatic, and Always. The Never option will never write intermediate data to the hard 
drive, the Always options always will, and the Automatic will write data depending on the 
target parameters. You can tune the settings depending on your system performance.

3.3.5.6 Carbon Farm Options Tab

The Carbon Farm Options tab allows you to specify and set up the Carbon Farm settings. 
ProMedia Carbon can be used as a front-end to a “farm” of transcoders under the control of 
Carbon Server. If you do not have a Carbon Server system, then these settings are not used. 
If you are using a Carbon Server system, you can set up transcoding jobs and then queue 
them up for processing on the farm. These settings allow you to control interactions with the 
farm.
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Carbon Farm Options

 Use Local Presets. If you would like to use presets that have been developed on the local 
machine, choose this option. 

 Use hosted Presets. If you would like to use presets that are on the Carbon Server 
machine (or some other machine in your network), choose this option. After choosing this 
option, you can browse to select the machine and file location for the presets that you 
would like to have available. By hosting presets on a central machine, all of the users in 
your environment can share the same presets. 

 Connect to Carbon Server. Choose this option to initiate connection to a Carbon Server 
machine. After choosing this option, you will select from the available Carbon Servers in 
the drop-down selection box. The Status window to the right of the selection box shows the 
status of the selected Carbon Server. 
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3.3.6 Application Settings
The Application Settings window lets you enable or disable application-specific behaviors. To 
open the Application Settings, choose Options > Application Settings.

3.3.6.1 Settings

 Window Animation. This toggles whether or not the windows slide into place when they 
open or close.

 Show “Save Project” Dialog on exit. This toggles whether or not ProMedia Carbon 
prompts you to save your projects when you exit the application.

 Disable Sound on “Conversion finished”. This option disables the exuberant “Done” 
sound that plays when ProMedia Carbon finishes a foreground conversion.

 Show Advanced options in basic view. This option includes all advanced options within 
the basic view. When the advanced options are included in the basic view, the advanced 
view is only necessary for source trimming and adding filters to sources and targets.

 Show “Custom Folder Browse Dialog” for Target Path. Enabling this will make Carbon 
use the standard Windows Explorer type browse window for selecting the target path 
rather than the default, less elaborate browse window.

3.3.6.2 Confirmation

 Disable confirmation when removing Filter. This option disables the prompt that appears 
when you remove a filter(s) from targets or sources.

 Disable confirmation when removing Source. This option disables the prompt that 
appears when you remove a source file(s) from the Source List.

 Disable confirmation when removing Target. This option disables the prompt that 
appears when you remove a target(s) from the Target List.
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3.3.6.3 Changing the Default MPEG Export File Extension

You can change the export extension on any MPEG file through the MPEG Exporter.  This can 
be changed to meet extension requirements of specialized systems.  To change the 
extensions, add the MPEG exporter as a Target.  Depending on the Stream Type, you can 
choose the extension of the Elementary, Program, or Transport streams.

The following instructions explain how to change the default output file extension for MPEG 
files. For example, by default ProMedia Carbon uses the file extension .m2t for all MPEG-2 
transport streams. If your situation calls for an MPEG-2 transport stream with the file 
extension of .mpg, you can use the following instructions so that all MPEG-2 transport 
streams created by ProMedia Carbon will use the .mpg extension.

1. Run regedit.

2. Browse to HKEY_LOCAL_MACHINE\Software\Rhozet\Carbon Coder\{A7264AEF-FF57-
42E0-BBAD-CCF546CD515F}.

3. Make a new subkey in this folder and name it file_ext.

4. Right-click the new key and select New > String Value.

5. Rename the new string to one of the following formats. You can add an individual key for 
each of the format types listed, but we recommend changing only those that you have to. 

6. Change the value of the new string to the file extension you would like the stream type to 
have (for example, mpg).

Table 3–1: String Value Formats

String Name File Type Changed

MPEG1_MUX Mpeg-1 System Stream

MPEG1_ELM_VIDEO Mpeg-1 Elementary Stream—Video Portion

MPEG1_ELM_AUDIO Mpeg-1 Elementary Stream—Audio Portion

MPEG2_MUX Mpeg-2 Program Stream

MPEG2_ELM_VIDEO Mpeg-2 Elementary Stream—Video Portion

MPEG2_ELM_AUDIO Mpeg-2 Elementary Stream—Mpeg-2 Audio

WAVE Mpeg-2 Elementary Stream—PCM Audio

MPEG2_TS Mpeg-2 Transport Stream
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7. Close regedit.

8. Restart ProMedia Carbon. 
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Chapter 4
Using Carbon Admin 

This chapter’s first section provides an overview of Carbon Admin and describes using 
Carbon Admin to set up Watch Folders, view jobs’ status, create presets, and configure 
transcoding parameters of local and remote systems. The second section, 4.2 Carbon Admin 
Interface Options and Details on page 79, provides a detailed description of Carbon Admin’s 
many menu options to customize and manage conversion settings. 

NOTE:  Use Carbon Admin to automate multiple file conversions through Watch Folders. 

4.1 Using the Carbon Admin Interface 
Carbon Admin does not work by itself, but is used to configure and control other Carbon 
products: ProMedia Carbon, Carbon Server, and Carbon Agent (a farm of transcoders). 
Carbon Admin includes all the features (and more) of the Carbon Server web-based user 
interface, which is still available. You can access Carbon Admin from the desktop or from the 
web-based user interface. 

Carbon Admin can be used to: 

 Set up Watch Folders, automated processes that transcode any source file dropped or 
copied into the folder. 

 View transcoding jobs and their status. This includes jobs that are currently running, jobs 
that have been previously run and are now finished, and jobs that are waiting (queued-up) 
to be run. 

 Create new presets and manage existing ones. Presets describe the kinds of output files 
you need to create, and are a convenient way to recreate the same kinds of files over and 
over, instead of having to enter the parameters again. For example, such as codec (Flash, 
H.264, etc.), file type (FLV, MP4), frame size (320x240 pixels), bit rate (300 Kbits/second), 
and frame rate (25 frames/second) every time you want to create a new output file. 

 Configure Carbon Server transcoding parameters.

 When applicable, view transcoding jobs and configure transcoding parameters of remote 
systems. 

The following sections describe how to use Carbon Admin’s basic features to create Watch 
Folders, and how to customize presets to match your specific requirements. For a detailed 
description of Carbon Admin’s menu options, see 4.2 Carbon Admin Interface Options and 
Details on page 79.
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4.1.1 Setting Up a Watch Folder
1. Double-click the Carbon Admin application short cut on the desktop. The opening 

screen appears, showing the Active Jobs, Queued Jobs, Completed Jobs, Failed Jobs, 
and Watch Folders tabs.

2. Select the Watch Folders tab.

3. On the Watch Folders tab, select Add Watch to define a new Watch Folder on the Watch 
Folder Setup dialog.
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4. On the Watch Folder Setup dialog, type a Watch Folder name and select Browse to, 
specify where to save the Watch Folder, then click OK. 
Alternatively, click Browse (directly to the right of the Watch Folder field) to select an 
existing Watch Folder to drag (or copy) source files to, then click OK. 

5. To add presets, on the left side of the screen, under Target Files, select Add. This 
changes the selections on the right side of the screen. 

6. To add a preset, find the Preset field, then select Browse below and to the right of the 
Preset field. This opens the Select Preset dialog. 



Chapter 4 Using Carbon Admin Using the Carbon Admin Interface

 © 2012 Harmonic Inc. 74 ProMedia™ Carbon Installation and User Guide v.3.20

7. For our example, on the left, in the tree-list of preset categories, select Web > MP4 
(H.264) category. This selection displays the MP4 H.264 factory default presets made 
available during installation. 

8. On the right, select MP4 448kbps 320x240 4x3 29.97fps, then select View Preset. 
You can see that the MP4 H.264 preset creates .mp4 target (output) files 320 pixels wide 
by 240 pixels high, with a frame rate of 30 frames per second. The target file is created 
from the source file by transcoding from the source format to the format (codec) specified 
in the preset.

9. Select Cancel, then select Select Preset to add the preset to your Watch Folder.
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10. To select the folder to which the H.264 .mp4 files will be written, on the Carbon Watch 
Folder Setup dialog, to the right of the Target Folder field, select Browse. 

11. When the folder selection dialog box opens, navigate to the target output folder and 
select OK. Once you have selected your output folder, you are now finished with this 
target. 

12. Select Save Watch to add the H.264 target to the Watch Folder. Notice in the Watch 
Folders properties list on the left side of the screen that a new target has been added to 
the Watch Folder. For this example, although we could add more targets to this Watch 
Folder, we will only add the H.264 target. 

13. Now open the input and output folders you specified (in the examples above, the input 
folder where you drop the source files is c:\Temp\WatchSource, and the output folder for 
the H.264 target file is c:\Temp\WatchTarget.).

14. Drop a video file into the Watch Folder (the input folder). Instead of dropping the file itself, 
you can also create a shortcut to the file by right-clicking and dragging the file, then 
releasing the right mouse button when the file is over the Watch Folder. 

15. Select Create Shortcuts Here to create a shortcut to the input file inside the Watch 
Folder.

To see the progress as the source file is transcoded into the target H.264 .mp4 file, go back 
to the Carbon Admin application and select the Active Jobs tab. You should now see a 
display like the following screenshot, in this example 47% of the input file has been 
transcoded.
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After a while, the progress bar will reach 100%, indicating that the job has finished 
transcoding, and you will see the status change to “Completed”. You should now be able to 
find the new file with the .mp4 file extension in the output folder (c:\Temp\WatchTarget in our 
example). 

Feel free to explore a little more on your own and create another few Watch Folders, using 
different presets.

The handling of presets is discussed in detail in the following section, 4.1.2 Creating New 
Presets on page 76; we suggest you review it after you feel comfortable creating Watch 
Folders and transcoding files by yourself.

NOTE:  If you create a Watch Folder that reads source files or writes target files to a network drive, you 
cannot use mapped drives such as M:\NetworkWatchInput, you must use UNC paths such as 
\\SERVERNAME\SharedFolder\NetworkWatchInput. If you do not do this, ProMedia Carbon and Carbon 
Admin will not be able to read the files or write the files, since it does not understand or have access to 
mapped drives, only UNC paths.

4.1.2 Creating New Presets
ProMedia Carbon includes hundreds of presets to simplify choosing settings for your 
transcoding jobs. There will be times; however, where you will be making changes to the 
supplied presets for a particular requirement. If you need to reapply the same settings in the 
future, you can save your own preset that restores all the codec parameters you configured.

A preset saves the settings for a single codec. Use it to reapply a particular set of parameters 
for future projects. As an example, you could have a preset called “QuickTime MP4 with 
H.264 for Streaming” that saves the H.264 and QuickTime parameters used for streaming 
output from your web server. Each time you have a new source file that needs to be 
transcoded for streaming, you can apply this saved preset instead of having to re-enter all of 
the settings again, such as frame size, frame rate, file wrapper (.mp4), and many more.

If you completed the earlier section, 4.1.1 Setting Up a Watch Folder on page 72, you already 
used the “H.264 (.mp4) 320x240 30fps” preset. This preset describes how to create a 
QuickTime file with the .mp4 extension, which contains video information encoded according 
to the H.264 specification. The video created using this preset will be 320 pixels (width) and 
240 pixels (height), with 30 frames of video displayed every second.

We’re going to use that preset to create a new customized preset, one that makes video with 
frames that are 400 by 300 pixels instead of 320x240. We’re only going to change the frame 
size, and no other parameters, but the principle of creating new presets remains the same, no 
matter how few or how many parameters you change.
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1. Make sure that Carbon Admin has been opened and select the Preset Editor option from 
the Tools menu.

2. When the Preset Editor dialog box opens, on the left side you can see the list of preset 
categories. When you save a new preset, you can choose a category to save it under so 
it’s easier to find in the future, and you can group it with other, similar presets. 

When you select a category (in this example the “H.264” top level category and the 
“Web” sub-category), the list of presets stored under that category appears. In this 
example, the two presets that are installed with ProMedia Carbon are displayed. We’re 
going to take one of those presets and modify it to create our own, new customized 
preset.

3. Select the H.264 (.mp4) 320x240 30fps preset and double-click the Preset.

When the preset parameter list appears, all the parameters that can be changed for this 
codec are listed on the left in a tree listing, the description of the parameters and the 
current value for the parameter in this preset is shown on the right.

4. In the tree in the left panel, scroll the list until you see H.264 Encoder Settings-Basic 
category. Select the Profile parameter that appears under this list.

5. In the Destination panel on the right, scroll down to the Width parameter, and change it 
to 400. Change the Height parameter to 300, and select Save As.
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6. When the preset Save As dialog box appears, enter a name for the preset and a custom 
description. The description is a useful place to make note of any specifics about the 
preset, such as the intended use of the output target files.

You can also select the category under which the preset will be saved from the tree on 
the left. It’s a good idea to group new presets together in the category that already has 
similar presets, although you can create new categories and sub-categories if you want.

7. When you’re done with the name and the description, select OK. 

Carbon Admin now validates the parameters in the preset, and adds it to the list of 
existing presets. You might have to wait a while for the preset to be validated. The preset 
editor screen now appears again, and the preset you just created is shown in the 
“H.264\Web” category.

You can now use your new preset when you create a Watch Folder. There are many more 
parameters you can change, and there are many existing presets you can customize, so feel 
free to experiment. The default set of presets that is installed when ProMedia Carbon is 
installed can’t be accidentally deleted using the Carbon Admin user interface, so feel free to 
experiment.
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4.2 Carbon Admin Interface Options and Details
Each time you start Carbon Admin you will begin at the home screen. The home screen 
contains a number of different areas that all display information about the current state of 
Carbon Server. First, there is the menu bar, then a number of areas that supply general 
information about the Carbon Server transcoder, then the Job and Watch Folder tabs, then 
the area that displays Job and Watch Folder lists, then the Job/Watch detail and preview 
areas, and finally the status bar at the bottom.

The version of Carbon Admin installed with Carbon Server (Carbon Server Admin), has one 
additional tab called Carbon Machines (not shown in the illustration). This tab displays all the 
Carbon Agent machines that are known to this Carbon Server machine. 

The rest of this section describes each area in general terms. Where there is more detailed 
information available, sections later on in this document provide it.

4.2.1 Menu Bar
The Carbon Admin menu bar provides the File, View, Tools, and Help options described in the 
following sections.

4.2.1.1 File

The only option in the File menu is Exit, this will end the Carbon Admin program.
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4.2.1.2 View

 Refresh. Re-display the jobs or Watch Folders in the current tab.

 Preview Style. Change whether a preview is shown in the preview window in the bottom 
right of the Carbon Admin ('Single Preview'), or for every currently transcoding job in the 
Active Jobs tab ('Preview in List'), or not at all ('No Preview'). If Single Preview is selected, 
the preview window is only visible when the Active Jobs tab has been selected. If Preview 
in List or No Preview is selected, the preview window disappears from the bottom right of 
the Carbon Admin window. If Preview in List is selected, every active job that is visible in 
the Active Jobs tab will show a small preview of the current output file. 

4.2.1.3 Tools

Preset Settings. Manage existing presets, and create new ones. See 4.1.2 Creating New 
Presets on page 76 for some information to get you familiar with the creation of presets. 

Kernel Settings. Edit less-frequently used configuration parameters for Carbon Server. See 
4.2.13 Kernel Settings Configuration on page 100 for more information. 

4.2.1.4 Help

This section is fairly self-explanatory. The About Carbon Admin option will display the Carbon 
Admin version number and legal and copyright information.

4.2.2 Carbon Server Information Areas
The following sections describe the status area displayed directly under Carbon Admin Menu 
bar.

4.2.2.1 Application Status

Describes the machine for which Carbon Admin is displaying the status. Currently, Carbon 
Admin can only display the status of the local machine (the machine on which it is running), 
but in the future may be able to select and display the status of other machines running 
Carbon Server. 

Connected to. The name of the selected machine (or IP address if the name cannot be 
found). The IP address “127.0.0.1” is reserved for the local machine, that is, the machine that 
Carbon Admin is currently running on.

Version. The version of Carbon Server that is running on the selected machine.

4.2.2.2 Job Status

Lists the total number of jobs in each job category.

 Active. The number of transcoding jobs that are currently in the process of being 
transcoded.

 Queued. The number of transcoding jobs that have been requested to transcode, but that 
are waiting for a transcoding “slot” to free up. A machine running Carbon Server can be 
configured to have a user-specified number of Transcoding Slots, which indicates how 
many transcoding jobs that machine can execute simultaneously. If a machine has three 
transcoding slots and is already executing three transcoding jobs, that machine cannot 
accept any new jobs until one of the three jobs completes or fails. Once that happens, a 
transcoding slot becomes available, and one of the jobs in the Queued status now 
becomes Active.

 Completed. The number of transcoding jobs that have been transcoded successfully.

 Failed. The number of transcoding jobs that have encountered an error somewhere during 
transcoding.
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 Total Jobs. The number of all jobs in the four preceding categories combined.

Watch Status

This area lists the numbers of Watch Folders and their state of activity.

 Total Watches. The total number of Watch Folders that have been configured on this 
machine. 

 Active. The number of Watch Folders that have been marked as Active. When a source file 
is dropped into the input folder of a Watch Folder marked as “Active”, it will be transcoded 
according to the Watch Folder settings.

 Inactive. The number of Watch Folders that have not been marked as “Active”. When a 
source file is dropped into the input folder of a Watch Folder not marked as “Active”, it will 
be ignored, it will not be queued, and no transcoding will take place.

4.2.2.3 Connected Machine Status

This informational area displays the status of Carbon Server systems, and is not displayed for 
ProMedia Carbon or Carbon Agent machines.

 Total Machines. The number of Carbon Agent machines that are under the control of the 
Carbon Server machine.

 Active. The number of machines that are under the control of the Carbon Server machine 
and that have been marked as “Active”. Active machines are configured to accept jobs 
dispatched by the Carbon Server machine.

 Inactive. The number of machines that are under the control of the Carbon Server machine 
and that have not been marked as “Active”. Inactive machines will not accept jobs 
dispatched by the Carbon Server machine.

 Total Slots. The sum of transcoding slots on all active machines. A machine running 
Carbon Server can be configured to have a user-specified number of Transcoding Slots, 
which indicates how many transcoding jobs that machine can execute simultaneously. If a 
machine has three transcoding slots and is already executing three transcoding jobs, that 
machine cannot accept any new jobs until one of the three jobs completes or fails. Once 
that happens, a transcoding slot becomes available, and one of the jobs in the Queued 
status now becomes Active.

 Slots Used. The sum of the number of transcoding jobs that are currently being executed 
simultaneously on all active machines.

4.2.3 Job and Watch Folder Tabs

4.2.3.1 Active Jobs

Selecting this tab will display a list of transcoding jobs that are currently in the process of 
being transcoded. Right-clicking a job in this tab will display the following options: 

 Stop. Terminate transcoding, and move the jobs to the “Failed Jobs” tab. From there it can 
be re-submitted for transcoding at a later time if desired. 

 Remove. Terminate transcoding and remove the transcoding job from this tab. 

 Select All. Selects all jobs and runs the selected option.

4.2.3.2 Queued Jobs

Selecting this tab will display a list of transcoding jobs that have been requested to transcode, 
but that are waiting for a transcoding “slot” to free up. A machine running Carbon Server can 
be configured to have a user-specified number of Transcoding Slots, which indicates how 
many transcoding jobs that machine can execute simultaneously. If a machine has three 
transcoding slots and is already executing three transcoding jobs, that machine cannot 
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accept any new jobs until one of the three jobs completes or fails. When a job is completed or 
fails, a transcoding slot becomes available, and one of the jobs in the Queued status now 
becomes Active and is moved to the Active Jobs tab. Right-clicking a job in this tab will 
display the following options: 

 Remove. Terminate transcoding and remove the transcoding job from this tab. 

 Re-queue. Resubmit this transcoding job and move it to the Queued Jobs tab. 

 Start Now. Immediately moves the job to the Active Jobs tab and starts transcoding it, 
regardless of the number of transcoding jobs already in progress and the maximum 
number of Transcoding Slots configured for this machine. 

 Set Priority. Set a priority for this job, between 1 (lowest) and 10 (highest). The highest 
priority jobs will be transcoded next once a transcoding slot is freed up. Selecting Start 
Now immediately moves the job to the Active Jobs tab and starts transcoding it, regardless 
of the number of transcoding jobs already in progress and the maximum number of 
Transcoding Slots configured for this machine.

 Select All. Selects all jobs and runs the selected option.

4.2.3.3 Completed Jobs

Selecting this tab will display a list of transcoding jobs that have been transcoded successfully. 
Right-clicking a job in this tab will display the following options: 

 Remove. Terminate transcoding and remove the transcoding job from this tab. 

 Re-queue. Resubmit this transcoding job and move it to the Queued Jobs tab. 

 Same Priority. Set a priority for this job, between 1 (lowest) and 10 (highest). The highest 
priority jobs will be transcoded next once a transcoding slot is freed up. Selecting Start 
Now immediately moves the job to the Active Jobs tab and starts transcoding it, regardless 
of the number of transcoding jobs already in progress and the maximum number of 
Transcoding Slots configured for this machine.

 Select All. Selects all jobs and runs the selected option.

4.2.3.4 Failed Jobs 

Selecting this tab will display a list of transcoding jobs that have encountered an error 
somewhere during transcoding. Right-clicking a job in this tab will display the following 
options: 

 Remove. Terminate transcoding and remove the transcoding job from this tab. 

 Re-queue. Resubmit this transcoding job and move it to the Queued Jobs tab. 

 Same Priority. Set a priority for this job, between 1 (lowest) and 10 (highest). The highest 
priority jobs will be transcoded next once a transcoding slot is freed up. Selecting Start 
Now immediately moves the job to the Active Jobs tab and starts transcoding it, regardless 
of the number of transcoding jobs already in progress and the maximum number of 
Transcoding Slots configured for this machine. This does set a priority for the job, but 
doesn't have any effect if the job is in the Failed Jobs tab until and unless the job is re-
queued. 

 Select All. Selects all jobs and runs the selected option.

4.2.3.5 Watch Folders

Selecting this tab will display a list of Watch Folders that have been created on this machine. 
To the left of every Watch Folder is a check box in the 'Active' column. For more information, 
see the ‘Active’ paragraph in section 4.2.4 Job and Watch Folder Lists on page 84 a little later 
on in this manual. 
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Selecting this tab also displays the Delete Watch, Edit Watch, and Add Watch buttons at the 
bottom of the tab. The Delete Watch and Edit Watch options only become enabled when 
you select a Watch Folder from the list, otherwise these two buttons stay greyed-out. 

 Delete Watch. Removes an existing Watch Folder and it’s files. This is not the same as 
making a Watch Folder active or inactive by checking or un-checking the 'Active' check 
box, but rather removes the Watch Folder permanently. If you want the Watch Folder back 
some time in the future, you will have to completely recreate it. Be careful with this option, 
once a Watch Folder is deleted it cannot be undeleted, only recreated. 

 Edit Watch. Change the parameters of an existing Watch Folder. See 4.1.1 Setting Up a 
Watch Folder on page 72 for information to get you familiar with the creation of Watch 
Folders, and see 4.2.6 Watch Folder Management on page 92 for detailed information. 

 Add Watch –Create and configure a new Watch Folder. See 4.1.1 Setting Up a Watch 
Folder on page 72 for information to get you familiar with the creation of Watch Folders, 
and section 4.2.6 Watch Folder Management on page 92 for detailed information.

Right-clicking a Watch Folder in this tab will display the following options:

 Edit. Edit this Watch Folder.

 Delete. Remove this Watch Folder. 

 Clone. Make a copy of this Watch Folder, but give it a different name. 

 Go To Folder. Open the Watch Folder on your desktop.
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4.2.4 Job and Watch Folder Lists
Selecting one of the job or Watch Folder tabs will display a list of jobs or Watch Folders.

4.2.4.1 Job lists

In the Active Jobs, Queued Jobs, Completed Jobs, and Failed Jobs tabs, details about the 
jobs in the various job states are displayed. 

 Name. The name assigned to the job. Jobs created by dropping source files in Watch 
Folders will usually have a name of the form “Job (date time)”. A more custom name can be 
specified when submitting a job using the API. 

 Description. A description of the job. Jobs created by dropping source files in Watch 
Folders will usually have a description of the form “Source path_to_source_file”. A more 
custom description can be specified when submitting a job using the API. 

 Priority. For queued and active jobs, this lists the job priority, from lowest (1) to highest 
(10). A job that has been forced to transcode immediately without needing to be queued 
first (also referred to as “Start Now” or “Render Now”) will be listed with priority 255. 

 Progress. Percentage of completion of the transcoding job. 

 Progress Bar. Percentage of completion of the transcoding job, expressed as a progress 
bar. 

 Status. Active jobs can be Starting, Started, Error, or Completed. If the job fails with the 
Error status, it will be moved to the Failed Jobs tab, so the status may not be visible for 
long. When the job is completed it will be moved to the Completed Jobs tab so the status 
may not be visible for long.

 Check In Time. The time when the Watch Folder queued the job. 

 Machine. For active, completed, or failed jobs, on which machine the job was executed. 

 Warnings. For active or failed jobs, any warnings or errors that were generated during the 
execution of the job. 

4.2.4.2 Watch Folder lists 

 Active. Whether the Watch Folder will act on source files dropped into the input folder. 
When a source file is dropped into the input folder of a Watch Folder marked as “Active”, it 
will be transcoded according to the Watch Folder settings. If this box is unchecked, then 
source files dropped into the input folder this Watch Folder will be ignored, will not be 
queued, and no transcoding will take place. 

 Name. The user-specified name that was give to the Watch Folder when it was created. 

 Folder. The input folder of the Watch Folder. When a source file is dropped into this folder, 
it will be transcoded according to the Watch Folder settings. 

Table 4–1: Job Lists 

Tab Name (Prev) Desc Prior Prog Progress 
Bars Status Check-

in Time Machine Warn

Active Jobs y y y y y y y y y y

Queued 
Jobs

y n y y n n n y n n

Completed 
Jobs

y n y n n n n y y n

Failed Jobs y n y n n n n y y n
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 Priority. Jobs created will by this Watch Folder will have this job priority by default. 

 # of Targets. Number of different output files that will be created for each source file 
dropped into the input folder. 

 # of Retrievals. Number of network shared storage locations or FTP servers this Watch 
Folder scans for source files. 

4.2.4.3 Job and Watch Folder Details

When a job or a Watch Folder is selected in one of the tabs, the details of that job or Watch 
Folder become visible in the Details area.

Job Details 

Selecting a job in one of the job tabs, displays the details pertaining to that job, depending on 
the status of the job (that is, what tab it's listed in). Jobs don't all have the same details to 
display. The table below lists details that apply to jobs in selected tabs.

 Source File. The source file that was dropped into the Watch Folder's input folder. This can 
be the actual source file, or the shortcut to the source file. 

 Target Preset. The preset used to create an output file. This may appear multiple times, 
once for each output file the Watch Folder creates. 

Table 4–2: Job Lists Details

Tab Source 
File

Target 
Preset 

Target 
File

Checked 
In Started Completed Duration Job GUID Touched 

Source

Active Jobs y y y y y y y y y

Queued 
Jobs

y y y y n n (y if jobs 
were re-
queued)

y y n

Completed 
Jobs

y y y y y n (y if jobs 
were re-
queued)

y y y

Failed Jobs y n y y y n Y y n
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 Target File. The folder to which an output file is written. This may appear multiple times, 
once for each output file the Watch Folder creates. 

 Checked In. The time that the transcoding job was queued. 

 Started. The time that the job actually started transcoding. 

 Completed. For completed or re-queued jobs, the time that the job finished transcoding. 

 Duration. The time it took to transcode the job.

 Target 0 File. The output folder, preset name, and filename ('%s' represents the source file 
name) for the first target. 

 Target 1 File. The output folder, preset name, and filename ('%s' represents the source file 
name) for the next target. There may be many more 'Target X File” details, depending on 
how many targets this Watch Folder is configured to create from every source file. 

 Job GUID. The Globally Unique Identifier of the job. This can be used in API jobs to identify 
jobs uniquely for logging, accounting, or performance measurement purposes. 

Watch Details

Selecting a Watch Folder in the Watch Folders tabs displays the details pertaining to that 
Watch Folder. 

 Watched Folder. The input folder for the Watch Folder. Files dropped into this folder are 
automatically transcoded. 

 Watch Status. The current activity of the Watch Folder process. 

 Retrieval 1 Status. This detail is visible when a Remote Retrieval such as a network share 
or FTP is being checked for the arrival of new source files. 

 Target 0 File. The output folder, preset name, and filename ('%s' represents the source file 
name) for the first target. 

 Target 1 File. The output folder, preset name, and filename ('%s' represents the source file 
name) for the next target. There may be many more 'Target X File” details, depending on 
how many targets this Watch Folder is configured to create from every source file. 

4.2.4.4 Carbon Server Machines

Selecting this tab will display a list of Carbon Agent machines that are known to this Carbon 
Server machine. The listed Carbon Agent machines can be selected or de-selected for 
accepting transcoding jobs from this Carbon Server machine by checking or un-checking the 
check boxes in the ‘Active’ column. 

You can also right-click the machine name, and select Edit Node Settings to change settings 
on the individual Carbon Agent machines. 

Server Setting for Node
 Enable. When checked, the selected Carbon Agent is available for this Carbon Server and 

can be sent transcoding jobs. When unchecked, this Carbon Server will not send new jobs 
to the selected Carbon Agent. The Carbon Agent will complete its assigned jobs but new 
jobs will not be sent to it by this Carbon Server, although it may continue receiving new 
jobs from other Carbon Servers if present. 

 Slots. Refers to how many jobs sent by this Carbon Server can be simultaneously executed 
on the selected Carbon Agent. 

 Priority. This Carbon Server will send new jobs to Carbon Agent machines in order of 
decreasing priority levels. The higher the priority, the more likely it is that a new job will be 
sent to a Carbon Agent. If two Carbon Agents have free transcoding slots, and one has 
priority “7” and the other has priority “4”, the Carbon Agent with priority “7” will be sent 
jobs until it has no more free transcoding jobs. Only then will the Carbon Agent with priority 
“4” be sent new jobs by this Carbon Server. If two Carbon Agents have the same priority, 
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jobs will first be sent to the Carbon Agent with the highest number of empty slots. Only 
when the two Carbon Agents have the same number of empty slots will jobs be sent to 
them on a 'Round-Robin' basis. 

Global Node Settings
 Enable. When checked, the Carbon Agent is available for any Carbon Server and may be 

sent transcoding jobs. When unchecked, the selected Carbon Agent will not accept jobs 
from any Carbon Server, such as for situations where the Carbon Agent machine needs 
configuration or maintenance. The Carbon Agent will complete its assigned jobs but it will 
not accept any new jobs. 

 Version. This is the version number of the Carbon Agent software running on the selected 
Carbon Agent machine. 

 Tag. Used to create sets of Carbon Agents with specific attributes (such as hardware 
acceleration) in a farm network. When a Watch Folder is created, you can assign tags to all 
jobs that come from that Watch Folder. Jobs with a tag will only be assigned to Carbon 
Agents whose tags match the tags of the job. Tags supersede priorities, so when a job has 
a tag assigned to it, it will be sent only to those Carbon Agents with the matching tag, even 
if there are higher priority Carbon Agents without the tag. Within the set of Carbon Agents 
with a matching tag, Carbon Server farm manager does consider the priorities. 

 Mandatory Tag. (This is not yet implemented.) A Mandatory Tag indicates that this Carbon 
Agent machine will only accept jobs from Watch Folders configured with this tag, no other 
jobs will be accepted. 

 Total Slots. Sets the total number of jobs that can be executed by the selected Carbon 
Agent, for all Carbon Servers combined.

 Failed Count. ((This is not yet implemented.) This is the number of jobs that have failed on 
this Carbon Agent machine. 

 Kernel Properties. Use this to change the kernel properties of the individual Carbon Agent 
machines. This saves the trouble of using Windows remote desktop to log in to each 
Carbon Agent machine and using Carbon Agent Admin to adjust the settings on the 
machine directly. 

 Reboot Agent. Allows you to send a reboot request to the Carbon Agent machine. The 
machine will reboot immediately and running jobs will be terminated. 

 View Log. (This is not yet implemented.) View the log file of the Carbon Agent machine. 

4.2.4.5 Preview

This window is only visible when the Active Jobs tab has been selected. It can show a 
preview of the output file as it is being transcoded. Note that, whereas the actual effect on the 
transcoding job you are previewing is low (even large and fast previews won’t really slow 
down the actual transcoding job), there is overhead on the Carbon Admin application, and on 
the Carbon Server system when using it. For some extremely large previews, hundreds of 
kilobytes need to be transferred and displayed, so use this feature wisely.

 Preview off. No preview is shown. 

 Thumbnail Preview-slow. A small fixed-size preview is displayed, the preview is updated 
slowly. 

 Thumbnail Preview-fast. A small fixed-size preview is displayed, the preview is updated 
quickly. 

 Full Size Preview-slow. A scalable preview is displayed. It can be scaled by dragging the 
edges of the preview window or dragging the edges or corners of the Carbon Admin 
window itself. The preview updates slowly. 
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 Full Size Preview-fast. A scalable preview is displayed. It can be scaled by dragging the 
edges of the preview window or dragging the edges or corners of the Carbon Admin 
window itself. The preview updates quickly. 

4.2.4.6 Status Bar

The Status Bar area displays when Carbon Admin can communicate properly with the Nexus 
background transcoding service. It needs to be able to perform certain tasks, such as 
manage and create presets. If Carbon Admin is able to connect to Nexus, it will display the 
message “Connected.”

If Carbon Admin cannot connect to Nexus for any reason, it will display the message “Not 
Connected.” When this happens, it is often a problem with the USB key, perhaps it is not 
inserted properly or the temporary/evaluation license has expired. Try removing and 
re-inserting the USB key, and restart the machine to see if that makes the problem go away. If 
not, you may need to contact Support for more help. 

One other thing to watch out for in this context is the behavior when the machine has just 
started, or when Nexus has just been restarted. Every time Nexus starts, it verifies all the 
presets on the machine and builds a list of the ones that have been correctly verified. It takes 
a while for Nexus to do this, so you may see the Building Preset dialog box below while 
Carbon Admin waits for Nexus to finish. This should never take more than 2 or 3 minutes 
unless you have a huge list of custom presets. If this dialog never seems to finish, you may 
have a problem and should restart the machine to see if that fixes the problem. 

4.2.5 Preset Management
Carbon Server includes hundreds of presets to simplify choosing settings for your 
transcoding jobs. There will be times, however, where you will be making changes to the 
supplied presets for a particular requirement. If you need to reapply the same settings, like 
codec parameters and target file handling options, in the future, you can save your own 
preset that restores all the codec parameters you configured. 

A preset saves the settings for a single codec. Use it to reapply a particular set of parameters 
for future projects. As an example, you could have a preset called “QuickTime MP4 with 
H.264 for Streaming” that saves the H.264 and QuickTime parameters used for streaming 
output from your web server. Each time you have a new source file that needs to be 
transcoded for streaming, you can apply this saved preset instead of having to re-enter all the 
setting such as frame size, frame rate, file wrapper (.mp4) and many more. 

The "Quick Start Guide" of this document gives an overview of the preset management 
process to get you familiar with the creation of presets, and is recommended reading if you’re 
not familiar with the concept of presets, or if you haven’t used the ProMedia Carbon User 
Interface or Carbon Admin to create and manage presets before. This section will discuss the 
details of preset creation and management, and present you with all the available options. 

To help explain how presets work in Carbon Server, you need to know about the three 
different types of presets, explained as follows in 4.2.5.1 System Presets.

4.2.5.1 System Presets

System presets are displayed when the System category is selected in the list of categories 
on the left side of the window. System Presets are the basic building blocks of every other 
type of preset. Both the Factory Default Presets and the User Presets are created by taking 
one of the System Presets, modifying it, and saving it under a different name and a different 
category. These presets can never be modified, renamed, or deleted since they are not really 
separate preset files but are built into and are part of Carbon Server. 
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4.2.5.2 Factory Default Presets

These are specializations and customizations of the System Presets, either according to 
industry standards (for example, “CableLabs HD 1080i 18.1 Mbps”) or according to 
Harmonic recommendations (for example, “3GPP2 H.264 320x240 128Kbps 15fps AAC-
LC”). The Factory Default Presets are created by Harmonic and are automatically installed 
when a Carbon Server product is installed. They are installed under many different category 
names. They cannot be deleted or modified by the end user when using the ProMedia 
Carbon User Interface or Carbon Admin. In custom installations where these presets are not 
used for Watch Folders or API jobs, they can be removed from the file system from the folder 
where they are installed by default (usually in the folder named “c:\Program Files\Common 
Files\Rhozet\ProMedia Carbon\System Presets,” this name is slightly confusing in this context 
but is maintained for backwards compatibility with earlier Carbon Server versions). This is best 
done only under controlled circumstances and in consultation with Harmonic Support.

4.2.5.3 User Presets

These are presets created by the end user, either by modifying a System Preset or a Factory 
Default Preset. These can be deleted and renamed at will, and can be stored under any 
category, those created by the end user, in any of the Factory Default Preset categories, or 
even in the System category. It may sometimes be difficult to tell User Presets from System 
Presets and Factory Default Presets, but selecting a User Preset will show the Remove button, 
whereas System Presets and Factory Default Presets can't be removed using Carbon Admin. 
User Presets are usually stored in the “c:\Documents and Settings\All Users\Application 
Data\Rhozet\Carbon Coder\User Presets” folder on Windows XP or Windows Server 2003. 
There is an equivalent folder on Windows Vista, but that name can vary per installation so you 
may need to search for the folder name “User Presets” to see where Vista placed it.

4.2.5.4 Preset Editor Window

When you are in the main Carbon Admin window and you select the Preset Editor option 
from the Tools menu, the Preset Editor dialog box opens. From this window, you can 
manage, create, copy, and delete presets. Do not save User Presets in the System category, 
but instead, create a separate folder.
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Category List

On the left side you can see the list of preset categories. When you save a new preset, you 
can choose a category to save it under, so that it’s easier to find in the future, and you can 
group it with other, similar presets. Categories can be stored in a hierarchy, so you can have a 
top level category called ‘Flash’ and then create two sub-categories under that called ‘Flash 
8—Streaming’ and ‘Flash 8—Download’ that contain presets to create Flash-8 output files 
optimized for streaming and downloading, respectively.

Preset List

When you select a category, the top right shows the list of presets stored under the selected 
category. 

Preset List buttons

The four buttons in the Preset Editor window that pertain to managing individual presets 
provide the following functions: 

 Refresh. Sometimes changes that have been made to presets aren't immediately 
displayed, select this button to refresh the display and display the changes. 

 Copy. Copy the selected preset, naming it “Copy of NAME”. This is very useful when 
creating a lot of presets that differ in only one or two parameters, you can create the first 
preset and then copy it multiple times, modifying the copies quickly for those few 
parameters that are different. 

 Delete. If a User Preset is selected, this button will be enabled and allow you to 
permanently delete the selected preset. If you want the preset back some time in the 
future, you will have to completely recreate it. Be careful with this option, once a preset is 
deleted it cannot be undeleted, only recreated. 

 Edit Preset. Allows the editing of an existing User Preset, or allows you to open a System 
Preset or Factory Default Preset, edit it, and save the result as a new User Preset. If you edit 
a System Preset or a Factory Default Preset, and you change any parameters, then you 
cannot save the preset with the same name as the original, since you cannot change or 
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overwrite System Presets or Factory Default Presets. You can, however, save the modified 
preset under a different name, which will create a new User Preset. See  Editing Individual 
Preset Parameters on page 91 for details on editing presets and changing settings. 

Preset Description

When you select an individual preset you can see the preset details, including the description, 
at the bottom right of the window. If you have selected a User Preset, you can change the 
Name of the preset, the Category under which the preset is saved, and the Description of the 
preset. 

The Globally Unique Identifier (GUID) of the preset is useful when creating API jobs.

Preset Description Buttons

The two buttons in the Preset Editor that pertain to the editing of preset details provide the 
following functions: 

 Save. If you make any changes to the Name, Category, or Description of a preset, select 
Save to accept the changes. Your changes may not always be reflected immediately, you 
may have to select Refresh and wait while Carbon Admin and the Nexus background 
service exchange details about the updated preset. 

 Cancel. Reject the changes you've made in the Name, Category, or Description fields. 

Editing Individual Preset Parameters

When you have selected an individual preset of any type and selected Edit Preset, the Preset 
Setup dialog box will open. 

All the parameters that can be changed for this preset are listed on the left in a hierarchical 
tree listing, and on the right in a list. You can either navigate the tree and select a parameter, 
or you can scroll down the list to find the same parameter, there is no difference between the 
two displays in terms of functionality. 
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The parameters can include codec settings (such as bit rate), file handling settings (such as 
how to name target files), and other settings (such as whether to split a target file into 
segments). 

The current value of the parameter in this preset is shown on the right side of this list. When 
you select an individual parameter, explanatory text for that specific parameter will appear in 
the preset help text area below the list to assist you in choosing an appropriate value for the 
parameter. 

Note that the type and number of parameters you can change depends on the codec, device, 
and file format selected. For example, the preset selected in the H.264 System Preset has 
almost 60 available parameters. There may be many other presets that do not offer the same 
variety and choice of parameters, such as the Factory Default preset in the second image, 
which offers only 18 parameters.

In many cases, the specific codec only supports a few parameters. In the case of presets that 
target specific hardware, such as video playout servers or handheld devices, there may be 
limitations on frame size, bit rate, etc. 

Managing and Backing Up Preset Files

As discussed earlier (4.2.5.3 User Presets on page 89), User Presets are usually stored in the 
c:\Documents and Settings\All Users\Application Data\Rhozet\Carbon Coder\User 
Presets folder on Windows XP or Windows Server 2003. There is an equivalent folder on 
Windows Vista, but that name can vary per installation so you may need to search for the 
folder name “User Presets” to see where Vista placed it. 

Preset files in that folder are XML files, with names like “fdst_H_264 (_mp4) 400x300 
30fps.cpf”. The latter part of the file name will reflect the name you gave to the preset, with 
some characters replaced by underscore characters (for example, “H.264 (.mp4)” becomes 
“H_264 (_mp4)”). 

Preset files can be backed up by copying all files with the “.cpf” file extension to a backup 
folder. 

4.2.6 Watch Folder Management
A Watch Folder is defined as a folder on a Windows system that automatically converts 
source video files that have been dropped into it, to different types of video output files. Any 
video source files written or dropped into this “Input” folder are converted (transcoded) to the 
one or more types of output files. The format of the output files is specified by the end user 
when the Watch Folder is created.

4.2.6.1 How Watch Folders Work 

A Watch Folder consists of three parts: 

  A folder on a Windows system that is designated as the Watch Folder Input Folder when 
the Watch Folder is created. 

  A Windows operating system service installed when Carbon Server is installed (“Nexus”) 
that continually monitors the Watch Folder's Input Folder for new files. 

  The output file formats and other settings and configuration information entered by the 
user when the Watch Folder is created. 

Input folder for Watch Folders

When a Watch Folder is created, one of the things the user must do is designate an Input 
Folder. This is a normal folder on a Windows system, and once the Watch Folder has been 
created and is active, this folder will be monitored for the presence of new files. When a new 
file is created in this folder, the Windows operating system and the component of Carbon 
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Server called the “Nexus” background service will work together to transcode this source file. 
Carbon Server will transcode the source file into the various output file formats also specified 
at the time the Watch Folder is created. 

The Nexus Background Service 

When Carbon Server is installed on a Windows system, a part of Carbon Server called 
“Nexus” is installed as a Windows service. The Nexus background service runs continuously 
and handles API jobs, maintains the various queues of transcoding jobs, and also monitors 
Watch Folders. 

When a file is created inside a Watch Folder's input folder, the Nexus Service is notified by the 
Windows operating system that a new file has been detected. Nexus checks to make sure 
that the format of that source file is supported by Carbon Server, and then creates one or 
more new Windows Processes that handle the actual transcoding of the source file into one 
or more different output files. 

NOTE:  When using the Windows Task Manager application, the Nexus process can be found by looking 
for a process named “PNXSERVR.exe”. The processes that create and transcode are named 
“PNXKERNL.exe.”

Watch Folder configuration

Creating a Watch Folder requires the user to specify which kinds of output files should be 
created once a source file has been found in the input folder. This can include the kinds of file 
formats the output files should have, the compression type or encoder (sometimes known as 
“codec”) to use, how large the frame should be, how many frames per second the output file 
should display, etc. 

There are also many options for where and how to deliver the output files, as well as options 
for what kinds of other actions to take when output files are ready. 

Step-by-step instructions for creating a simple Watch Folder have been given in the Quick 
Start part of this document, in the 4.1.1 Setting Up a Watch Folder on page 72 section. The 
next section, 4.2.7 Watch Folder Setup Properties, will discuss all of the individual settings that 
can be applied to a Watch Folder, and show how to configure complex Watch Folders. 

4.2.7 Watch Folder Setup Properties
When either the Add Watch or Edit Watch button is selected on the Watch Folders tab, the 
Watch Folder Setup dialog box appears. The sections below describe the general parameters 
that can be entered or modified for Watch Folders.

4.2.7.1 Name 

This is the name of the Watch Folder, which helps you manage your Watch Folders. As an 
example, you could use the names of projects or customers as the names of your Watch 
Folders. 

4.2.7.2 Watch Folder 

This is the location of the Watch Folder. You can choose any local or remote folder location. If 
choosing a remote location, make sure that the Nexus process has the required permissions 
to access that remote location. 

4.2.7.3 If Target File Exists 

This allows you to either overwrite an existing file or to rename to a new file name if one 
already exists with your target name. 
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4.2.7.4 Job Priority 

Since you can have many Watch Folders operating at the same time, you can set the priority 
of each. As an example, you may have a news folder that is set to a higher priority than an 
archive task. A priority 8 job will be executed before a priority 3 job if they both arrive at the 
same time. 

4.2.7.5 Leading/Trailing Clips 

If you would like to have a video “stitched” to the beginning or end of each file that is 
transcoded, then you would select that option in video these settings. The leading and trailing 
clips do not have to match the source or target settings—they will be automatically converted 
to the appropriate target format. Leading and trailing clips are often used for automatic 
advertising insertion. 

4.2.7.6 Watch Folder Setup Advanced Settings 

If the Watch Folder contains sub folders, checking this option will look in those sub folders for 
source files and transcode them the same way as source files in the Watch Folder itself. 

Watch Sub Folders

For example, if the Watch Folder “c:\MyWatchInput\” contains a sub folder “\FromEditor2\”, 
then any source files dropped into the “c:\MyWatchInput\FromEditor2\” folder will be 
processed just like source files dropped into the “c:\MyWatchInput\” folder.

If this option is unchecked, then the source files dropped into the 
“c:\MyWatchInput\FromEditor2\” folder will never be processed nor removed, but just remain 
in that folder until manually removed. 

Append Source Sub Folder to Target Path

This option is only meaningful if ‘Watch Sub Folders’ is checked. If this option is checked, and 
the Watch Folder contains sub folders, then target files created from source files dropped into 
a sub folder will be created in an identically-named sub folder inside the target folder. 

For example, if the Watch Folder “c:\MyWatchInput\” contains a sub folder “\FromEditor2\”, 
and the target folder is “c:\MyWatchOutput\”, then any source files dropped into the 
“c:\MyWatchInput\FromEditor2\” folder will be processed and create target files in a new 
folder “c:\MyWatchOutput\FromEditor2\”. If this option is unchecked, and the ‘Watch Sub 
Folders’ option is checked, then the source files dropped into the 
“c:\MyWatchInput\FromEditor2\” folder will be processed and create target files in the 
“c:\MyWatchOutput\” folder. 

If this option is unchecked, then the source files dropped into the 
“c:\MyWatchInput\FromEditor2\” folder will never be processed nor removed, but just remain 
in that folder until manually removed. 

Create One Job for Each Target

If a Watch Folder is configured to create multiple target files from each source file, then 
checking this option will create a separate transcoding job for every target file. 

For example, if a Watch Folder is configured to create an H.264 target and an MXF output, 
then two transcoding jobs will be visible in the Active Jobs tab every time a source file is 
dropped into the Watch Folder. 

If this option is unchecked, then one job will be created, and that one job will create both 
target files. This can be faster because the source file only needs to be transcoded once, but 
the job will take more memory, and may sometimes exceed the memory limitations of the 
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operating system and thus actually slowing down the job. In addition, if it takes much less 
time to create one target than the other, then the processor will not be used optimally while 
Carbon Server is working to finish the slower target. 

Delete Local Source After Conversion

If this option is checked, any local source files dropped into the Watch Folder will be deleted 
after they have been successfully transcoded. They will not be deleted if the transcoding 
failed and generated an error.

Delete Source File Shortcut Links to

If this option is checked, any shortcuts to the deleted source file are also deleted.

Accept Folders as Assets

This feature will allow you to use Carbon Server to automate other, third-party processes 
using notifiers (see 4.2.9 Creating Source Notifiers on page 97). If this option is checked, and 
a folder is dropped into the Watch Folder, then Carbon Server will not attempt to transcode 
the contents of the folder, but will pass the folder name to any notifiers attached to the Watch 
Folder. 

For example, this function could be used to pass the name of the folder that contains 
transcoded target files to a Command Line notifier (see 4.2.10.3 Command Line Notifier on 
page 98). The command line can then launch a third-party process that encrypts or adds 
DRM to all the files in the folder. 

If this option is unchecked, and a folder is dropped into the Watch Folder, Carbon Server will 
attempt to transcode source files contained in the folder only if the Watch Sub Folders option 
is checked (see  Watch Sub Folders on page 94). 

Retrieve Sources to Agent Machines

For Carbon Server systems, checking this option will allow individual Carbon Agent machines 
to retrieve source files over FTP or from network storage systems themselves. If this is 
unchecked, Carbon Agent machines have to wait for the Carbon Server machine to retrieve 
the source files over FTP and store them on the local storage of the Carbon Server machine. 
Carbon Server will then send the transcoding job to the Carbon Agent machines, and the 
Carbon Agents will then have to retrieve the source files from the local storage of the Carbon 
Server machine. 

Enable Segmented Grid Transcoding

For Carbon Server systems, checking this will allow source files to be split into segments and 
have each segment be processed by a different Carbon Agent machine. The Maximum 
Segments value determines into how many segments the source file can be split, don’t make 
this too high for smaller source files, since the overhead of splitting the source file and 
stitching the target segments back together may negate the segmenting advantage. 

NOTE:  Even if this option is checked, it will only work for some types of target files and under some 
circumstances. 
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4.2.8 Audio and Video Source Filters
Audio and video filters can be applied to a source file before it is transcoded into the various 
target file formats. See the lists below for the available audio and video filters. These filters 
can be found under the Source Folders category in the tree on the left.

If a filter is added as a source filter, then all output will have that effect applied. For example, if 
a crop is applied to the source via the Relative Crop filter, then all targets will have the same 
cropping applied. If you wanted to crop only one of your targets, then you would apply the 
Relative Crop filter as a target filter. 

If you would like to use settings, other than the default for each filter, then you need to edit 
the preset and save a new preset with its own name. You can create your own categories for 
presets. After choosing a new preset, you will need to select “Update” to update your Watch 
Folder with the new settings.

4.2.8.1 Audio Filters

 Channel Mixer

 DVD to PC Converter

 Dynamic Range Compressor

 Fade In/Out

 Lowpass

 Normalize

 Normalize—ITU 1770

 Parametric 5.1 to Stereo Converter

 Track Offset

 Volume

4.2.8.2 Video Filters

 601 Correction—Expand Color Space

 601 Correction—Shrink Color Space

 601 to 709 Color Correction

 709 to 601 Color Correction

 Adaptive De-Interlace

 Bitmap Keying

 Black/White Correction

 Blur 

 Broadcast Color Safe

 Caption 608 to 708 conversion

 Caption convert 708 to Ancillary

 Caption convert Ancillary to 708

 Caption Inject From .SCC File

 Circular Blur

 Color Correction

 Deblocking Filter

 DVD Subtitle/608 CC1 Imprint

 Fade In/Out

 Flexible-to-fixed frame rate conversion
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 Gamma Correction

 Gaussian Blur

 Line 21 Extraction

 Line 21 Modulator

 Map Alpha to Target Y channel

 Median

 Motion Compensated Temporal Filter

 Pulldown

 Relative Crop

 Rotate

 Sharpen

 STL Caption Burn-in

 Teletext Data Extraction

 Teletext Data Modulator

 Teletext inject from STL file

 Teletext Subtitle Captioner

 Temporal Noise Reducer

 Timecode Display

 Timecode Extraction—VITC

 Timecode Insertion—VITC

 Timecode Processing

 VBI Import from SMPTE 436M

 VBI Mapper

 V-Chip

 Video Inverse Telecine Filter

 Video Metadata Inject

 Video Source Properties

 Video Timecode Inject

 XML Titler

 XYZ to RGB video filter

4.2.9 Creating Source Notifiers
A Source Notifier lets you know when a source file starts or finishes transcoding, of if an error 
occurs during transcoding. 

Source Notifiers cause Carbon Server to execute a notification (send an email message, post 
a Web Service URL, or execute a Windows command line) whenever a job event (job starts, 
job finishes, or job encounters an error) occurs. 

4.2.10 String Replacement Tokens
You can use the following string replacement tokens in notifications: 

 %jobguid%. Unique GUID for this task

 %jobname%. Unique name for this task

 %source%. Full source path and name
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 %destinationname%. Result destination file name (only valid in completion 
notifications)

 %errormessage%. Error message (only valid in error notifications) 

4.2.10.1 Email Notifier 

An Email Notifier can be used to send emails on job start, completion, or error. You can use 
string replacement tokens in your email subject and body.

 Recipient. To whom the email should be sent, this is a normal email address. 

 Subject. Subject line of the email. 

 Body. Body text of the email.

Example: The file %source% has generated error message 
%errormessage% 

4.2.10.2 Web Notifier

A Web Service Notifier can be used to trigger external web services on job start, completion, 
or error. You can use string replacement tokens in your web service call.

 Web Service URL. The URL to execute when the job event (start, finish, or error) occurs. 

Example: http://myserver.com/script.aspx?Source =%source% 

4.2.10.3 Command Line Notifier

 Command Line: Command to execute. 

 External process shown as new job: Check this option to show the command line as a 
separate job in the Carbon Admin job queue. 

Example: c:\myprog.exe %source% 

4.2.10.4 On Start 

Send a notification when a job is started. 

4.2.10.5 On Completion 

Send a notification when a job is finished. 

4.2.10.6 On Error 

Send a notification when a job encounters an error. 

4.2.11 Remote File Retrieval
A Watch Folder can actively look for files to transcode on remote storage systems or FTP 
locations. When a file is detected at this remote location, it will be moved to the local Watch 
Folder and then transcoded. This is called a “remote retrieval”. A remote retrieval is used 
when the Watch Folder can’t transcode directly from the desired location, such as with an FTP 
site or shared storage that has a different password than the local system. 

4.2.11.1 File Retrieve: Remote Connection

 Remote Path (UNC). The folder on the remote storage where Carbon Server will look for 
new files to copy to the local Watch Folder for transcoding. You MUST use a UNC path, you 
cannot use a mapped drive since Windows processes like the Carbon Server background 
process Nexus are unable to access mapped drives. 
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 User (optional). If you need to log in to the remote storage to access the source files, enter 
the name here. 

 Password (optional). If you need to log in to the remote storage to access the source files, 
enter the password here. 

4.2.11.2 File Retrieve: Retrieval Settings

 Wildcard. File mask to retrieve. Files that do not match the wildcard will not be retrieved.

 Watch Interval (sec.). Interval in seconds between checking the remote location for new 
files.

 Minimum File Size (KB). Minimum file size in Kilo-bytes. Files smaller than this will not be 
retrieved. 

 Delete Source Upon Completion. Whether to delete the file from the remote location 
once it has been retrieved. 

 Watch Sub Folders. If the Watch Folder contains sub folders, checking this option will look 
in those sub folders for source files and transcode them the same way as source files in the 
Watch Folder itself. 

 Propagate Sub Folders. This option is only meaningful if ‘Watch Sub Folders’ is checked. If 
this option is checked, and the Watch Folder contains subfolders, then target files created 
from source files dropped into a subfolder will be created in an identically named subfolder 
inside the target folder. 

 Retrieve Sources to Agent. Only useful in a Carbon Server transcoding network. Checking 
this option will cause Carbon Agent machines to retrieve the source file directly, without 
Carbon Server having to retrieve the file first and then pass it to Carbon Agent. This can 
significantly improve transcoding and file transfer speeds. 

4.2.11.3 FTP Retrieve: Server Connection

 Current Server. Server name to connect to. 

 Server Status. Display whether Carbon Admin is currently connected to the FTP server. 

 Current Folder. The folder on the FTP server that is currently being browsed. Choose 
Select to browse into this folder. 

4.2.11.4 FTP Retrieve: Retrieval Settings

 Selected Folder. The folder on the FTP to retrieve files from.

 Wildcard. File mask to retrieve. Files that do not match the wildcard will not be retrieved.

 Watch Interval (sec.). Interval in seconds between checking the remote location for new 
files. 

 Minimum File Size (KB). Minimum file size in kilobytes. Files smaller than this will not be 
retrieved. 

 Delete Source Upon Completion. Whether to delete the file from the remote location 
once it has been retrieved. 

 Watch Sub Folders. If the Watch Folder contains subfolders, checking this option will look 
in those subfolders for source files and transcode them the same way as source files in the 
Watch Folder itself. 

 Propagate Sub Folders. This option is only meaningful if Watch Sub Folders is checked. If 
this option is checked, and the Watch Folder contains subfolders, then target files created 
from source files dropped into a subfolder will be created in an identically named subfolder 
inside the target folder. 
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 Retrieve Sources to Agent. Only useful in a Carbon Server transcoding network. Checking 
this option will cause Carbon Agent machines to retrieve the source file directly, without 
Carbon Server having to retrieve the file first and then pass it to Carbon Agent. This can 
significantly improve transcoding and file transfer speeds. 

4.2.12 Target File
 Preset Category. Presets are divided into categories for easier selection. 

 Select Preset. Select the preset to use for this target. 

 Target Folder. The folder to write the target file to. 

 Target File Name. The name to give the target file. Make sure to always at least include %s 
which represents the source file name.

 Delete Local Target File after Delivery. Whether to delete the file from the local Target 
Folder once the file has been delivered using either the File Delivery or FTP delivery.

4.2.12.1 Target File: Filters 

See 4.2.8.1 Audio Filters on page 96 and 4.2.8.2 Video Filters on page 96 for a list of filters 
that can be applied to audio and video source files. 

4.2.12.2 Target File: Notifiers 

When notifiers are added to a Watch Folder, those notifiers will be activated either the 
moment a source file is dropped in the Watch Folder, or when any one of the targets creates 
an error, or when all the targets from the Watch Folder have been created. Just like it is 
possible to add notifiers to the Watch Folder, it is also possible to add notifiers to individual 
targets. This way, the notifiers will be activated when the individual target is started, creates an 
error, or is finished. 

See 4.2.9 Creating Source Notifiers on page 97Notifiers for more information on the kinds of 
notifiers that can be attached to this specific target. 

4.2.12.3 Target File: Delivery—File Delivery 

 Delivery Path (UNC). The folder on the remote storage where this target files will be 
written.You MUST use a UNC path, you cannot use a mapped drive since Windows 
processes like the background transcoding process Nexus are unable to access mapped 
drives. 

 User (optional). If you need to log in to the remote storage to access the target folder, 
enter the name here. 

 Password (optional). If you need to log in to the remote storage to access the target folder, 
enter the password here. 

4.2.12.4 Target File: Delivery—FTP Delivery 

 Current Server. Server name to connect to. 

 Server Status. Display whether Carbon Admin is currently connected to the FTP server. 

 Current Folder. The folder on the FTP server that is currently being browsed. Select it to 
browse into this folder. 

 Selected Folder. The folder on the FTP to write target files to. 

4.2.13 Kernel Settings Configuration
The Tools > Kernel Settings menu in Carbon Admin is where less-frequently used 
configuration parameters for Carbon Server can be found. A number of these parameters can 
be used to fine-tune and debug Carbon Server machines or Carbon Server systems. 
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Some parameters can be changed and activated immediately (such as the Transcoding Slots 
parameter). For others, once the parameter has been changed, the Carbon Server Nexus 
Service needs to be restarted before the change is applied. These parameters have an 
asterisk (*) appended to them. Help text at the bottom of the dialog box may mention 
“Requires machine restart.”

4.2.13.1 Configuration Parameter Categories

 

Table 4–3: Rendering Category

Parameter Description

Transcoding Slots Set the number of simultaneous transcodes this machine will perform. 
A good rule of thumb is to set this to half the number of processor 
cores on the machine. Setting this to 0 disables transcoding on this 
machine

Machine Priority Jobs will be assigned first to those machines in a transcoding network 
that have the highest priority (10), lower priorities later.

Table 4–4: Network Category

Parameter Description

Use DNS to lookup machine 
names

Enable this to have IP addresses resolved to machine names using 
DNS, for the UI and log files. Disable it when there is no DNS server 
on the network or to improve performance.

Bind to IP Address* Force Carbon Server to communicate only using a specific IP address, 
specified as xxx.xxx.xxx.xxx . Leave this blank except on multi-homed 
systems. Requires machine restart.
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FTP Max Upload Sessions Set the maximum number of simultaneous post-transcoding FTP 
uploads (deliveries) this machine will perform.

FTP Max Download Sessions Set the maximum number of simultaneous pre-transcoding FTP 
downloads (retrievals) this machine will perform.

Maximum FTP Send 
Bandwidth (kbps)

Set this value to limit the total bandwidth in Kilo bits per second that 
all concurrent FTP sessions can use when sending output files that 
have been transcoded. Leave this value set to zero (0) to allow 
unlimited bandwidth use during sending. Note that unlimited 
bandwidth use may slow down the system to the point where no other 
network communications are possible, and may stall or crash system 
processes.

Maximum FTP Receive 
Bandwidth (kbps)

Set this value to limit the total bandwidth in Kilo bits per second that 
all concurrent FTP sessions can use when retrieving input files that will 
be transcoded. Leave this value set to zero (0) to allow unlimited 
bandwidth use during sending. Note that unlimited bandwidth use 
may slow down the system to the point where no other network 
communications are possible, and may stall or crash system 
processes.

Local Rendering only Set this to '1' (default is 'local and remote' = '0') to do transcoding only 
on the local machine, instead of also accepting transcoding jobs from 
other Carbon Server machines.

Maximum Disk Space For Job 
Processing

The minimum disk space (in MegaBytes) required on the local 
machine for an FTP retrieval to commence.

Table 4–5: Job Queue Category

Parameter Description

Max completed jobs Number of completed jobs kept in the queue if Manage-Job-Queue is 
enabled.

Max failed jobs Number of failed jobs kept in the queue if Manage-Job-Queue is 
enabled.

Retry Delay for failed Jobs Number of seconds to wait before a failed job is automatically 
resubmitted to the queue. Setting this to zero (default) never 
automatically resubmits a failed job.

Table 4–6: Email Server Category

Parameter Description

SMTP Server Specify the SMTP Server to use for outgoing emails.

SMTP User Specify the SMTP User account for outgoing emails.

Table 4–4: Network Category

Parameter Description
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SMTP Password Specify the password for the SMPTP User account specified above.

SMTP Sender Specify the email address of the sender for outgoing emails.

Table 4–7: Machine Render Properties Category

Parameter Description

Machine Tags Enter a list of strings separated by semi-colons (';'). Each string (tag) 
can be chosen by the end user and is used to designate this machine 
as possessing a specific property. When creating a Watch Folder (or 
submitting a transcoding job using the API), it is possible to add a tag 
to that Watch Folder. This signifies that jobs created by that Watch 
Folder will also have that tag, and be executed only on machines that 
have the same tag listed in this field. This is useful if there are many 
Carbon Server machines in a transcoding network, but only a few 
have a special codec or piece of hardware installed (often for 
licensing- or budgetary reasons). If, for example, there are 10 
machines on a transcoding network, all with 2 processor cores and 
2GB of memory, except for 2 of those machines that have 8 cores 
and 8GB of memory each, the tag HI_PERFORMANCE could be 
entered in this field on those two machines. If a Watch Folder has that 
same tag, source files dropped in that Watch Folder will then be sent 
only to those fast machines, and in theory will be processed much 
faster than other jobs. Note that jobs that do not have a tag can be 
executed on any machine, it is only jobs with tags that are sent to 
specific machines.

Pre-load Kernel in Memory Set this to '0' (default is 'pre-load' = '1') to load the transcoding kernel 
only when transcoding jobs start. Enabling pre-load reduces the start-
up delay of transcoding jobs, and reduces free memory by around 
80MB.

Kernel Preset Enumeration Set this to '0' (default is 'enumerate' = '1') when configuring the 
system for exclusive API use and new presets will not need to be 
created. WARNING: Disable this only for purely API-based use of 
Carbon Server. When disabled, no user interface interaction with 
presets is possible.

Table 4–6: Email Server Category

Parameter Description
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Table 4–8: Watch Settings Category

Parameter Description

Watch Folder Retry Time (ms) When a source file is dropped into a Watch Folder, this setting 
determines how many milliseconds to wait before checking if the 
source file size is changing (for example, because the file is still being 
written by the OS or an FTP upload). If the file size has changed 
between checks, will check again, and continue doing so until the file 
size is the same for two consecutive checks. If this is set to zero, 
Carbon Server may immediately begin transcoding source files when 
dropped in a Watch Folder, regardless of whether they are finished 
being written. This can cause the transcode operation to fail.

Minimum Source File Size 
(bytes)

When a source file is dropped into a Watch Folder, it will be 
transcoded if it is this size in bytes or larger. Smaller files will be 
ignored, this can be useful for video source files that come with 
unneeded metadata files, for example.

Ignore FS Modifier Set this to '1' (default is 'do not ignore' = '0') to ignore File System 
messages from the Windows OS. Some playout server file system 
drivers or network storage drivers may not completely or correctly 
implement those messages, so setting this field may resolve issues 
with jobs staying in the Preparing stage for a long time (tens of 
minutes). Setting this field disables Carbon Server's normal detailed 
file status analysis, so should therefore be used with caution.

Don't Resolve to UNC Carbon Server normally automatically converts a directory name such 
as c:\Input on the machine STORAGE01 into the UNC path 
\\STORAGE1\C$\Input, so that other machines can access the same 
file when needed (for example, when decoding a source file). Set this 
field to disable that mechanism, and leave directory names as they 
are. This can be necessary in the case of a SAN for example, where 
every machine on the transcoding network has a SAN driver with the 
drive letter X: installed for example. In this case, all file names such as 
X:\DropHere\Sourcefile.mpg will be passed verbatim to other 
machines. Use this with caution; if not all machines have this drive 
letter and the drive letter does not point to the exact same network 
storage for all machines, subtle and difficult to diagnose errors may 
occur.

Table 4–9: Storage Locations Category

Parameter Description

Media Submission Path* DirectDrop exporters write media to this directory. This location must 
be accessible throughout your network, must allow fast writing and 
must have plenty of free space available. Requires machine restart.

Reference Files Data Storage* The location for the data portion of submitted reference files. Requires 
machine restart.
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Table 4–10: Farm DIRECTDROP Category

Parameter Description

Subscribed Farm Manager Enter a server name or IP address. Carbon Server will assume this 
machine exists and use it for DirectDrops etc.

Table 4–11: XML Job Submission Category

Parameter Description

XML Watch Folder* It is possible to execute API jobs by dropping XML files in the 
directory entered in this field. Requires machine restart. (See the 
Harmonic Carbon API Manual for XML file specifications; installation 
installs everything necessary to use the API.)

Table 4–12: Logging Category

Parameter Description

Log Jobs to Event Log Setting this will log Jobs into the Windows Applications Event Log.

Write Engine Log File Setting this causes Carbon Server to write a general log file, which 
contains general information for each transcoding job executed.

Log File Path* The general log file is written to this directory. Requires machine 
restart.

Log File Retention (days) A new log file is created at midnight every day. This field determined 
how many days back to keep the old log files, for example, setting this 
to 5 leaves today's file and the files from the preceding 4 days intact 
but removes log files any older than that. Setting this field to zero 
(default) leaves all log files in place an never removes any.

Table 4–13: Logging - XML File Category

Parameter Description

Write XML Log File to File 
Share*

Setting this causes Carbon Server to write a general log file in XML 
format. Requires machine restart.

File Path for XML Files* The general XML-format log file is written to this directory. Requires 
machine restart.
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Table 4–14: Status - XML File (FTP) Category

Parameter Description

Write XML Log File to FTP 
Server*

Setting this causes Carbon Server to write a general log file in XML 
format to an FTP server. Requires machine restart.

FTP Site* Enter IP address or server name. Requires machine restart.

FTP Port* Enter Port# to use. Requires machine restart.

FTP User* Enter User Name. Requires machine restart.

FTP Password* Enter Password. Requires machine restart.

Remote Path* Enter Remote Path. Requires machine restart.

Table 4–15: Status Timeouts Category  

Parameter Description

Timeout Preparing Status (s) Number of seconds a transcoding job allowed to be in the Preparing 
status before it times out and is considered as having failed.

Timeout Preparing Status - 
Agent (s)

Number of seconds a transcoding job allowed to be in the Preparing 
status before it times out and is considered as having failed. This field 
applies to Carbon Agent machines only, very long timeouts must be 
tolerated for these machines because very large source files could still 
be in the process of being written.

Timeout Starting Status (s) Number of seconds a transcoding job allowed to be in the Starting, 
Paused, or Reading status before it times out and is considered as 
having failed.

Timeout Stopping Status (s) Number of seconds a transcoding job allowed to be in the Stopping 
status before it times out and is considered as having failed. Note that 
Stopping can take a relatively long time some exporters index files, re-
multiplex, etc. during the Stopping phase. A very high value is 
recommended, at least twice the time it would take to read/write the 
typical output files to/from disk.

Timeout Started Status (s) Number of seconds a transcoding job allowed to be in the Started 
status before it times out and is considered as having failed. This is the 
longest total time a job is considered valid without having received 
status updates.
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Transcoding Inactivity (s) Number of seconds a job is allowed to have no transcoding progress 
before it times out and is considered as having failed. Note that the 
default is 30 minutes, this should be changed without careful 
consideration. Many output formats have processes that do not 
involve any transcoding progress at all, such as de-multiplexing 
source files or writing temporary output files, and those jobs would fail 
if this timeout limit is set too low.

Pipeline Inactivity (s) Number of seconds the transcoding pipeline will wait (for example, to 
receive newly decoded video samples) before it times out and the job 
is considered as having failed.

Table 4–16: User Interface Category

Parameter Description

Alternate H.264 Encoder If alternate, third part H.264 encoders (not installed with this 
transcoder) are installed on this system, enable this to expose a text 
field in the H.264 target that allows you to set parameters specific to 
the selected H.264 encoder. Those parameters are encoder-specific 
and the encoder may not be passed all the parameters set in this 
transcoder’s user interface or presets.

Use COM Messaging* If the service user is a dedicated user and the desktop user is different 
from the service user, updating the GUI with status changes may fail. 
Use a special communication through a COM interface by enabling 
this option. Requires machine restart.

Table 4–17: Debug - Network - Autodetect Category

Parameter Description

Broadcast Server IP Disable this to prevent Carbon Agent and ProMedia Carbon machines 
from finding this Carbon Server machine. The Server will still see the 
Agents.

Broadcast Agent IP Disable this to prevent Carbon Server machines from finding this 
Carbon Agent machine. The Agent will still see the Server. 

Broadcast Client IP Disable this to prevent Carbon Server machines from finding this 
ProMedia Carbon machine. The Coder will still see the Server.

Table 4–15: Status Timeouts Category continued

Parameter Description



Table 4–18: Debug - Network - Ports Category

Port Description

 Nexus Service Port* Main listening port of the Nexus background transcoding service for 
all external connections. Requires machine restart.

Nexus Admin Port* Internal Nexus to Nexus and component communication port. 
Requires machine restart.
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Table 4–19: Debug - Logging Category

Parameter Description

Log Watches Setting this causes Carbon Server to write a Watch Folder log file, 
which contains processing information about source files dropped in 
Watch Folders and jobs created by Watch Folders. NOTE: Use only for 
debugging and support.

Log Remote Retrieval 
Watches

Enable this to write a remote retrieval watch log file containing 
processing information about FTP and LAN retrievals attached to the 
Watch Folders. NOTE: Use only for debugging and support.
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Chapter 5
Configuring Carbon Server

By using Carbon Server, an organization can easily scale the number of machines being used 
for transcoding without changes to the basic workflow. Carbon Server allows a network of 
transcoding machines to “look” like a single transcoding machine. The Carbon Server 
application manages the following items: 

 Job distribution 

 Job prioritization 

 Load balancing 

 Failover protection 

 FTP transfer management

 Status monitoring 

 Job notification 

5.1 Carbon Server Setup
A simple Carbon Server setup would look something like this:

In this case a single Carbon Server is controlling a number of Carbon Agents. A Carbon 
Agent is the “slave” transcoding process that runs under the “master” of Carbon Server. The 
Carbon Agent is a version of the ProMedia™ Carbon application that runs without a user 
interface. The Carbon Server application can also perform local transcoding. Therefore a 
configuration of one Carbon Server and 4 Carbon Agents would provide five times the 
transcoding throughput of a single ProMedia Carbon machine. 

Carbon Server is designed to scale from a single user to an entire enterprise. The server 
software automatically recognizes new Carbon Agent “nodes” and adds them to the 
transcoding network. If a Carbon Agent fails to transcode a job, that job is automatically 
routed to another Carbon Agent. 
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The distributed transcoding network managed by Carbon Server can access shared storage 
on the network or remote storage via FTP. As an example, Carbon Server can be set to watch 
an FTP location on a catch server, then automatically transcode arriving material into an 
editing format. The transcoded video can then be automatically transferred to an editing 
station. 

5.1.1 Carbon Server Tools
You can manage your Carbon Server transcoding network, using Carbon Admin, the desktop 
tools, the optional Web user interface, and the API, as described in the following sections.

5.1.1.1 Carbon Admin 

The Carbon Admin application allows you to see all the jobs that are currently queued for 
transcoding. You can see the parameters for each job, including priorities and targets. It also 
allows you to manage transcoding nodes within the system. For example, you can individually 
set the number of simultaneous transcodes that you want each node in the network to work 
on. You can also activate or reset specific nodes in the system. In addition, Carbon Server 
Admin allows you to set up specific Watch Folders on your network. A Watch Folder has a 
number of parameters including source file location, location to write the target file, preset, 
etc. A Watch Folder can also be used to get data from a specific FTP server or to send a 
transcoded target file out to an FTP server. Watch folders can also have instructions regarding 
what to do with source files once transcoded. For example, whether they should be deleted 
or left in place. See 4.2.6 Watch Folder Management on page 92 for more details. 

5.1.1.2 ProMedia Carbon 

The Carbon Server installation process also installs the ProMedia Carbon application on the 
machine. ProMedia Carbon allows you to create presets for specific transcoding operations. 
Carbon Server ships with several hundred presets, or you can create your own. A preset 
includes both the transcoding parameters and any desired video and audio filters. The 
presets created in ProMedia Carbon are available for setting up Watch Folders. 

5.1.1.3 Tagging Agent Machines for Specific Jobs

Carbon Server has the ability to 'tag' certain agents on its render farm to do specific types of 
jobs. A tag is simply a word you define for a specific task or group of tasks. You may then 
create a job or Watch Folder that uses only the agents which have a certain tag. See 
instructions below to set up an agent and Watch Folder to use a ‘tag.’ 

Instructions

1. Go to the desktop of the agent machine you want to assign a tag to and start the Carbon 
Admin interface.

2. Select Tools > Advanced Kernel Options.... 
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3.  In the Machine Tags field enter something like Flash8. 

NOTE:  You can enter multiple tags for one agent by separating each tag with a ;.

4. Select OK. 

5. Restart the Nexus service. 

6. Using Carbon Admin, create a new Watch Folder. 

7. When you add a target to the Watch Folder using Carbon Admin, select the double 
arrows in the Job Tags field, you should see the Flash8 tag. 

8. Select Flash8 and finish adding the target.

9. Any transcoding jobs from this Watch Folder that will be converted to this target will now 
be run only on the machines that have the Flash8 tag assigned to them in the Advanced 
Kernel Options dialog box. 

5.1.2 Controlling Carbon Server with the API
In addition to the desktop tools and Web UI, a transcoding network can be controlled directly 
via an XML-based API provided with the software. Every aspect of the transcoding process 
can be controlled by the API, including source- and target destinations, transcoding 
parameters, filtering, compositing, ad insertion, titling, notifications, etc. The same API 
controls both ProMedia Carbon and Carbon Server, so your work will scale from a single 
machine to an entire transcoding network. 

5.2 Considerations for Operating Carbon Server

5.2.1 File and Folder Access
Every Carbon Agent “sees” a job exactly as you submitted it. If you set your Watch Folder to 
the Carbon Server machine’s “c:\incoming” folder and you drop a file "test.avi" into the folder, 
the job will be passed to the Carbon Agent with instructions something like “take the file in 
the folder c:\incoming\test.avi and convert it.” The “c:” drive on the Carbon Agent machine is 
different and may not even contain a “c:\incoming” folder, therefore the job will fail. Carbon 
Server does do translation of local drives to UNC paths, such as converting 
“c:\incoming\test.avi” to “\\<Managermachine>\c$\incoming\test.avi,” but this may still be a 
problem in some circumstances, for example, with user access rights. 
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To avoid this, we suggest avoiding drive letters entirely. If you want to create a drop location in 
your local machine, create it as “\\<your machine>\<drive>$\<folder>\.” In this case the 
agents will be able to access the Watch Folder regardless of location. The same issue applies 
to the target folder of your Watch Folder. 

5.2.2 Codec and Third-party Component Availability 
If you are using codecs or exporters that were not shipped along with your Carbon Server, 
please make sure they are installed on every Carbon Agent in your farm. Carbon Server 
distributes user created presets automatically but it cannot re-distribute third-party 
components such as codecs, etc. 

5.2.3 Multiple Carbon Servers 
Carbon Server can be operated with multiple Carbon Server farm manager machines. In this 
scenario, each Carbon Agent serves each Carbon Server. When a Carbon Agent has free 
slots, the first Carbon Server that polls the Carbon Agent will receive access to the Carbon 
Agent resources. When running multiple Carbon Servers, please consider user right issues: 
the Carbon Agent is controlled by a Windows Service with a user login and has to serve 
multiple Managers. The access to all Manager machine administrative shares must be 
ensured for this user (for preset distribution). This issue is covered in the installation and 
configuration steps, but pay specific intention in the multiple Carbon Server issues to issues 
such as account naming and credentials. 

5.2.4 Failover
Carbon Server has built-in “failover.” If a job fails to transcode on a Carbon Agent machine for 
any reason, the job will be re-assigned to a different Carbon Agent. This will be repeated until 
all Carbon Agents report failure. 

If you use the Carbon Server Admin application to look at the queues of the individual Carbon 
Agent machines, you will see those errors reported. Since Carbon Server spends a significant 
amount of time in retrying and reassigning jobs please consider troubleshooting that 
particular Carbon Agent if the number of errors is high. 

5.2.5 Logging
To view job status (Job started, failed, completed etc.) as well as certain error conditions, 
enable logging as follows:

1. Launch the Carbon Server Admin application.

2. Select Tools > Kernel Settings and check the following options: 

 Logging: Write Engine Log File

 Logging: Log File Path (if you want to change the location of the log files)

 Optionally you can also enable the debug logs (enable the first two only when asked 
to by Harmonic Support, they will significantly impact transcoding performance):

 Debug—Logging: Log Watches

 Debug—Logging: Log Remote Retrieval Watches 

3. Close the Carbon Server Admin application. 

4. Restart the Nexus Service to read the logging options.

5. Select Start > Control Panel > Administrative Tools > Services.

6. Select the Nexus Server (Carbon Server) service, and select Restart the service in the 
top left of the window. 
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After setting the logging options, Carbon Server will generate log information and write it to 
the specified file.

5.2.5.1 Error Handling

Error logs are available both through logging in Carbon Server as well as through the NT 
Event Log.  Following are explanations of how to enable logging in Carbon Server, how to 
enable sending logs to the NT Event Log, and a list of common errors for reference. To see 
the error list with descriptions, go to A.2 Error Numbers and Descriptions on page 119.

5.2.5.2 Enabling Logging

To enable logging, open Carbon Server Admin, select the Tools menu, and then Kernel 
Settings.  Once there, scroll down to Kernel Settings.  

5.2.5.3 Log Jobs to Event Log

Setting this to True will log jobs into the Windows Applications Event Log.

5.2.5.4 Write Engine Log File

Setting this to True causes Carbon Server to write a general log file that contains general 
information for each transcoding job executed.

5.2.5.5 Log File Path

The general log file is written to this directory.  Please note that the default directory has been 
changed from previous versions of Carbon Server and is now c:\Program Files\Common 
Files\Rhozet\Carbon Coder\Kernel\.  Also note that changing this setting requires restarting 
the system to take effect.

5.2.5.6 Log File Retention (days)

A new log file is created at midnight every day.  This field determines how many days back to 
keep the old log files, for example, setting this to 5 leaves today?s log file and the log files 
from the preceding 4 days intact but removes log files any older than that.  Setting this field to 
0 (default) leaves all log files in place and never removes any.

You may additionally enable logging to an XML file.

 Write XML Log File to File Share. Setting this to True causes Carbon Server to write a 
general log file in XML format.  This requires a machine restart to take effect.

 File Path for XML Files. The general XML-format log file is written to this directory.  
Changing this requires a machine restart to take effect.

By enabling the XML File (FTP) logging you can write an XML log to a remote FTP location.  To 
do this set Write XML Log File to FTP Server to True and enter the appropriate information for 
the FTP server and path where you would like the XML file stored.  For debugging purposes 
there are 4 additional types of information you can log (described below).  It is important to 
note that enabling these logging options can significantly affect the performance of Carbon 
Server.

5.2.5.7 Log Watches

Setting this causes Carbon Server to write a Watch Folder log file that contains processing 
information about source files dropped in Watch Folder and jobs created by Watch Folders. 

NOTE:  This should be used only for debugging and support.



Chapter 5 Configuring Carbon Server Considerations for Operating Carbon Server

 © 2012 Harmonic Inc. 114 ProMedia™ Carbon Installation and User Guide v.3.20

5.2.5.8 Log Remote Retrieval Watches

Setting this causes Carbon Server to write an attached watch log file; this contains processing 
information about FTP and LAN retrievals attached to Watch Folders.  

NOTE:  This should be used only for debugging and support.

5.2.6 Importing the DivX File Extension
The following instructions explain how to give Carbon Server the ability to import the *.divx 
file extension.

1. Run regedit.

2. Browse to HKEY_LOCAL_MACHINE\Software\Rhozet\Carbon Coder\{477062CF-
ABAE-4EE2-9049-6010A7E6B9B9}.

3. Add a new string value to this key titled ImportExtensions.

4. Right-click the ImportExtensions string and select Modify.

5. Change the value of the ImportExtensions string to divx.

6. Close regedit.

7. Restart ProMedia Carbon. 

NOTE:  When using a render farm, these instructions will need to be followed individually on each agent 
machine. The DivX player needs to be installed on all machines that need to process DivX files.

5.2.7 Force Import Using MPEG Importer Based on File Extension
The following instructions explain how to give Carbon Server the ability to import non-
standard file extension with the MPEG importer.

1. Run regedit.

2. Browse to HKEY_LOCAL_MACHINE\Software\Rhozet\Carbon Coder\{C8C765E3-
B3EB-4AE3-B463-1B5C82E63CBB}.
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3. Add a new string value to this key titled ImportExtensions.

4. Right-click the ImportExtensions string and select Modify. 

5. Change the value of the ImportExtensions string to the file extension that you would like 
to import. For example, if you want to import a file with extension “*.encoded”, then enter 
the value encoded. 

6. Close regedit.

7. Restart ProMedia Carbon. 

NOTE:  When using a render farm, these instructions will need to be followed individually on each agent 
machine.
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Appendix A 
Troubleshooting Carbon Products

This chapter provides suggested actions that users can take should commonly reported 
issues occur, and ways to contact Harmonic support:

 A.1 Solving Unexpected Problems

 Includes steps you can take if Carbon Server or Carbon Agent found issues arise.

 A.2 Error Numbers and Descriptions

 Includes error descriptions to solve issues quickly. 

 A.3 Common Video Encoding Problems

 Includes common video encoding problems and how you can avoid or fix them.

 A.4 Contacting Harmonic Support

 Contact information, including Harmonic’s web address, mailing address, and support 
phone numbers.

A.1  Solving Unexpected Problems

A.1.1   Carbon Products are not Working as Expected
If one of the Carbon Server or Carbon Agent machines does not work as expected, please 
check the following points:

 DirectX and QuickTime. Verify that DirectX and QuickTime are installed on Carbon Server 
and Carbon Agent machines.

 USB Security Keys. Verify that each USB security key (dongle) is inserted correctly and in 
the appropriate machine. The Carbon Server farm manager machine requires the “Carbon 
Server” USB security key; each Agent requires one “Carbon Agent” USB security key. If you 
are in doubt, the Carbon Admin interface will report an incorrect or missing USB security 
key when launched. 

 Firewalls. Please ensure that the firewalls are disabled on the involved machines. If a 
firewall is required to run, please open the ports 21, 80, 1101, 1102, 1103 and 1104. You 
may find that under some circumstances even opening ports will not make Windows 
Firewall work correctly, in this case try disabling it entirely.

 Event Viewer. When the Harmonic background transcoding services start, potential 
problems will be logged as events, which can be viewed using the Windows Event Viewer 
(Start > Control Panel > Administrative Tools > Event Viewer). 

A.1.2   Multi-hosting issues with Carbon Server
Multi-hosting is supported with Carbon Server or Carbon Agent by binding the Nexus 
background service to a specific IP address. We define multi-hosting as a machine with 
multiple NICs connected to the same or different network but maintaining different IP 
addresses. Please see 4.2.13 Kernel Settings Configuration on page 100 for more information.

A.1.3   Windows Firewall Consideration
By default, Windows Firewall will block the ports that Carbon Server requires to communicate. 
In order for Carbon Server to be able to properly communicate across the network, either 
Windows Firewall needs to be disabled or configured to allow traffic on those ports. If your 
Carbon Server installation is using the default ports for communication, then you need to 
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make sure that the Nexus Service has access to both ports 1101 and 1111. If you’ve 
customized the ports over which Carbon Server communicates, then those new port 
numbers would be assigned to Nexus in the firewall configuration instead of ports 1101 and 
1111.

A.1.4   Data Execution Prevention
When running Harmonic products on Windows Server 2003, errors may appear when trying 
to launch applications. One symptom is the Harmonic application stalling on the message 
“Loading ‘Sharpen’ filter”. 

To solve this requires changing the Windows Data Execution Prevention (DEP) default setting. 
See the steps below how to set the DEP option.

1. Go to Start > Run and enter sysdm.cpl. Select OK to open your System Properties dialog 
box.

2. Select the Advanced tab.

3. In the Performance section select Settings.
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4. Select the Data Execution Prevention tab.

5. Select Turn on DEP for essential Windows programs and services only.

6. Select OK.

A.1.5   Carbon Server and Carbon Agent on Different Subnets
By default, Carbon Server and Agent will not find each other if they are located on different IP 
subnets within your network. The reason for this is that the ports over which Carbon Server 
communicates are more often than not closed by default on routers. There are two possible 
solutions to get Carbon Server to communicate through different subnets. First, you can 
reconfigure your routers to allow the default ports Carbon Server uses by default to be open. 
Second, you can change the ports Carbon Server uses to communicate on each system to a 
port that is already open and available on your routers. Note that this change needs to be 
made on every Carbon Server and Carbon Agent machine you wish to communicate. Please 
see Table 4–18 on page 108 for more information.

Option 1: Router Configuration. The two default ports that need to be open for Carbon 
Server to communicate are 1101 and 1111. Individual router configuration is different between 
different brands and models, so please consult the documentation accompanying your router 
to open these two ports. 

Option 2: Port Configuration. To change the ports on which Carbon Server communicates, 
open the Carbon Admin application on both Server and Agents. Select the Tools > Kernel 
Settings. There you will find two settings: Nexus Service Port and Nexus Admin Port. Change 
these two fields to the ports that you would like to use and set the routers accordingly. Please 
note that these cannot be the same port. Please see Table 4–18 on page 108 for more 
information.
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A.2  Error Numbers and Descriptions
Table A–1: Error Numbers and Description  

Error Number Description

x00000001 "This operation is not supported in this version. [CR:0x00000001]"

x00000002 "An unknown error occurred. [CR:0x00000002]"

x00000003 "A version conflict occurred. [CR:0x00000003]"

x00010F06 "The Transcoder cannot import this file format. [CR:0x00010F06]"

x00010F0A "Destination Parameter problem occurred. [CR:0x00010F0A]"

x00010F0C "Destination Interleaving violation [CR:0x00010F0C]"

x00010F0E "Generic Target Error occurred. [CR:0x00010F0E]"

x00010F0F "Copy Protection Device not found [CR:0x00010F0F]"

x00010F10 "Generic Error in Plugin. [CR:0x00010F10]"

x00010F11 "Your destination location has no free hard drive space available. The 
conversion was stopped. [CR:0x00010F11]"

x00010F12 "Could not write to your destination location [CR:0x00010F12]"

x00010F15 "File size limit reached. Your OS does not allow to write files larger 
than 4GB. The conversion was stopped. [CR:0x00010F15]"

x00010F16 "File system limit reached. Your File system does not allow to write 
files larger than 4GB. The conversion was stopped. 
[CR:0x00010F16]"

x00010F17 "File size limit reached. The conversion was stopped. 
[CR:0x00010F17]"

x00010F18 "Not enough memory available for the current operation 
[CR:0x00010F18]"

x00010F19 "The Conversion was aborted. [CR:0x00010F19]"x00010F1A="Your 
Transcoder Installation is damaged. Please run Setup again. 
[CR:0x00010F1A]"x00010F1D="Internal Application Error: 
(NOTIMPLEMENTED). [CR:0x00010F1D]"

x00010F1E "The file name you specified is invalid. [CR:0x00010F1E]"

x00010F1F "The Target File was not written correctly. It might contain errors. 
[CR:0x00010F1F]"

x00010F20 "Your source video has an odd size. The Transcoder can only import 
sources with an even size. [CR:0x00010F20]"

x00010F22 "DirectX 9 or higher needs to be installed on your computer. The 
Transcoder cannot start. [CR:0x00010F22]"
x00010F23="QuickTime 6 or higher needs to be installed on your 
computer. The Transcoder cannot start. [CR:0x00010F23]"
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x00010F24 "This product requires EDIUS to be activated or in the trial period. 
Please activate EDIUS and try again. [CR:0x00010F24]"

x00010F25 "This product requires trial or activated version of EDIUS HDV. Please 
install and activate EDIUS HDV and try again. [CR:0x00010F25]"

x00010F26 "Cannot add another module of this type (limit of simultaneous usage 
exceeded). [CR:0x00010F26]"

x00010F27 "Invalid parameters [CR:0x00010F27]"

x00010F28 "There is an error happened when create/open or process memory 
map file [CR:0x00010F28]"

x00010F29 "There is an error happened when create/open /set/reset event 
[CR:0x00010F29]"

x00010F2A "Specified target filename is invalid. This can happen if you try to write 
to a read-only media or the target file already exists and is in use. 
[CR:0x00010F2A]"

x00010F2D "The Transcoder detected stalling in the conversion. Possibly your 
source is no longer accessible. Select Stop to cancel your conversion 
[CR:0x00010F2D]"

x00010F2E "Non-recoverable Frame Drop occurred during Capturing 
[CR:0x00010F2E]"

x00010F2F "The job cannot be rendered - please try again later (global resource 
currently not available). [CR:0x00010F2F]"

x00020001 "Plugin not found. [CR:0x00020001]"x00020002="Your source file 
name is invalid [CR:0x00020002]"

x00020003 "Audio/Video formats incompatible. [CR:0x00020003]"

x00020004 "Your system is low on memory. [CR:0x00020004]"

x00020005 "Conversion cancelled. [CR:0x00020005]"

x00020006 "This preset is referring to an exporter which is not installed on your 
system. [CR:0x00020006]"

x00020007 "This preset is invalid. [CR:0x00020007]”

x00020008 "The settings of this preset are invalid. [CR:0x00020008]"

x00020009 "Please select a target first. [CR:0x00020009]"

x0002000A "The Transcoder cannot import this file. Either the file format is not 
supported or the file is damaged. [CR:0x0002000A]"

x0002000B "The Transcoder cannot load the required plugin for this action. 
[CR:0x0002000B]"

x0002000C "Copy-Protection Device not found. [CR:0x0002000C]"

Table A–1: Error Numbers and Description continued

Error Number Description
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x0002000D "A Preset with the given name already exists. Please choose another 
name. [CR:0x0002000D]"

x0002000E "The preset name you entered is not a valid file name. Either it is too 
long or contains invalid characters. Please choose another name. 
[CR:0x0002000E]"

x0002000F "Couldn't change the category for the presets - possibly the presets 
are write protected or system presets. [CR:0x0002000F]"

x00020010 "Couldn't change the category for the some presets - possibly the 
presets are write protected or system presets. New Category was 
created but old category was kept. [CR:0x00020010]"

x00020011 "The project file is invalid. [CR:0x00020011]"

x00020012 "One or multiple sources/targets could not be restored 
[CR:0x00020012]"

x00020013 "One or multiple sources from the project file could not be loaded. 
[CR:0x00020013]"

x00020014 "One or multiple targets could not be restored from the project file. 
[CR:0x00020014]"

x00020015 "One or multiple filters could not be restored from the project file. 
[CR:0x00020015]"

x00020016 "Your system is low on virtual memory. The Transcoder needs 
sufficient virtual memory (150 MB) to perform the conversion. The 
Transcoder cannot load this source file. [CR:0x00020016]"

x00021001 "Internal Application Error: (NOT_SUPPORTED). [CR:0x00021001]"

x00021002 "Internal Application Error: (PARAMETER). [CR:0x00021002]"

x00021003 "Internal Application Error: (INTERFACE). [CR:0x00021003]"

x00021004 "Internal Application Error: (DLLINTERFACE). [CR:0x00021004]"

x00021005 "Internal Application Error: (ENUMINDEX). [CR:0x00021005]"

x00021006 "Internal Application Error: (GRAPHSTATUS). [CR:0x00021006]"

x00021007 "Internal Application Error: (CLASSSTATUS). [CR:0x00021007]"

x00022001 "No audio filter found to perform required conversion. 
[CR:0x00022001]"

x00022002 "No video filter found to perform required conversion. 
[CR:0x00022002]"

x00022003 "Internal Error: unable to start conversion. [CR:0x00022003]"

x00022004 "Internal Error: unable to locate required filter. [CR:0x00022004]"

x00022007 "Audio/Video mismatch between source and target. 
[CR:0x00022007]"

Table A–1: Error Numbers and Description continued

Error Number Description
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A.2.0.1 Errors Description

Each error description returned by Carbon Server will now end with the string 
"[CR:0x????????]" containing 8 hexadecimal characters. This will be visible to manual 
operators in the Carbon Admin as well as in errors returned when using the API.

The first 3 hex digits identify the Carbon Server module (0x000????? - 0xFFF?????), these 
could be importers, exporters, filters, etc.  The last 5 hex digits identify the error (therefore 
both 0x00F00001 and 0x00C00001 could be generated for example)

A.2.0.2 Identical Error Numbers 

Identical error numbers with different error descriptions may occur, for example, the string 
could be "Can't write to d:\" or "can't write to e:\" with the same error number representing 
"can't write to [letter]:\".

Identical error descriptions with different error numbers may occur, for example, both the 
MXF and GXF source import modules may generate a "can't access Metadata" error 
description but since they have different module numbers the error numbers will be different.

There is a common number space [0x000?????], designed for generic errors, which can 
appear when it is not possible to identify the module in which the error occurred.

A.3  Common Video Encoding Problems
This section illustrates some common video encoding problems and how you can fix or avoid 
them.

A.3.1   Video is Blocky or Appears to Break Up
The video image appears to break up into different moving blocks. Parts of previous video 
may appear in different locations. Notice in the example that elements of the correct video 
seem to be mixed with the older video. After some time, the image may recompose itself, 
producing a correct image.

x00022008 "Unable to spawn new thread. [CR:0x00022008]"

x00022009 "Unable to read source file. [CR:0x00022009]"

x0002200A "Unable to write target file. [CR:0x0002200A]"

x0002200B "Unable to start encoding preview. [CR:0x0002200B]"

x0002200C "Internal Error: Unable to start video processing. [CR:0x0002200C]"

x0002200D "Internal Error: Unable to start audio processing. [CR:0x0002200D]"

x0002200E "Unable to start multipass encoding session. [CR:0x0002200E]"

x00022028 "Two or more Audio Normalize filters in sequence not allowed. 
[CR:0x00022028]"

x0002202A "Cannot login to network share. [CR:0x0002202A]"

Table A–1: Error Numbers and Description continued

Error Number Description
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Possible Causes

 DVD media reading problem. If you are seeing this type of problem after authoring a DVD 
and playing it back on a set-top DVD player, it could simply be a difficulty reading the DVD-
recordable media. Try the same disc in a computer-based DVD player. If it plays in the 
computer without problems, try a different set-top player or a different brand or type of 
DVD-recordable disc. Many set-top players cannot reliably play all DVD-recordable discs.

 Use of seek or trick-play in the player. If you were playing the file and playback was okay 
until you used the player’s fast-forward, rewind or scrubber to reposition the playback 
location, then it’s probably not a problem at all. Depending on the format and player, the 
video may take until the next keyframe to start displaying properly. Try letting the file play 
through from start to end without interrupting it to verify. If the video displays correctly in a 
straight-through playback, then the output file is fine.

 Video bit rate too low or not enough keyframes. If the break-up only appears after scene 
changes, then the video bit rate is too low to handle the large change in the video. Increase 
the video bit rate to allow faster recomposition. Alternatively, if the target format supports 
keyframing, decrease the keyframe interval, thus increasing the number of keyframes. 
Keyframes provide a full video frame so large changes can be tracked and better 
compensated for.

 Video bit rate too high. When using a hardware decoder, such as for MPEG playback, in 
some cases a video bit rate that is too high can cause the to image break up. If the video 
bit rate is at or near the maximum setting, try reducing it a bit. If it plays on a software-
based player but not on a hardware-based player, this may also be because the bit rate is 
too high.

A.3.2   Video Appears Fuzzy or Blurry
The video appears fuzzy or blurry. When played zoomed, it appears blocky, almost like 
viewing something through a frosted glass window.

Possible Causes

 DV playback not set to full quality. If the problem occurs only with Microsoft DV AVI files, 
the problem may be due to the Digital Video decode setting being set to Low. When set to 
Low, DV files are decoded in low resolution, regardless of what the resolution of the actual 
file is.

To fix this problem in Windows Media Player: 

 Open Windows Media Player, and look for the Options selection in the menu (usually 
under Tools).
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 Look for a setting called Digital Video that has a slider with Small at one end and 
Large at the other. In Windows Media Player 9, this is found by selecting Advanced in 
the Performance.

 Set the slider to Large.

 Close all open programs including Windows Media Player, then open the file for 
playback again. The file should now play in full resolution.

 Video resolution too low. When stretched to the original size, a low-resolution image will 
appear blocky. If you want or need to view the image at the same size as the original, you 
should increase the video frame size. In order to preserve quality and avoid similar effects 
due to too low a bit rate, the bit rate should be increased when increasing the video 
resolution.

 Video bit rate too low. Depending on the encoding format, a video bit rate that is too low 
can also produce blocky video as shown above. Increase the video bit rate to see if this is 
the case. If increasing the bit rate does not help, the video frame size needs to be 
increased.

A.3.3   Video Has Halos or Blocks Near Objects
The video appears to have halos around the edges of objects and/or block-like noise around 
near objects. There does not seem to be a loss of resolution, just loss of sharpness and some 
changes to colors.

 

Possible Causes

 Video bit rate too low. This type of effect is usually caused by setting the video bit rate too 
low. Increase the video bit rate to get a better result. If increasing the video bit rate 
produces too large a file, keep the video bit rate the same, but decrease the video frame 
size. When the choice is available, choosing Optimize for Quality instead of Optimize for 
Speed should also help.

A.3.4   Video Appears to Jitter
Movement in the video seems to jitter up and down. Moving objects may seem to take two 
steps forward then one step back.

Possible Causes

 Single-field detail in interlaced output. If the video appears to have vertical jitter or 
flashing horizontal edges, the source image may have single-field detail. This usually occurs 
with still images used for video. ProMedia Carbon normally makes the appropriate 
adjustments to avoid this situation, but if you still have trouble, try applying an anti-flicker or 
deinterlace filter to your source before bringing it to ProMedia Carbon.

 Improper source interlacing field order. For interlaced sources, the interlacing mode may 
not be set correctly. Verify that the proper interlacing field order is set in the Advanced 
Source Configuration.
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 Improper target interlacing field order. For interlaced output, the target field order may 
be incorrect for the playback device. Check the requirements of the intended playback 
device to determine the proper interlacing setting. 

A.3.5   Video Movement Appears Jumpy
Movement in the video does not appear smooth—it seems to jump instead of move in a fluid 
fashion. Objects in motion seem to jump or “flash” to the next position like a strobe effect.

 

Possible Causes

 Video frame rate too low. If the video frame rate is too low, motion in the video will not 
appear smooth. Increasing the frame rate will help to improve the fluidity of motion but will 
also make the file size larger. Generally speaking, a frame rate below 15fps will result in 
unsatisfactory playback.

 Streaming connection speed too slow. Users viewing a streaming file that was made for a 
faster connection speed may see this type of “snapshots in time” effect. The user need a 
faster connection to the streaming server, a progressive download file should be used 
instead.

 Playback machine too slow. Some formats play with different frame rates depending on 
the speed of the viewer’s machine. Try playback on a faster computer to see if it plays 
better.

A.3.6   Audio and Video Are Out of Sync
Audio and video do not play in synchronization with each other. For example, a person talking 
may show their lips moving, but their speech may not be audible until a second or two later.

Possible Causes

 Use of seek or trick-play in the player. If you were playing the file and playback was in-
sync until you used the player’s fast-forward, rewind or scrubber to reposition the playback 
location, then it’s probably not a problem at all. Depending on the format and player, audio/
video synchronization cannot be guaranteed after repositioning the playback point. Try 
letting the file play through from start to end without interrupting it to verify. If 
synchronization is maintained in a “straight-through” playback, then the problem is trick-
play and not the output file.

 Video and audio playing from different devices. If you are playing the video on one 
device and using a different device for audio, synchronization is not guaranteed. For 
example, DV files playing audio from the PC but using a connected DV camera or 
converter for video output will be unsynchronized. This is because there is a slight delay 
between the DV camera or converter between getting the DV data from the PC and 
outputting the decoded analog video. Thus, in this situation audio will appear to come 
slightly before the video.
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 Set-top DVD audio decoder problems. If you’re seeing the problem using a set-top DVD 
player for playback, it could be a problem with the player itself. Some set-top DVD players 
have problems with audio synchronization, especially when the audio is AC3 format. Try a 
commercially-produced DVD in the player and see if it has the same problem. Also try 
playing your DVD with a software-based DVD player.

 DVD authoring error. If your problem exists with an authored DVD, it could be a problem 
with the DVD authoring. Substandard DVD authoring can also cause audio/video sync 
problems. Try reauthoring the DVD with a different DVD authoring application.

A.3.7   Video Shows Strange Patterns or Blocks 
The video shows strange patterns or blocks of different data.

 

Possible Cause

 Corrupt video file. The data of the video file is probably corrupt. Check to see that the 
source file does not show the same problem, as any problems in the source will be 
faithfully reproduced in the output. If the problem only occurs in the output, try writing the 
file to a different drive or directory, or try a different compression format.

A.3.8   Video Appears Stretched or Squashed
The video appears to be stretched in one direction. Circles now appear as ovals and people 
are taller or wider than they should be.

 

Possible Causes

 Widescreen MPEG-2 output. If your output is widescreen MPEG-2, then this is not a 
problem. Some MPEG-2 playback software does not properly size the video playback 
according to the aspect ratio set in the MPEG-2 file. Thus, widescreen MPEG-2 files play 
back squashed. Authoring a widescreen DVD using this file and playing that DVD on a DVD 
player will produce a correct widescreen result.

 Player does not compensate for pixel and frame aspect ratio. Some media players do 
not compensate for video with non-square pixels and thus do not display video in the 
proper aspect ratio. This is not a problem with the encoding or ProMedia Carbon; it is a 
problem with the player. Try to find a player that properly compensates for non-square pixel 
playback.
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 Incorrect source aspect ratio setting. Check the aspect ratio setting in your source file. If 
it is set incorrectly, ProMedia Carbon will interpret the shape of the video image incorrectly 
and therefore process it incorrectly. ProMedia Carbon never does anything to stretch or 
squash the image; widescreen sources converted to standard screen size will be scaled to 
fit into the standard width, a process known as letterboxing, as shown in the image below. 

A.3.9   Cannot Load Encoded MPEG Files into DVD Authoring Software
Your DVD authoring software does not accept the MPEG files you made with ProMedia 
Carbon.

Possible Causes 

 File naming problem. Some DVD authoring applications do not recognize the standard 
.m2p file extension for MPEG-2 program streams. Instead, they want files named .mp2 or 
.mpg instead. Try renaming the output file from .m2p to .mp2 or .mpg and try again.

 Incorrect MPEG-2 file type. Not all DVD authoring applications support MPEG-2 
elementary streams (.m2v files and associated audio files) and MPEG-2 program streams 
(.m2p files), some will only accept one or the other. Check your DVD authoring software’s 
documentation to see which type it supports and verify that you are creating the correct 
type with ProMedia Carbon.

 Software does not accept MPEG files. Some DVD authoring applications do not accept 
MPEG files as sources. If this is the case, you will need to use ProMedia Carbon to output a 
different file type (usually VOB) that the authoring application will accept or use a different 
authoring application. Consult your authoring software’s documentation to find out what file 
types it accepts.

A.3.10   Nexus Credentials Can’t Read From Source
Watch folders, API scripts, and certain target folders say “Can’t read from source,” but the 
ProMedia Carbon GUI works properly. 

Description 

If you are getting errors such as “Can’t read from source” when using the API or Watch 
Folders, or target files are not being written properly, the Harmonic background transcoding 
service called “Nexus” may not have the proper permissions/credentials. Normally the Nexus 
Service has the credentials of the “Local System” account, you may need to change that to an 
authorized account. The Nexus Service is responsible for handling requests from Watch 
Folders, the queue manager, and the API. The GUI tool can transcode independently without 
accessing the Nexus Service in most instances, which is why you may not see those same 
problems when transcoding with the ProMedia™ Carbon user interface. 
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Instructions 

1.  Open the services console by going to Start > Run. Enter services.msc and select OK.

2. Double-click the Nexus Server service. 

3. Select the Log On tab. 

4. Set the credentials (“This account” and “Password”) for the service to a user that has 
rights to access the share. It is recommended to use Browse to find the appropriate 
account, especially if this machine is part of a domain. 

5. Close the Nexus Server Properties dialog box.

6. Now that the proper login credentials have been set, the Nexus Server service needs to 
be restarted for the changes to take effect. To do this right-click Nexus Server and then 
select Stop.
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7. Wait a few seconds after the service has stopped, then right-click Nexus Server and 
select Start. 

8. Nexus now has the credentials of the specified account, and jobs submitted with the apt 
or Watch Folders should be able to access source files and write target files. 

A.3.10.1 About Nexus Service

Transcoding manually uses a different process than transcoding with Watch Folders or using 
the API. The ProMedia Carbon program is a separate transcoder from the Windows Service 
that is also installed on a system when ProMedia Carbon or Carbon Server/Agent is installed. 
This service is called "Nexus Server" and, by default, just like every other Windows Service, it 
has permission to only access resources on the same machine that it was installed on. On the 
other hand, the ProMedia Carbon program with the GUI has the same permissions as the 
account that the user enters to log on to the machine. That is why it is necessary to give 
Nexus permission to access network resources. 

NOTE:  With regards to mapped drives versus UNC paths; mapped drives only exist for the user that is 
logged in, Windows Services do not see mapped drives. That's why the UNC path works with Watch Folders 
and the API, and mapped drives do not. 

A.3.11   Remote Retrieval
Description  

A Watch Folder is set up on a NAS or play-out server and is not processing new jobs. Carbon 
Server Watch Folders are "passive" processes, that is, they wait for a signal from the file-
system to indicate that a new file has been created in the Watch Folder path. 

When working with some devices with drivers, such as NAS drivers or file-system drivers for 
video play-out systems, passive processes may not work properly. The reason is that some file 
system drivers do not *completely* simulate a real Windows file system, that is they do not 
notify passive processes when a new file has been created in a folder that the passive 
process is watching. 
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Instructions

For this reason it may sometimes be necessary to add "Remote Retrieval" to a standard 
Carbon Server Watch Folder. Remote Retrieval can either be FTP retrieval, or File System 
retrieval. Both types of Remote Retrieval periodically check the remote FTP server or remote 
file system for new files. If a new file is discovered, Remote Retrieval checks again a second 
time, to see if the file size is constant. If the file size is not constant but growing instead, it 
means that the file is still being written to the remote device, and Remote Retrieval continues 
checking until the file size is constant. 

When the new file has been verified to have a constant size, Remote Retrieval then copies it 
to the local file system, to the Watch Folder path that was specified when the Watch Folder 
was created. In the case of a File System type of Remote Retrieval, a shortcut can also be 
copied instead of the entire file. The Watch Folder then sees the new file and precedes to 
transcode it normally. 

You can access the Remote Retrieval setup through the Carbon Admin. Select a Watch Folder 
and then select edit watch in the lower right. The Remote Retrieval option is located in the 
tree on the left. A file share/folder or FTP location can be targeted for the Remote Retrieval 
process. You will also need to specify the correct login info (username/password) if 
permissions are needed to access this location. 

Once you select OK, the Remote Retrieval process will be enabled for the location specified. 

NOTE:  If you choose the File Share/Folder option, make sure that you use only UNC paths of the form 
\\DeviceOrServerName\FILESYSTEM\Folder. Do not use mapped drives such as M:\Folder, since mapped 
drives are only valid for the user who is currently logged on, and cannot be accessed by background 
processes like Carbon Server Watch Folders. 

A.4  Contacting Harmonic Support
The Harmonic Customer and Technical Support groups are available to help you with any 
questions or problems you may have regarding Harmonic products. 

For assistance, refer to the following table for contact information in your region:

Table A–2: Contacting Harmonic Support

Region Telephone Technical Support E-mail

Americas 888-673-4896 (1-888-
MPEGTWO)
or 408-490-6477

techhelp@harmonicinc.com

Europe, Middle East +44 7699 391552 support.emea@harmonicinc.com

Asia (excluding 
India and Russia)

+852-2116-1119 hongkongtechsupport@harmonicinc.com

India +91 22 6793 9291 support.sm@harmonicinc.com

Russia +7 495 926 4608 support.sm@harmonicinc.com

Africa +972-54-900-7740 support.sm@harmonicinc.com

China +852-2116-1119 dlchinatechsupport@harmonicinc.com
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The corporate address for Harmonic is:

Harmonic
4300 North First St.
San Jose, CA 95134, U.S.A.
Attn: Customer Support

The corporate telephone numbers for Harmonic are:

Tel. 1.800.788.1330 (from the U.S. and Canada)
Tel. +1.408.542.2500 (outside the U.S. and Canada)
Fax.+1.408.490.6770

The web address for Harmonic is www.harmonicinc.com.
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Appendix B 
ProMedia™ Carbon Features Added Since Release 3.0

This appendix summarizes and describes ProMedia™ Carbon features since release 3.0.

B.1  New Features in ProMedia Carbon Release 3.19.2
There are no new features, only bug fixes for this release. The fixed bugs are:

 CCDR-225: in certain cases the H.264 Exporter causes Carbon to abort unexpectedly due 
to a memory leak. 

Fix: the memory leak has been fixed.

 CCDR-221: The frame time code contained in the Generic Container System Item of MXF 
OP1a clips created with Omneon Exporter v2 is always all zeroes (00:00:00:00).

Fix: this frame time code was removed. This makes the behavior of the Omneon Exporter 
v2 the same as in releases prior to 3.19.1.

 CCDR-255: The value of the firstFrame field for clips created with the Omneon Exporter v2 
is always equal to zero. 

Fix: the firstFrame field value is now derived from the start time code, for all Omneon 
formats and wrappers.

B.2  New Features in ProMedia Carbon Release 3.19.1
ProMedia Carbon 3.19.1 is a full Carbon release that extends Carbon 3.19 with new features 
and bug fixes. The new features are:

 Improved Video Quality for H.264 encoded video. This affects the following Exporters and 
WFS Presets:

 H.264 Exporter

 HTTP Live Exporter

 Smooth Streaming Exporter - H.264

 WFS Preset "Audio Passthrough with TS Transcode"

 Creation of H.264 proxies from Omneon Spectrum clips. This feature is primarily intended 
for quick turnaround workflows that involve viewing and/or manipulation of large quantities 

of Spectrum clips with the Omneon Media Application Server1 (MAS). In order to keep 
network bandwidth usage low, MAS displays derivatives of the Spectrum clips called 
proxies instead of the Spectrum clips themselves.

ProMedia Carbon can also create the proxies without MAS, and when the proxies are 
wrapped in QuickTime they can be viewed with a QuickTime player.

NOTE:  This feature is only available for transcode farms controlled by WorkFlow System (WFS). It is not 
available for Carbon Server/Agent farms or standalone Carbon installations.

This feature includes growing file support, meaning proxies can be created from Spectrum 
source files that are still being recorded. Watch Folder support for growing files is only 
available when WFS is controlled by MAS.

1. The Media Application Server monitors and manages content across multiple Omneon systems, including Spec-
trum and MediaGrid.  In addition it provides several media processing services, such as clip transfers.
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B.3  New Features in ProMedia Carbon Release 3.19
 Rebranding of the Carbon Coder standalone application to “ProMedia Carbon”. The 

rebranding is limited to Carbon Coder and does not impact Carbon Server or Carbon 
Agent. ProMedia Carbon is fully backwards compatible with Carbon Coder.

 Improved video quality and rate control for the H.264 Exporter and the HTTP Live 
Streaming Exporter. For these two Exporters, the H.264 video codec has been improved in 
the following ways:

 Improved adaptive QP assignment at the macro-block level.

 Improved adaptive deblocking.

 Improved CBR rate control. 

There are three new parameters in the H.264 Exporter to support these improvements, and 
some obsolete parameters have been removed at the same time. The removal of the 
obsolete parameters has no impact on previously saved presets.

 Omneon Exporter v2 improvements.

 Support for Spectrum-compliant file naming for QuickTime Reference and MXF OP1b 
target clips.

 SDK version 6.4: the Omneon Media SDK has been upgraded to version 6.4.

 New formats: Support for the Omneon Internal / Low Latency OP1a wrapper, and 
support for eVTR D10 (IMX).

 Support for writing video-only clips, that is, clips without audio.

 Support for writing 436m tracks for all target formats wrapped in regular and Low 
Latency OP1a, and for XDCAM HD wrapped in RDD9. The number of ANC bytes can 
be set manually or detected automatically.

 XDCAM Exporter improvements.

 Support for writing 436m tracks for DVCAM25 and MPEG HD target formats

 Auto-sensing for the Line 21 Extraction filter.

 Carbon 3.19 has improved performance for JPEG 2000 decoding, and for AVC-Intra 
encoding with the Omneon Exporter v2. The performance gains were achieved by 
implementing multi-threading for both processes; in 3.17 both were single threaded. Initial 
tests show that real time speed can be achieved with an 8-core machine, though this was 
not a hard requirement. (Decoding and encoding tested separately, not simultaneously.)

B.4  New Features in ProMedia Carbon Release 3.18.2
Carbon 3.18.2 is a full Carbon release that extends Carbon 3.18.1 with two new features and 
a few bug fixes. The new features are:

 Support in the QuickTime 7 Exporter for ProRes 422 that complies with requirements from 
the Apple iTunes Store. Carbon can now be used to generate ProRes 422 material suitable 
for uploading to the iTunes Store.

 Expansion of the number of audio tracks to 16 for ProRes 422 in the QuickTime 7 
Exporter.

These features only apply to the ProRes 422 export format and are only available for systems 
that meet the requirements for ProRes 422 as an export format. Support for this was 
introduced in release 3.18.1. Please read the Upgrade Considerations in the 3.18.2 release 
notes before deciding to install or upgrade to 3.18.2.
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B.5  New Features in ProMedia Carbon Release 3.18/3.1.8.1
ProMedia Carbon 3.18 includes the following new features that provide high-performance, 
scalable and cost-effective transcoding for a broad range of business environments, from 
specialized studios to enterprise-scale installations. 

B.5.1   QuickTime 7 Exporter for Apple ProRes 422 (3.1.8.1)
Support for QuickTime 7 Exporter for Apple ProRes 422 (a standard-definition and high-
definition lossy video compression format for use in post production) as a target format for 8-
bit source material. A wide range of ProRes 422 frame rates and resolutions is supported and 
the transcoded material can be imported into Final Cut Pro for viewing and further 
processing. Support for Apple ProRes 422 as a target format for 10-bit JPEG 2000 and 10-bit 
Avid AAF / DNxHD sources. The transcoded material can be imported into Final Cut Pro for 
viewing and further processing.

See 2.3.2 Installing ProMedia Carbon 3.20 on page 21 for special, required usage conditions 
before deciding to install or upgrade to ProMedia Carbon 3.18.1.

B.5.2   Microsoft Smooth Streaming with H.264
Carbon Coder 3.18 adds an exporter for creation of multi-bit rate streaming files for Microsoft 
Smooth Streaming with H.264. Use of H.264 for streaming to Microsoft Silverlight players has 
become increasingly popular and ProMedia Carbon 3.18 adds the H.264 Smooth Streaming 
Exporter to the Smooth Streaming Exporter for VC-1, which was already available. The audio 
codec used with the H.264 Smooth Streaming Exporter is AAC.

The name of the new Exporter in the Carbon User Interface is “Smooth Streaming Exporter—
H.264”. To avoid confusion, the VC-1 based Exporter has been renamed “Smooth Streaming 
Exporter—VC-1”.

The maximum number of video layers is 16, and so is the maximum number of audio 
streams. Video frame size and bit rate for each layer can be generated automatically, or set 
manually by the user.

B.5.3   Multi-bit rate Audio for HTTP Live Streaming 
Carbon Coder 3.18 allows the user to set the audio bit rate in HTTP Live Streaming per 
individual stream. In previous versions of Carbon this was not possible because the bit rate 
was the same for all streams. With the support of multi bit rate audio you can now assign 
different bit rates to different streams, allowing for configurations that use low bit rates for 
audio only streams.

B.5.4   Framework for Improving Video H.264 Quality
A framework has been put in place inside the H.264 encoder to allow for future optimizations 
to the video quality. There is no impact on the performance of the H.264 encoder.

B.5.5   Omneon Exporter v2
The Omneon Exporter v2 has expanded format support and now includes XDCAM HD and 
XDCAM EX. Both can be wrapped in QuickTime 6 and 7, and MXF OP1a and OP1b, and for 
XDCAM HD there is also the RDD9 compliant OP1a wrapper. Wrapping of AVC-Intra Class 
50 and 100 in QuickTime has been added too.

The Exporter has been updated and now uses Spectrum SDK version 6.2, the most recent at 
the time of this release
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B.5.6   Support for SMPTE 2038
Carbon 3.18 implements SMPTE 2038 for carriage of SMPTE 291M Ancillary Data (ANC 
data) within Transport Streams that use MPEG-2 video. The ANC packets are carried inside 
Transport Stream PES packets and ProMedia Carbon allows the user to set the PID of the PES 
stream. Inclusion of SMPTE 2038 PES streams is controlled by a check box.

Frame rate conversion is not supported with this feature, and if the box is checked then a PES 
stream will always be included, even if there is no SMPTE 291M ANC data in the source file

B.5.7   Dolby Digital and Dolby Digital Plus Decoding
Until now, use of the Dolby Digital (AC-3) and Dolby Digital Plus (E-AC-3) decoders in Carbon 
was restricted to verification of audio content encoded in these formats. This restriction has 
been removed and these decoders can now be used for production purposes

B.6  New Features in ProMedia Carbon Release 3.17
 A new RPI-based MPEG-2 Exporter has been added. It allows the creation of multiple audio 

programs. Each stream can be tagged with an audio language descriptor and PID.

 The XDCAM exporter supports the Active Format Descriptor (AFD) in the MPEGHD format.

 A new Video Scaling Algorithm has been added in the Kernel Settings.

 A new RPI-based Omneon Exporter has been added. It has added support for DVCPRO 
HD/DV100 format as well as the ability to allow multiple audio channel configurations.

 Carbon will now insert its version number when writing Projects, Presets and Profiles.

 Added several parameters to the H.264 Exporter to provide more fine-grained control, this 
offers the option to substantially increase transcoding speed at the cost of some visual 
quality. New HD & SD presets in the H.264 preset category illustrate both high quality and 
high speed settings for these new parameters.

 Closed Captions are now supported on MPEG2-v2 exporter with frame rate conversion of 
23.98, 29.97 and 59.94 fps.

B.7  New Features in ProMedia Carbon Release 3.16
 Allow creation of multiple audio output streams in the Smooth Streaming exporter. Each 

output stream can be tagged with an audio language descriptor.

 A new Video Filter that allows for insertion of V-Chip XDS information into the Carbon 
pipeline in the caption/708 payload. Other filters such as the Line 21 Modulator video filter 
can use the data from the caption/708 payload and insert it into line 21 of the VBI of 
output files.

 A new Audio Filter that allows Dolby-E encoding for any ProMedia Carbon Exporter 
supporting an Uncompressed or PCM audio format.

 Added support for the creation of MPEG-2 Transport Stream Video with MPEG-2 AAC-LC 
LATM/LOAS or MPEG-4 AAC-LC LATM/LOAS audio for the MPEG-2 exporter.

 Added support for the import of MPEG-2 Transport Streams with MPEG-2 AAC-LC LATM/
LOAS or MPEG-4 AAC-LC LATM/LOAS audio streams from MPEG-2 video.

 Added support for extracting striped timecode tracks from GXF files.

 Extended the API functionality to return StartTimecode of ProRes sources in the reply from 
a JobEvaluate API call.

 Added support for the creation of MPEG-2 Transport Stream Video with MPEG-2 AAC-LC 
LATM/LOAS or MPEG-4 AAC-LC LATM/LOAS audio for the H.264 exporter.
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 Added support for the import of MPEG-2 Transport Streams with MPEG-2 AAC-LC LATM/
LOAS or MPEG-4 AAC-LC LATM/LOAS audio streams from H.264 video.

 Extended the GUI of the Channel Mixer audio filter to support up to 32 input audio 
channels and allow the mapping on up to 32 output audio channels.

 Support writing of CEA-708D captions for the Omneon exporter.

 Added Support For AVC-Intra encoding in the Omneon Exporter

 Added support for inserting Active Format Descriptor into H.264 elementary video 
streams per ATSC A/72 Part 1, section 6.4.

 Added a Video Filter to map any input VBI that contains less than the standard 32 lines, 
from 1 up to the normal 32 lines, to a full 32 lines of VBI.

 Enhanced the existing MXF OP1B importer to support J2K content.

 Expanded the H.264 Importer to read captions from MPEG Transport Streams per CEA-
708 standard.

 Added the Http Live Streaming exporter, which lets you send audio and video over HTTP 
from an ordinary web server for playback on iPhone, iPad, iPod touch and desktop 
computers.

 Added a Timecode Processing filter. This filter can correct, clean up, or synchronize the 
timecode payload with time sources other than the source file.

 Enhanced the H.264 exporter to allow the creation of multiple audio programs for 
Transport Streams and System Streams.

 Updated the Avid MXF Exporter to AMT SDK V1.5.2, which added new Avid formats, frame 
rates, bit rates, etc.

 Extended the API multiplexer with the control option for text justification background 
options on STL subtitle files.

 Enhanced the H.264 importer to allow multiple audio programs on Transport Streams and 
System Streams.

 Added the ability to Read ATSC A/53 compliant caption data from QuickTime-wrapped 
Omneon input files with MPEG essence.

 Added support for reading CEA-708 caption data from MXF input files with MPEG video 
essence.

 Updated the AS02 exporter with the ability to read ATSC A/53 captions and SMPTE 328M 
timecode.

 Added support to the H.264 exporter with the ability to include CEA-708 closed 
captioning data.

 Extended the API multiplexer with control options for advanced video options.

 Updated the SMPTE302 importer to support 32-Channel source files.

B.8  New Features in ProMedia Carbon Release 3.15
 Allow the GXF Exporter to write SMPTE 291M ancillary data to the VANC section, for 

example, when inserting CEA-708 captions into GXF output files. The GXF Importer has 
also been enhanced to extract CEA-708 captions stored in VANC from GXF input files.

 Convert CEA-608 analog (line 21) captions to CEA-708 Digital TV captions.

 The Omneon Importer now reads MXF OP1A input files with AVC-Intra video tracks.

 Importing and Exporting various types of MPEG-2 Transport Streams now supports reading 
and writing CEA-708 captions.

 Updated the Microsoft Smooth Streaming Exporter with enhancements and fixes, and 
manifests are now Version 2 compliant.
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 The Windows Media Exporter can now create output files with multiple audio files, such as 
when creating files that need to contain audio tracks in more than one language.

 Added the ability to select which audio PID to extract the audio channels from when 
importing Transport Streams with H.264 video essence. Also, all audio PIDs in an input 
Transport Stream can now be combined into one linear list of input audio channels.

 Audio in GXF files can now be 24 bits, in addition to sample sizes supported in previous 
versions.

 Added an option to the MPEG-2 Transport Stream multiplexer to distribute video packets 
uniformly over time, in addition to the previous method which is to distribute all packets in 
such as way as to optimize the bandwidth of the stream. The optimized method is the 
default, but the option can be enabled with a check box in the Carbon UI.

 Support for reading VBI from MXF files that are compliant with the SMPTE 436M 
specification. This enables the import of CEA-608 line 21 captions or Teletext, for example, 
from those MXF files that contain such information in the Vertical Blanking Interval.

 Teletext to STL caption file conversion, and vice versa. A new STL caption file Exporter has 
been added, which can create STL text files from Teletext information from source files. 
Conversely, STL caption files can be imported and used to create Teletext information in 
the VBI, which can be inserted into output files.

 API support for de-multiplexing MPEG-2 Transport Streams into their constituent 
elementary video and audio streams. Some metadata formats can also be extracted.

 The Carbon transcoding engine now supports carrying caption information for progressive 
formats with 23.98p and 59.94p frame rates.

 Carbon now works differently when creating MPEG-2 output files from input files that have 
video and audio tracks of different durations. Instead of generating a few extra blank video 
frames to compensate for longer audio tracks, output files now have their audio tracks 
truncated to match the duration of the video tracks. This ensures that the video duration of 
such output files will be the same as the duration of the video tracks of the input files.

 Extended support for DVB VBI import and export, compliant with ETSI EN 301 775.

 A language descriptor can now be set for H.264 output files when creating Transport 
Streams.

 The API Transport Stream multiplexer now supports Dolby Digital Plus (E-AC-3) as an input 
audio elementary stream type.

 Support for SMPTE 291M ancillary data in the Carbon transcoding engine, initially in 
support of the GXF Importer and Exporter for the reading and writing of CEA-708 captions.

B.9  New Features in ProMedia Carbon Release 3.14
 Improved H.264 Exporter. The H.264 exporter has been updated to improve quality and 

increase transcoding speed. Many new settings are now exposed allowing the ability to 
truly tune the exporter to meet higher video quality while hitting lower bit rates. The 
exporter also adds compatibility for more devices, such as the iPhone OS v3.0.

 Microsoft Smooth Streaming Exporter. This new exporter introduces Microsoft’s Smooth 
Streaming SDK allowing you to create multi-bit rate streaming files with the VC-1 video 
codec and deliver them to Microsoft Silverlight players.

 Avid MXF Exporter. A new exporter has been added allowing the creation of MXF wrapped 
Avid codecs for compatibility with many Avid products.

 Motion-Compensated Temporal Filter (MCTF). The MCTF filter is an advanced video 
algorithm from the Harmonic codec research and development team. The MCTF filter 
allows you to hit lower bit rates without losing video quality.
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 De-Blocking Filter. Also from the Harmonic codec research and development team, this 
advanced de-blocking filter helps to remove blockiness in a compressed source file before 
the final encode.

 STL Caption Video Filter. This new video filter burns captions from an STL file into the 
output video.

 VITC Video Filters. Two new video filters to extract and insert information to and from the 
Vertical Interval Timecode (VITC).

 ITU 1770 Audio Filter. This audio filter allows standards-based adjustment of audio levels to 
meet broadcast requirements.

 Harmonic Programming Interface (RPI). The RPI allows 3rd parties to develop importers, 
exporters, and filters for use in the Harmonic transcoding pipeline.

 Carbon Farm Manager (CFM). The CFM is a service which runs outside of your Carbon 
Server Farm environment. It monitors for stalled jobs as well as other problems and 
performs routine maintenance like scheduled, graceful reboots of the entire farm.

 Carbon Farm Analyzer (CFA). The CFA reports information about the utilization and status 
of the machines in your transcoding farm in addition to what’s available in the Carbon 
Admin interface. This tool is extremely helpful in tracking down problematic situations.

B.10  New Features in ProMedia Carbon Release 3.13
 API support for SMPTE Transitions (RMF-13/65).

 Enhanced Television - Binary Interchange Format (ETV-BIF) pass-through for MPEG-2 
Transport stream outputs (RMF-15).

 Import EVS XT-1 compatible MXF-wrapped Motion-JPEG files (RMF-16).

 Apply rules to Watch folder allowing features such as automatic aspect ratio overrides 
(RMF-23).

 Extract Teletext caption information (RMF-24).

 Insert or burn-in Teletext captions into targets when using sources with Teletext (RMF-76).

 Enhanced API support for inputs with multiple audio sources and independent in- and out-
points (RMF-51).

 Multiplexing-only API call to create DVB outputs with multiple audio sources and DVB/STL 
subtitle streams (RMF-55/57/58)

 XDCAM MXF & MOV MPEG-2 HD 4:2:2 import and export support (RMF-62/103/112).

 Added Dolby Digital Plus (E-AC-3) encoding ability to the AC-3, H.264, and MPEG 
exporters (RMF-75).

 Support for writing and reading MXF AS02 compatible files (RMF-79/80).

 Add Active Format Descriptors (AFD) to output files (RMF-81).

 Support for reading DVS Clipster compatible MXF-wrapped JPEG2000 input files (RMF-
84).

 Omneon exporter can create one output file per each audio channel (RMF-101).

 New filter “Map Alpha to target Y channel” filter creates separate luma-only output files 
(5827).

B.11  New Features in ProMedia Carbon Release 3.12
 Allow export of MPEG-1 Level II elementary audio files using the MP3 Target.

 Web-based help system with improved searching and indexing.
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B.12  New Features in ProMedia Carbon Release 3.11
 XDCAM EX files, which are MPEG-4 files with MPEG-2 video essence, can be imported. 

XDCAM EX metadata is not imported.

 Implemented the reading and writing of Panasonic AVC Intra files, which are files with AVC-
Intra essence in an MXF OPAtom wrapper.

 Allow the insertion of AC-3 audio in MP4 files created by the H.264 exporter.

 Support the reading of Avid MXF-wrapped DNxHD files.

 Allow the deletion of original source files, even if they are referenced by a Windows 
shortcut.

 The Panasonic P2 exporter can now be used to create MXF files that can be directly 
imported into Avid systems without the Avid system taking extra time to “render” the files 
first.

 The H.264 exporter now exposes an API for users to use an alternative H.264 encoder 
instead of the default H.264 encoder installed during installation of the applications.

 Allow the specification of the duration of video fades in increments of one-tenth of a 
second.

 H.264 Exporter has a new caption mode to support Echostar-specific STB captioning 
requirements.

 Video Timecode Inject filter allows the setting of the Start time code for target files.

 Read time code when importing DPX frames.

 Ability to associate a Look-Up Table (LUT) with a DPX sequence.

B.13  Harmonic Flash Support
With the 3.0 release support for Flash was added to ProMedia Carbon and Carbon Server. 
The following sections summarize the various ways in which Carbon supports Flash versions 
7, 8, and 9.

B.13.1   Flash 7
 Carbon supports reading and writing. 

  H.263 inside an FLV or SWF wrapper. This is very similar to "Flash-7 Sorenson", and works 
the same in all the players, like YouTube and 2-pass support.

 While the ability to export a SWF-wrapped file is supported it should be mostly seen as a 
vector format and not used for normal web video applications. 

B.13.2   Flash 8
 Carbon only supports writing, this is a licensing issue. 

 VP6 (licensed from Adobe) inside an FLV wrapper. 

 Single Pass only, but high quality. 

 High Speed. 

 Takes advantage of Macro-Grid processing allowing multiple systems to work on a single 
encode. 

 For multi-pass we support the On2 Pro Encoder, however it must be purchased separately. 

 Multi-pass 

 A few additional parameters compared to Adobe.

 There is a version of a QuickTime plug-in from On2 called the FlixExporter that is 
licensed for non-commercial use as stated on their website.
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B.13.3   Flash 9
 Carbon 3.0 supports reading and writing. 

 H.264 in an F4V wrapper. Video H.264 in other wrappers is also supported by Carbon but 
is not Flash 9. 

 1 and 2-pass support. 
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